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Güvenlik

Giriş

Verimli ve güvenli bir kullanım sağlamak için yazılımı kullanmadan önce bu güvenlik bölümünün ve tüm ilgili konuların 
okunması gereklidir. Ürünü kullanmaya başlamadan önce bu el kitabının içeriğini okuyup anlamanız önemlidir. Prosedürleri 
ve güvenlik önlemlerini periyodik olarak gözden geçirmeniz gerekir. 

Bu yazılım yalnızca eğitimli ve uzman personel tarafından kullanılmalıdır.

suiteDXT / suiteHEART® yazılımının orijinal yayım tarihinden itibaren 7 yıl faydalı ömrü olması beklenmektedir.

DİKKAT: Federal Yasalar gereği, bu cihazın satışı, dağıtımı ve kullanımı sadece bir hekim tarafından veya bir hekimin 
siparişi ile yapılabilir.

Bu el kitabında, tehlike, uyarı ve ikaz terimleri tehlikelere işaret etmek ve ciddiyet derecesini veya seviyesini göstermek için 
kullanılmaktadır. Tehlike olası bir şahıs yaralanma nedeni olarak tanımlanır. Aşağıdaki tabloda listelenen terminoloji 
açıklamalarına aşina olun:

Kullanım Endikasyonları

suiteHEART® Yazılımı, medikal görüntülerin gözden geçirilmesi ve raporlanması için tekrarlanabilir araçlar sunan analitik 
bir yazılım aracıdır. suiteHEART® Yazılımı, bir MR sisteminden medikal görüntüleri içe aktarabilir ve bunları bilgisayar 
ekranındaki bir görüntüleme alanında gösterebilir. Görüntüleme alanı birden fazla çalışmaya ve çok kesitli, çok aşamalı 
görüntü serilerine erişim sağlar. Çok aşamalı görüntü sekansları görüntülemeyi kolaylaştırmak için film modunda 
görüntülenebilir.

Tablo 1:  Güvenlik Terminolojisi

Grafik Tanım

TEHLİKE:

Tehlike, yönergeler gözardı edilirse ciddi kişisel yaralanmalara, ölüme ya da önemli maddi hasara 
neden olacak belirli bir tehlikesi olduğu bilinen koşulları ya da eylemleri belirtmek için kullanılır.

UYARI : 

Uyarı, belirli bir tehlikesi olduğu bilinen koşulları ya da eylemleri belirtmek için kullanılır.

DİKKAT: 

İkaz, potansiyel bir tehlikesi olduğu bilinen koşulları ya da eylemleri belirtmek için kullanılır.
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Rapor giriş arabirimi de bulunur. Rapor arabirimindeki ölçüm araçları, görüntüleme incelemesine ait tam bir klinik 
raporunun hızlı ve güvenilir bir şekilde doldurulmasını sağlar. Kullanılabilir araçlar şunları içerir: nokta, mesafe, alan ve 
hacim ölçüm araçları (ejeksiyon fraksiyonu, kardiyak çıktısı, diyastol sonu hacmi, sistol sonu hacmi ve hacim akış 
ölçümleri).

Sol ventriküler kontur tespiti, kapak düzlemi tespiti, akış analizi için damar konturu tespiti, miyokardiyum ve enfarktüs 
boyutu ölçümü için sinyal yoğunluğu analizi ve T2 star analizi için yarı otomatik araçlar da mevcuttur.

Ölçüm araçlarının sonuçları hekim tarafından yorumlanır ve ilgili diğer hekimlere aktarılabilir.

Bu araçlar, eğitimli bir hekim tarafından yorumlandığında teşhisi desteklemek için yardımcı olabilir.

Kullanım Amacı

suiteHEART® Yazılımının amacı, kardiyak işlevinin nicel ve nitel hale getirilmesinde eğitimli personele yardımcı olmaktır. 
Yazılım, DICOM görüntü parametrelerini ayarlamak için araçlar ve kullanıcının faydalanabileceği, zaman içinde MRI ile 
alınmış kalp ve damar düzeni görüntülerini gösteren, gösterim durumları sunar. Yazılım buna ek olarak, kardiyak işlevini 
nicel hale getirmek için kullanılabilecek doğrusal mesafe, alan ve hacim ölçme araçları sağlar. Son olarak, yazılım hacimsel 
akış ölçümlerini  yapmak için araçlar sunar ve akış değerlerini hesaplama yeteneği sağlar.

Desteklenen DICOM Görüntü Biçimleri

suiteHEART® Yazılımı, aşağıdaki DICOM biçimlerini destekler; MR ve Gelişmiş MR. Desteklenen biçimler hakkında daha 
fazla ayrıntı için suiteHEART® Yazılımı DICOM Uyumluluk Beyanı el kitabına bakın.

DİKKAT: Harici bir PACS’tan içe aktarılan ve DICOM görüntüsü olarak saklanan veri, suiteHEART® Yazılımı ile 
görüntülenmek için uyumlu olmayabilir. 
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Güvenlik Bildirimleri

UYARI : Uygulama yalnızca görüntülerin analizine yardım eder ve otomatik olarak ölçülebilir sonuçlar üretmez. 
Nicel ölçümlerin kullanımı ve yerleştirilmesi kullanıcının inisiyatifindedir. Ölçümler yanlış yapılırsa, hatalı 
teşhisler meydana gelebilir. Ölçümler yalnızca uygun bir şekilde eğitilmiş ve uzman bir kullanıcı 
tarafından oluşturulmalıdır. 

UYARI : Görüntü üzerindeki yapılar yanlış yorumlanırsa hatalı teşhislere neden olabilir. Teşhis için yapı içeren 
görüntüler kullanmayın. Analiz yalnızca uygun bir şekilde eğitilmiş ve uzman bir kullanıcı tarafından 
gerçekleştirilmelidir.

UYARI : Görüntülerde hasta adı ya da numarası yoksa yanlış hasta için teşhis konulabilir. Teşhis için hasta adı ya da 
numarası içermeyen görüntüleri kullanmayın. Analizden önce hasta bilgilerini görsel olarak onaylayın.

DİKKAT: Görüntü filtresinin uygulandığı görüntülerin kullanılması sonuçların değişmesine neden olabilir. Kullanıcı 
piksel yoğunluğu düzeltilmiş görüntüleri analiz etmeden önce kendi inisiyatifini kullanmalıdır. 
Filtrelenmiş görüntüler yüklenirse yazılım uyarı mesajı gösterecektir.

Ekipman Tehlikeleri

DİKKAT: Hasarlı veya zarar görmüş ekipman kullanılması halinde, teşhisin gecikmesi nedeniyle hasta için risk 
oluşabilir. Ekipmanın düzgün çalıştığından emin olun.

DİKKAT: Uygulamalar, üzerinde hastalarla ilgili tıbbi bilgileri olan, bir veya daha fazla sabit disk sürücü içeren 
ekipmanlar üzerinde çalışır. Bazı ülkelerde bu tarz ekipmanlar, kişisel verilerin işlenmesi ve serbest 
dolaşımına ilişkin kurallara tabi olabilir. Kişisel verilerin yayımlanması, geçerli düzenleyici kuruma bağlı 
olarak yasal işlem başlatılmasına neden olabilir. Hasta dosyalarına erişimin kesinlikle korunması önerilir. 
Kullanıcı, hasta bilgilerini düzenleyen yasaları anlamaktan sorumludur.
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Başlangıç

Uygulamayı Başlatma ve Uygulamadan Çıkma

suiteHEART® Yazılımı, Kardiyak MRI (Manyetik Rezonans Görüntüleme) verilerinin analiz edilmesi, gözden geçirilmesi ve 
raporlanması için kullanılabilen bir uygulamadır. Bu el kitabı, suiteHEART® Yazılımı kullanıcı arabiriminin ve kardiyak MR 
görüntülerin üzerinde nicel analiz gerçekleştirmeye yönelik iş akışının ayrıntılı bir açıklamasını sunar.

suiteHEART® Yazılımını Başlatma

1. Masaüstü kısayolunu kullanarak suiteDXT uygulamasını başlatın.

NOT:  Uygulamalar arasında gerekli dosya aktarımını/aktarımlarını gerçekleştirmek için hem suiteDXT hem de
suiteHEART® Yazılımı uygulamaları çalışıyor olmalıdır (eş zamanlı olarak).

2. Ana Ekranda Uygulama Başlatma (Launch Application) aşağı açılır menüsüne gidin ve suiteHEART® Yazılımını seçin.

ŞEKİL 1- Uygulama Başlatma

3. Çalışma listesinde bir çalışma seçin ve şunlardan birini yapın:

• Başlat (Launch) düğmesine basın.
• Sağ fare tuşuyla tıklayın ve “<seçili uygulama> ile başlat” (“Launch using <selected application>”) ögesini seçin.
• Çalışmanın üzerine çift tıklayın.

4. Piksel yoğunluk filtresi uygulanmış görüntüler içeren incelemeler, inceleme açılmadan önce bir mesaj kutusunda
listelenir.

NOT:  Ekran çözünürlüğü 1920x1080 veya daha yüksek bir çözünürlüğe ayarlanmış olmalıdır, aksi halde yazılım başlamaz.

UYARI : Analizde piksel yoğunluk filtresi uygulanmış görüntüler kullanmak hatalı sonuçlara neden olabilir.
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suiteHEART® Yazılımından Çıkma

Uygulamadan çıkmak için Dosya (File) > Çıkış (Exit) ögelerini seçin.

ŞEKİL 2- suiteHEART® Yazılımını kapatma.
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Kullanıcı Arayüzüne Genel Bakış

Genel Bakış

suiteHEART® Yazılım arayüzünde Şekil 1‘de gösterildiği gibi üç ana panel bulunur.

• Analiz Görünümü: Her analiz modu için analiz araçları sunar.
• Görüntü Görünümü: Görüntü analiz ve gözden geçirme işlevleri için hızlı erişim sağlar.

- Küçük resim görünümleri, düzenleme penceresi ve mod görünümünden oluşur.

• Rapor Görünümü: Yapılandırılmış raporlar için kullanılan araçları sunar.

ŞEKİL 1- Üç Ana Panel: Analiz Görünümü, Görüntü Görünümü, Rapor Görünümü

Analiz 

Küçük Resim 

Rapor 

Görüntü Görünümü

Mod Düzenleyici 

Görünümü

Görünümü

Görünümü Görünümü

Görünümü
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Analiz/Görüntüleyici Modları

NOT:  Patent Foramen Ovale (PFO) Analizi dosya aşağı açılır menüsünden veya klavyede Ctrl-5 tuş kombinasyonu ile 
seçilebilir.

Seride Dolaşma

Seçili çalışma içindeki görüntüleri görüntülemek veya serileri değiştirmek için Görüntü Görüntüleyicinin üst kısmında 
bulunan sağ ve sol ok tuşlarını kullanın. Filtre (Filter) düğmesinin solunda bulunan seri aşağı açılır menüsü de seri seçimi 
yapmak için kullanılabilir. Analiz veya ilgi bölgesi içeren seriler Şekil 2‘de gösterildiği gibi kalın harflerle gösterilir.

ŞEKİL 2- Seride Dolaşma

Tablo 1:  Analiz Modları

İşlev 
Analizi

Akış 
Analiz

Miyokardiyal 
Değerlendirme

T1 
Eşleştirme

T2 
Eşleştirme

Zamana 
Bağlı Analiz

T2 Star 
Analizi

Tablo 2:  Görüntüleme Modları

Görüntüleyici Virtual
FellowTM

3B/4B  
Görüntüleyici
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Düzenleme Penceresi ve Mod Görüntüleme

Görüntü Görüntüleyicide görüntü üzerine sağ fare tuşuyla tıklarsanız görüntü kullanma araçları etkinleşir. 

Dosya Menüsü Seçenekleri

Analiz Seç  (Select Analysis) – Analiz modunu seçer (İşlev, Akış, Miyokardiyal Değerlendirme, Zamana Bağlı, PFO, T2Star, 
T1 Eşleştirme, T2 Eşleştirme ve 3B/4B) 
VT Tara (BrowseDB) – Yerel veritabanını açar
Çalışmayı Değiştir (Switch Study) – Analiz modu için kullanılabilir çalışmaları listeler
Rapor Önizleme (Preview Report) – Biçimlendirilmiş raporu önizleme
Rapor Yazdır (Print Report) – Raporu yazdırır
İncelemeyi Onayla (Approve Exam) – Son raporu imzayla onaylar ve kilitler
Onaylı İnceleme Yükle (Load Approved Exam) – Daha önceden açılmış bir raporu yükler
Çıkış (Exit) – Geçerli analiz sonuçlarını ikinci alım (SCPT) serisine kaydederek uygulamayı kapatır.

 Araçlar Menü Seçenekleri

Tercihler (Preferences) > 
Tercihleri Düzenle (Edit Preferences) – Sistem ve şablon tercihlerini düzenlemek için tercih düzenleyicisini açar
Tercihleri İçe Aktar (Import Preferences) – Kullanıcı tercihlerini ve makroları geri yükler
Tercihleri Dışa Aktar (Export Preferences) – Tüm kullanıcı tercihlerini dışa aktarır

Dışa Aktar (Export) >

Raporu Dışa Aktar (Export Report) –  Geçerli analiz sonuçlarına göre bir rapor üretir ve ikinci alım (SCPT) serisine kaydeder.
Raporu Excel Dosyasına Dışa Aktar (Export Report to Excel) – Analiz sonuçlarını içeren bir Excel çalışma sayfası üretir.
DICOM Filmi Olarak Dışa Aktar (Export Cine DICOM) – Mevcut seçilmiş seriden DICOM filmi oluşturur ve SCPT dosyası olarak 
kaydeder.
Film Dosyalarını Dışa Aktar (Export Cine Files) – Mevcut seçilmiş seri görüntülerini seçilen dosya biçimlerinden birinde dışa 
aktarır. Kullanılabilir biçimler şunlardır: sıkıştırılmış QuickTime video, JPEG, TIFF, GIF, PNG veya sıkıştırılmamış AVI video.
Matlab’a Dışa Aktar (Export to Matlab) – İkili biçimde bir Mat-file dosyasını dışa aktarır. (Sadece lisansla kullanılabilir)
Raporu XML Dosyasına Dışa Aktar (Export Report to XML) – Raporu XML dosyası olarak dışa aktarır.

Tablo 3:  Görüntü Kullanım Araçları

Pencere/Düzey

Kaydır

Yaklaş

Döndür

Çevir

Rapora Gönder

Tarama Parametreleri

Sıfırla
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Rapor Veritabanı
Notu Aç/Kapat (Toggle Annotation) – ROI notunun açılıp kapatılmasını sağlar
Hat Kalınlığını Aç/Kapat (Toggle Line Thickness) – Notların çizgi kalınlığının gösterilip kaldırılmasını sağlar.
Çapraz Başvuru Hatlarını Aç/Kapat (Toggle Cross Reference Lines) – Görüntüler üzerindeki çapraz başvuru hatlarının gösterilip 
kaldırılmasını sağlar.
Görüş Alanı Aç/Kapat (Toggle FOV) – Görüş alanının açılıp kapatılmasını sağlar
Pencereyi/Seviyeyi Ters Çevir (Invert Window/Level) – Pencere/seviye görünümünü ters çevirir

Yardım Menüsü Seçenekleri

Kullanım Talimatları (Instructions for Use) – suiteHEART® Yazılımı Kullanım Talimatları
DICOM Uyumluluk Beyanı (DICOM Conformance Statement) – suiteHEART® Yazılımı DICOM Uyumluluk Beyanı
suiteHEART® Hakkında (About suiteHEART®) –  Uygulama sürüm bilgisi 
Hızlı Tuşlar (Quick Keys) – Klavye işlevleri

Görüntü Görüntüleme Kontrolleri

Aşama Kaydırma Çubuğu (Phase Slider Bar)  film aşama seçimini kontrol eder.

Görüntü Atlama Simgeleri (Image Step Icons)  kesit veya 
aşamalarda küçük resim görünümü varken kesit kesit gezinmeyi sağlar.

Tercih ayarlarınıza göre klavyedeki Sol ve Sağ Ok Tuşlarını kesitler arasında, Yukarı ve Aşağı Tuşlarını da aşamalar arasında 
gezinmeyi kontrol eder.  

NOT:  x (kesit) ve y (aşama) eksenleri değiştirilebilir. Bkz.  Şekil 4, “Diğer Paneli”, sayfa 33. Değiştirme yapılırsa uygulama 
kapatılıp yeniden başlatılmalıdır.



suiteHEART® Yazılımı Kullanım Talimatları NS-03-040-0006 Rev.�1      10

Mod Görünümleri

Mod görünümünün üç biçimi vardır:

Film Modu

- Film: Bir film görüntüsünü film modunda görüntüleme işlemini kontrol eder.

- Film Modu Çubuğu: Filmin başlangıç ve bitiş çerçevelerini tanımlar.

- Saniyedeki Çerçeve Sayısı (FPS): Film hızını değiştirmek için oka tıklayın veya metin kutusuna bir değer girin.

- Oynatma Simgesi: Film modu çubuğunun yanında yer alır.

- Duraklatma Simgesi: Film modu çubuğunun yanında yer alır.

Matris Modu

Matris Modu Simgesi: Görüntü ızgarasını kesit/aşama olarak görüntüler.

Analiz için seçilen görüntüler vurgulanır; endokardiyal ve epikardiyal konturlar not edilir. Matris modu aşamalarda 
gezinmek için kullanılabilir. ED ve ES düğmeleri,aşamaları matriste uygun bir şekilde seçmek için kullanılabilir. Matris giriş 
sonuçlarına tıklanırsa kesit Görüntü Düzenleyiciye yüklenir.

Matris modu, bir satır veya sütundaki kesit konumu üzerinde bulunan konturların silinmesini destekler ve bu işlem kesit 
veya aşama numarası seçilip sağ fare tuşuyla tıklayarak ve silme ögesini seçerek yapılır. Tek bir aşamaya, bir grup aşamaya 
veya kesite ait olan konturlar, matris modunda doğrudan istenen aşama ve kesit konumları seçildikten sonra sağ fare 
tuşuyla tıklayarak ve silme ögesini seçerek silinebilir.

NOT:  x (kesit) ve y (aşama) eksenleri değiştirilebilir. Bkz.  Şekil 4, “Diğer Paneli”, sayfa 33. Değiştirme yapılırsa uygulama 
kapatılıp yeniden başlatılmalıdır.
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ŞEKİL 3- Matris Modu

Matris modu, sistol sonu ve diyastol sonu aşamaları gözden geçirmek ve atamak için kullanılır. Sistol sonu ve diyastol sonu 
hacimlerinin doğru ölçülmesini sağlamak için alma işlemi sırasında kalp atış hızı değiştiğinde tek ED/ES modunda 
kullanılabilir. Sistol sonu için belirtilen kesiti/aşamayı ayarlamak için ES düğmesini seçin ve matris modundaki hücrelere 
tıklayın. Diyastol sonu için belirtilen kesiti/aşamayı ayarlamak için ED düğmesini seçin ve matris modundaki hücrelere 
tıklayın. Hacimler sistol sonu ve diyastol sonu görüntüsü seçildikçe otomatik olarak yeniden hesaplanır.

Çapraz Başvuru Modu

Çapraz Başvuru (Cross Reference) modu, görüntü düzenleme penceresinde kısa eksen görünümü varken, görüntünün 
uzun eksen görünümünü gösterir. Uzun eksen görünümü, düzenleme penceresinde gösterilen görüntünün açısı içinde yer 
alan dikgen bir kesittir. Çapraz başvuru kesit göstergelerinin görünümünü değiştiren bir düğme ve tüm dikgen dilimler için 
kullanılabilen aşağı açılır bir menü mevcuttur. Kesit konumları arasında dolaşmak için eksi ve artı tuşlarını kullanın.

ŞEKİL 4- Çapraz Başvuru Kontrolleri

ŞEKİL 5- Çapraz Başvuru Modu Simgesi
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Görüntü Kullanım Araçları

Tablo 4:  Simgeler ve Adları

Kesit/Aşama Gözden Geçirme Açma/Kapatma

Pencere/Seviye (Window/Level) – Ayar yapmak için seçin ve orta fare düğmesini kullanın.

Kaydır (Pan) – Ayar yapmak için seçin ve orta fare düğmesini kullanın.

Yaklaş (Zoom) – Ayar yapmak için seçin ve orta fare düğmesini kullanın.

Döndür (Rotate) – Ayar yapmak için seçin ve orta fare düğmesini kullanın.

Yatay Çevir (Flip Horizontal) – Görüntüyü yatay olarak çevirir.

Aralık-Hepsi (Scope All) –  Görüntü için yapılan işlemi tüm kesitlere uygular.

Aralık-Mevcuttan Bitişe Kadar (Scope Current to End) – Görüntü için yapılan işlemleri mevcut 
kesitten bitişe kadar uygular.

Aralık-Sadece Mevcut (Scope Current Only) – Görüntü için yapılan işlemleri sadece mevcut kesite 
uygular.

Görüntüleme Alanı Yerleşimi (Viewport Layout) – Görüntüleyici yerleşimini değiştirir.

Karşılaştırma Modu (Compare Mod) – Karşılaştırma koduna geçiş yapar.

Gözden Geçirme Modu (Review Mod) – Gözden geçirme koduna geçiş yapar.

Çapraz Başvuru Hatlarını Göster (Show Cross Reference Lines) – Çapraz başvuru hatlarını açar/
kapatır. 
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Renkli Harita Katmanı (Colormap Overlay) – Kesit sınıflandırma renkli haritasını açar/kapatır.

Başa Al (Reset) – Kapsam ayarlarına uygun olarak W/L, Kaydırma, Yaklaşma ve Döndürme 
işlemlerini varsayılana geri getirir.

İlgi Bölgesi (Region of Interest) – Alan ve çevre ölçümleri sağlar.

İnce Artı İmleç (Crosshair) – Tek piksel verisi için örnekleme sağlar.

Doğrusal (Linear) – Düz hat mesafelerini ölçme imkânı sağlar.

Etiket (Label) – Düzenleme penceresinde kullanıcı notlarının eklenmesini sağlar.

Açı (Angle) – Açı ölçümü sağlar.

Bulma Özelliği (Find Feature) – Aynı konumu içeren görüntüleri otomatik olarak belirlemeyi ve 
görüntülemeyi sağlayan çapraz başvuru aracı.

Geri Al (Undo) – ROI düzenleme için kullanılan geri alma işlevidir.

Yenile (Refresh) – Görüntü Görüntüleyiciyi ağdan yeni alınan görüntülerle güncellemek için bu 
düğmeye tıklayın.

Filtrele (Filter) – Analiz moduna uygun olarak serileri vuru sekans tiplerine göre sıralar. HEPSİ (ALL) 
seçimi yapılarak seçim kaldırılabilir. Filtreler Tercihler altında ayarlanabilir. Filtre kullanımda 
olduğunda filtre düğmesi yeşil renkte görünür.

Tablo 4:  Simgeler ve Adları
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Hızlı Tuşlar 

* Aktif ayarlar Tercihler içinde yapılan seçimlere göre değişir.

Tablo 5:  Hızlı Tuşlar

İşlev Eylem

Görüntüyü Yakınlaştırma Ctrl + Orta Fare Düğmesi

Görüntüyü Döndürme Ctrl + Üst Karakter + Orta Fare Düğmesi

Görüntüyü Kaydırma Üst Karakter + Orta Fare Düğmesi

Pencere / Düzey Orta Fare Düğmesi

Film Oynat/Duraklat Boşluk Tuşu

Rapor Veritabanı Ctrl+D

Tercihleri Düzenleme Ctrl+E

Görüş Alanını Açma/Kapatma Ctrl+F

İncelemeyi Onaylama Ctrl+G

Pencereyi/Seviyeyi Ters Çevirme Ctrl+I

Kalın Hat Notunu Gösterme Ctrl+L

VT’yi Açma ve Tarama Ctrl+O

Raporu Yazdırma Ctrl+P

Uygulamayı Kapatma veya Çıkış Yapma Ctrl+Q

Rapor Önizlemeyi Açma Ctrl+R

Çalışma Değiştirme Ctrl+S

Notu Açma/Kapatma Ctrl+T

Çapraz Başvuru Hatlarını Açma/Kapatma Ctrl+X

Geri Alma Ctrl+Z

İşlev Ctrl+1

Akış Ctrl+2

Miyokardiyal Değerlendirme Ctrl+3

Zamana Bağlı Ctrl+4

PFO Ctrl+5

T2 Star Ctrl+6

T1 Eşleştirme Ctrl+7

T2 Eşleştirme Ctrl+8

3B/4B Ctrl+9

Kesitler arasında dolaşma* Sol ve Sağ Ok Tuşları

Aşamalar arasında dolaşma* Yukarı ve Aşağı Ok Tuşları
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Analiz Görünümü

Her analiz modu için Analiz Görünümü vardır.

ŞEKİL 6- Analiz Görünümü Özellikleri

1. Ölçüm tablosu, 2. Eğri Sonuçları, 3. Sil, 4. Grafikler, 5. Tablolar

1

2

5

3

4
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Analiz Görünümü Gözden Geçirme

Ölçüm Tablosu

ŞEKİL 7- Sonuç Parametreleri: Parametre yanında bulunan kutuya tıklayarak rapora eklenip eklenmeyeceğini belirleyin

NOT:  Kalp atışını girmek ya da düzenlemek için doğrudan sütundaki tabloya tıklayın.

 Grafik ve Tablo Sonuçları

Sonuçlar, Analiz Görünümünde sağ alt köşede bulunan simgelerden seçim yapılarak grafik veya tablo biçiminde görüntülenebilir.

ŞEKİL 8- Grafik (sol) ve Tablo (sağ) Simgeleri: Eğri sonuçlarını gösterir
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Tablo 6:  Analiz Araçları

 Sol Ventriküler Endokardiyal ROI  Sol Ventriküler Yerel ROI

 Sol Ventriküler Epikardiyal ROI
 Sol Ventriküler Kan Havuzu ROI’si

 Sağ Ventriküler Endokardiyal ROI

 Sağ Ventriküler Epikardiyal ROI

 Mitral Kapak Anülusu

 Triküspit Kapak Anülusu

 Sağ Ventriküler Ekleme Noktası

 Sol Ventriküler Papiller Kas ROI’si

 Sağ Ventriküler Papiller Kas ROI’si

 Sol Atriyal ROI 

 Sağ Atriyal ROI

 Uzun Eksen LV Endokardiyal ROI 

 Uzun Eksen LV Epikardiyal ROI 

 Sol Ventriküler Septal ROI
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Rapor Görünümü

suiteHEART® Yazılımında yapısal rapor için dört rapor sekmesi bulunur. Daha fazla bilgi için bkz. Yapılandırılmış Rapor, sayfa 144.

ŞEKİL 9- Raporlama Sekmesi

- Rapor Önizleme Bir raporu önizleme için kullanılır.

- İnceleme Onaylama Raporu imzalamak için kullanılır.
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VT Tarama

VT tarama penceresi yerel veritabanında bulunan geçerli içeriğin görüntülenmesini sağlar. Yerel veritabanında yer alan 
incelemeleri görmenizi ve görüntülemek ya da çalışma listesine eklemek istediğiniz incelemeleri seçmenizi sağlayan 
kontroller sunar.

ŞEKİL 10- VT Tarama Penceresi

1. Yerel veritabanı listesi, 2. suiteHEART® Yazılımı veritabanı görüntüleyici, 3. Görüntüleyiciye Ekle düğmesi, 4. Görüntüleyiciden Kaldır düğmesi,
5. Görünümü Güncelle düğmesi, 6. İptal düğmesi

VT Tarama Özellikleri

VT tara seçeneği varsayılan değeri her zaman yerel veritabanıdır.

1. Yerel veritabanı listesi (Local database listing) – yerel veritabanında saklanan incelemeleri görüntüler.

2. suiteHEART® Yazılımı veritabanı görüntüleyicisi (suiteHEART® Software database viewer) – geçerli suiteHEART®
Yazılımı veritabanında yer alan incelemeleri görüntüler.

3. Görüntüleyiciye Ekle (Add to Viewer) – Yerel veritabanından seçilen incelemeyi (pencerenin üst kısmında gösterilir)
suiteHEART® Yazılımı veritabanı görüntüleme alanına ekler.

4. Görüntüleyiciden Kaldır (Remove from Viewer) – İncelemeyi suiteHEART® Yazılımı veritabanı görüntüleme alanından
kaldırır.

5. Görünümü Güncelle (Update View) – Veritabanı Tarama penceresini kapatır ve görüntülenebilir liste alanındaki
incelemeleri uygulama görüntüleyiciye getirir. Çalışmaları değiştirme penceresini doldurmak için kullanılır.

6. İptal (Cancel) – Veritabanı Tarama penceresini listede değişiklik yapmadan kapatır.

1

2

3 4

6

5
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VT Tarama Prosedürü

İncelemeler yerel veritabanından seçilip suiteHEART® Yazılımı veritabanı Görüntüleyiciye eklenebilir ve Görünümü Güncelle 
(Update View) ögesine tıklanarak görüntülenebilir.

suiteHEART® Yazılımı Çalışma Değiştirme Listesine İnceleme Ekleme

1. Dosya (File) > VT Tarama (Browse DB) ögesine tıklayın.

2. Veritabanı görüntüleyici içinde incelemeyi bulun ve çalışmayı işaretlemek için üzerine tıklayın.

3. Görüntüleyiciye Ekle (Add To Viewer) ögesine tıklayın.

4. Görünümü Güncelle (Update View) ögesine tıklayın.

5. İnceleme artık suiteHEART® Yazılımı Çalışma Değiştirme Listesine eklenmiştir.

suiteHEART® Yazılımı Çalışma Değiştirme Listesinden İnceleme Çıkarma

1. Dosya (File) > VT Tarama (Browse DB) ögesine tıklayın.

2. İncelemeyi bulun ve Görüntüleyiciden Çıkar (Remove from Viewer) ögesine tıklayın.

3. Görünümü Güncelle (Update View) ögesine tıklayın.

DİKKAT: Halen suiteHEART® Yazılımı içinde açık olan bir çalışmayı silmeyin.

İncelemelerin görüntüleyicide gösterilebilmesi için önce suiteHEART® Yazılımına yüklenmesi gerekir. Çalışma Değiştirme 
Listesinin doldurulmasını için bkz. “VT Tarama Prosedürü” .

suiteHEART® Yazılımında Çalışma Değiştirme

1. Dosya (File) > Çalışmayı Değiştir (Switch Study) ögesine tıklayın.

İçinde daha önce VT Tarama prosedürü ile yüklenmiş olan inceleme listesi bulunan Kullanılabilir Çalışmalar (Available 
Studies) penceresi gösterilir.

2. İncelemeyi seçin.

Çalışma Değiştirme (Switch Studies) penceresini açtıktan sonra çalışma değiştirmekten vazgeçerseniz, uygulamaya dönmek 
için pencerenin dışında herhangi bir yere tıklayın.
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Görüntü Yönetim Araçları

Görüntüleyici

Görüntüleyici, çapraz başvurular kullanarak çalışmanın hızla gözden geçirilmesine olanak verir. Görüntüleyici arayüzü, seçili çalışma 
için alınan serilerin listesini her bir seri bir görüntüleme alanında olacak şekilde gösterir. Görüntüleyici arayüzü içinde analiz ve gözden 
geçirme için yeni seri tipleri oluşturulabilir. Çalışma gözden geçirme sürecini hızlandırmak maksadıyla, rutin olarak alınan seriler için 
kullanıcı tanımlı görüntüleme protokolleri tanımlanabilir.

NOT:  Dışa aktarma işlevi sadece suiteHEART analiz modlarında gerçekleştirilebilir. 

ŞEKİL 1- Görüntüleyiciye Genel Bakış

1. Çalışma serisi listesi, 2. Seri/Kesit görüntüleme alanı, 3. Çapraz Başvuru, 4., Seriyi kaydet, 5. Görüntüleme Protokolleri, 6. Rapor sekmelerine geç,
7. Bulma Özelliği, 8. Ölçüm Araçları

1
2

3

4
5

67 8
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Görüntüleyici İşlevleri

Yeni bir Seri Oluşturma

Görüntüleyici, İşlev, Miyokardiyal Değerlendirme ve Zamana Bağlı analizler yapma ya da sadece gözden 
geçirme amaçlı (özel) seri tiplerinin oluşturulmasına olanak sağlar. Oluşturulan seriler, mevcut çalışmanın seri 
listesine eklenir ve suiteHEART® Yazılımı uygulaması içinde görüntülenebilir ve analiz edilebilir.

NOT:  İşlev, Miyokardiyal Değerlendirme veya Zamana Bağlı analiz modlarında kullanılacak yeni serinin her kesiti, aynı 
sayıda aşamaya sahip, aynı elde etme reçetesiyle oluşturulmuş ve paralel olmalıdır.

UYARI : Kullanıcı, analiz için doğru görüntüleri içeren yeni seriyi analiz için oluşturmaktan sorumludur. Hatalı 
oluşturulan seri analiz edilebilir, ancak doğru olmayan sonuçlar verebilir. Kullanıcı kardiyak analizi 
konusunda uygun bir eğitim almış olmalı ve yeni seriye kopyalanan kesit konumu görüntülerinin farkında 
olmalıdır. DICOM içe aktarma için kullanılmış olan orijinal görüntüleri silmeyin.

1. Seri listesinden istenen serileri veya görüntüleri seçin.

2. Üst Karakter tuşuna basarak bir grup seriyi ya da Ctrl tuşuna tıklayarak tek seriyi ekleyin.

3. Tıklayıp çekerek görüntüleme alanı içinde görüntülerin sıralamasını değiştirebilirsiniz.

4. Bir görüntüyü görüntüleme alanından silmek için, görüntüleme alanını seçin ve klavye üzerindeki Sil (Delete) tuşuna
basın.

5. Seri kaydetme alanından Şekil 2  ögesini seçin.

ŞEKİL 2- Seriyi Kaydetme Alanı

6. Seri açıklaması için bir seri adı yazın.

7. İşlev, Miyokardiyal Değerlendirme veya Zamana Bağlı aşağı açılır menülerinden birinden uygun seri tipini seçin (Şekil 3).
Özel (Custom) seçilirse, farklı tarama düzlemlerine ve sekans tiplerine sahip görüntüler bir seri olarak kaydedilebilir.

ŞEKİL 3- Yeni Seriyi Kaydetme
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Hızlı Tuş  

Bir Görüntüleme Protokolü Oluşturma

Seri etiketine göre kullanıcı tanımlı görüntüleme alanını kaydeden bir Görüntüleme Protokolü (Viewing Protocol) 
oluşturarak gözden geçirme sürecini hızlandırın.

NOT:  Görüntüleme Protokolleri, seri etiketlerinin her çalışma için aynı olmasını gerektirir. Seri etiketleri değişmişse 
görüntüler görüntüleme alanında görünmez. 

UYARI : Gözden geçirme için doğru seri tipini içeren Görüntüleme Protokollerini oluşturmaktan kullanıcı 
sorumludur. Bir çalışma içinde seri etiketleri değişirse, Görüntüleme Protokolünün yeniden 
kaydedilmesi gerekir. Gözden geçirme için doğru seri tiplerinin kullanıldığını onaylamak için her zaman 
seri listesini gözden geçirin.

1. Seri listesinden istenen serileri veya görüntüleri seçin.

2. Üst Karakter tuşuna basarak bir grup seriyi ya da Ctrl tuşuna tıklayarak tek seriyi ekleyin.

3. Tıklayıp çekerek görüntüleme alanı içinde görüntülerin sıralamasını değiştirebilirsiniz.

4. Bir görüntüyü görüntüleme alanından silmek için, görüntüleme alanını seçin ve klavye üzerindeki Sil (Delete) tuşuna basın.

5. Görüntüleme Protokolü alanından  ögesini seçin.

6. Bir etiket adı yazın ve aşağı açılır menüden bir ön tanım değeri seçin (Şekil 4).

7. Kaydetmek için Tamam (OK) ögesine tıklayın.

ŞEKİL 4- Görüntüleme Protokolünü Kaydetme

Rapor Görüntüleme Sekmelerine Erişme

Raporlama görünümü sekmelerine erişmek için  ögesine tıklayın.

Görüntüleyici işlevine geri dönmek için  ögesine tıklayın.

İşlev Eylem

Görüntüleme için tüm 
görüntüleri yeniden seçme

Ctrl+A
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Bulma Özelliği*

1. Çapraz başvuru aracını kullanmak için  ögesini seçin. 

Mor imleç, görüntü üzerine konumlandırılabilecek esas imleçtir. 

2. Esas imleç etkinleştirildikten ve konumlandırıldıktan sonra, tüm yakın kesit konumlarını otomatik olarak görüntüleyin,
<Ctrl> tuşuna basın ve sol fare düğmesiyle mor imleci serbest bırakın.

Bu işlemin ardından, ana görüntüleme alanına ikincil yeşil imlecin esas mor imlece yakın olarak hesaplandığı 
kesitler getirilir. 

NOT:  Görüntüleme alanlarında yeşil ikincil artı notları gelir ve bunların içinde paralel olmayan  görüntüler bulunur. Bu 
görüntüler esas imlecin 3B uzayda 10 mm’ye kadar yakınında olduğu hesaplanan noktalardadır.

NOT:  Görüntüleme alanlarında yeşil ikincil artı notları gelir ve bunların içinde paralel  görüntüler bulunur. Bu 
görüntüler esas imlecin 3B uzayda 5mm’ye kadar yakınında olduğu hesaplanan noktalardadır.

*ABD Geçici Patent Başvurusu No. 62/923061
Unvan: Tıbbi Görüntüleri Tespit Etmek ve Göstermek için Yöntem ve Sistem
Mucit(ler): Wolff ve diğerleri.
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Karşılaştırma Modu

Karşılaştırma modu size aynı mevcut ya da daha önceki bir incelemeden görüntüleri/serileri arayüz içinde eş zamanlı 
olarak gözden geçirme olanağı sağlar.

NOT:  Karşılaştırma modunda rapora gönderilen görüntüler bitmap biçiminde olur. Bu görüntüler üzerinde görüntü 
işleme yapılamaz.

UYARI : Bir inceleme içinde incelemeleri ya da serileri gözden geçirmeden veya karşılaştırmadan önce, her iki 
görüntüleyici için tüm inceleme hasta göstergelerini görsel olarak onaylayın. 

ŞEKİL 5- Karşılaştırma Modu Görüntüleyici

1 2

Görüntüleyici 1

Görüntüleyici 2

3
4 5

6

7 8

10
9

12

11
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Görüntüleyici Belirtme Açıklama

Görüntüleyici 1 1 Seri aşağı açılır menüsü

2 Seri seçici

3 Görüntülenmekte olan hasta inceleme gösterge hattı

4 Görüntü kontrolleri

5 Görüntüleme alanı yerleşim seçimleri

Görüntüleyici 2 6 Görüntülenmekte olan hasta inceleme gösterge hattı

7 İnceleme seçici 

8 Seri seçici 

9 Görüntüleme alanı yerleşim seçimleri

Her İki 
Görüntüleyici

10 Kapsam ayarlarını değiştir

11 Gözden Geçirme Modunu Aç

12 Eş zamanlı filmi aç
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Örnek İş Akışı

1. Düzenleyici penceresinde herhangi bir analiz modu üzerine çift tıklayın.

2. Arayüzü Şekil 6‘da gösterildiği gibi iki görüntüleyiciye ayırmak için  ögesini seçin.

ŞEKİL 6- Karşılaştırma Modunda Görüntüleme

3. Görüntüleyici 1 içindeki seriyi değiştirmek için seri aşağı açılır menüsünü ya da sağ/sol ok tuşlarını kullanın.

• Bu üst görüntüleyici her zaman daha önce başlatılmış olan mevcut çalışmayı gösterir.

4. Görüntüleyici 2 içinde göstermek ve Görüntüleyici 1 içinde gösterilen seri ile karşılaştırmak maksadıyla, aynı
incelemedeki başka bir seriyi seçmek için seri aşağı açılır menüsünü kullanın.

• Herhangi bir görüntüleyici içinde bir görüntüleme alanı seçilmişse ve bir kısa eksen serisi gibi paralel bir kesit varsa, kesit
konumuna bağlı olarak, karşılık gelen kesit işaretlenir.

Görüntüleyici 1

Görüntüleyici 2
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ŞEKİL 7- Seri Aşağı Açılır Menüsü, Görüntüleyici 2

5. Görüntüleyici 2 içinde farklı bir inceleme yükleyip Görüntüleyici 1 içinde gösterilmekte olan incelemeyle karşılaştırmak
için inceleme seçiciyi kullanın.

ŞEKİL 8- İnceleme Seçici, Görüntüleyici 2

6. Her iki görüntüleyicide inceleme gösterge bilgisini kontrol ederek uygun inceleme seçimini onaylayın.

ŞEKİL 9- İnceleme Gösterge Bilgisi

7. Her iki görüntüleyicide de sağ fare tuşuyla tıklayınca görüntü işleme araçları açılır.

• Kapsam seçimi her iki görüntüleyiciye de uygulanır.

NOT:  Görüntü farklı bir çalışmada ise, Görüntüler (Images) sekmesinde görüntüye gitme komutunu işletmek geçerli bir 
işlem olmaz. 

NOT:  Her iki görüntüleyicide de film serisi seçildiyse ve her iki serinin de aynı sayıda aşaması varsa, film görüntülemeyi 

eş zamanlı hale getirmek için  ögesine tıklayın.
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Tercihleri Tanımlama

suiteHEART® Yazılımı Arayüz çubuğunda yer alan Tercihler (Preferences) ögesi seçildiğinde üç seçenek görüntülenir: 

• Tercihleri Düzenleme (Edit Preferences)
• Tercihleri İçe Aktarma (Import Preferences)
• Tercihleri Dışa Aktarma (Export Preferences)

ÖNEMLİ: Rapor edilecek ilk vakayı analiz etmeden önce kullanıcı tercihlerinin ayarlanması önerilir. Tercihlerde yapılan 
değişiklikler yeni bir inceleme başlatılana kadar etkili olmaz. 

Tercihleri Ayarlama

Tercihleri Düzenleme (Edit Preferences) özelliği, raporlama özelliklerinin özelleştirilmesini sağlar. Genel ayarlar şunları içerir:

• Rapor Tercihleri (Report Preferences)
• Rapor Onay Yetkili Kişiler (Authorized Report Approvers)
• Seri Filtresi (Series Filter)
• Diğer (Miscellaneous)
• Boşta Kalma Süresi Tercihleri (Idle Timer Preferences)
• Dışa Aktarma Tercihleri (Export Preferences)

Kullanıcı tanımlı parametre aralıkları Şablon Tercihi (Template Preference) sekmesinde oluşturulabilir. Makro Tercihleri 
(Macro Preferences) sekmesinde yapısal raporlama için makrolar oluşturulabilir.

Genel Ayarlar

Rapor Tercihleri

Tüm raporlarda görünen başlık bilgilerini yapılandırır.
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ŞEKİL 1- Rapor Düzeni Sekmesi

Rapor Tercihleri Prosedürü 

1. Görüntü Görüntüleme (Image View) menü çubuğunda Araçlar (Tools) > Tercihler (Preferences) > Tercihleri Düzenle
(Edit Preferences) ögelerine tıklayın.

2. Genel Ayarlar (Global Settings) sekmesini seçin.

3. İmleci Rapor Tercihleri (Report Preferences) panelinin istediğiniz alanına getirin ve bilgileri girin.

Başlıklar, üst bilgiler ve logo belirtilen kağıt boyutundaki raporda gösterilecektir. Bu bilgileri raporun dışında 
tutmak için "Raporda aşağıdaki alan değerlerini kullan” ("Use the field values below in Report”) onay kutusunun 
seçimini iptal edin. Bu, yazdırılan tüm hasta raporları için geçerli olacaktır. 

“Tek ve çift satırları destekle” (“support even and odd row”) onay kutusunu işaretlerseniz rapordaki sonuç 
satırları işaretlenerek gösterilir.
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4. Rapora site logosu eklemek için dosyayı jpeg, png veya gif biçiminde hazırlayın ve sabit sürücüye veya CD-ROM'a
kaydedin. Logo bölümünün altında Gözat (Browse) ögesine tıklayın ve sistem tarayıcı penceresinden dosyanın
konumunu belirleyin. Uygun logo dosyasını seçin ve Aç (Open) ögesine tıklayın.

Logo rapor tercihleri panelinde görünecektir.

5. Dışa aktarılacak raporun dosya ismini yapılandırmak için İnceleme Dosya Adı (Exam File Name) üzerine sağ fare
tuşuyla tıklayın.

6. Girdiğiniz verileri saklamak ve Tercihleri Düzenlemeyi kapatmak için Kaydet ve Çık (Save and Exit) ögesine tıklayın.

• Değişiklikleri kabul etmeden pencereyi kapatmak için İptal (Cancel) ögesine tıklayın.
• Pencereden çıkmadan Genel Tercihler (Global Settings) sekmesindeki tüm değerleri sıfırlamak için Sıfırla (Reset) ögesine

tıklayın.

Rapor Onay Yetkili Kişiler

Uygulamada nihai raporu kilitleyen rapor onay özelliği vardır. Rapor kilitlendikten sonra değiştirilemez. Onay yetkili kişi 
kimlik bilgileri açıklandığı gibi eklenir, değiştirilir ve silinir.

ŞEKİL 2- Rapor Onay Yetkili Kişiler (Authorized Report Approvers)

Rapor Onay Yetkili Kişileri Yönetme Prosedürü

1. Görüntü Görüntüleme (Image View) menü çubuğunda Araçlar (Tools) > Tercihler (Preferences) > Tercihleri Düzenle
(Edit Preferences) ögelerine tıklayın.

2. Genel Tercihler (Global Settings) sekmesini seçin ve imleci Rapor Onay Yetkili Kişiler (Authorized Report Approvers)
paneline getirin.

3. Onay yetkili kişiler listesine kullanıcı adı eklemek için Ekle (Add) sekmesine tıklayın.

• Kullanıcı adı girin.
• Parolayı iki kez girin.
• Ekle (Add) ögesini seçin.
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4. Onay yetkili kişiler listesindeki bir kullanıcının parolasını değiştirmek için Değiştir (Modify) sekmesini seçin.

• Parolası değiştirilecek kullanıcıyı seçin.
• Eski parolayı girin.
• Yeni parolayı iki kez girin.
• Uygula (Apply) ögesini seçin.

5. Onay yetkili kişiler listesinden bir kullanıcı silmek için Sil (Delete) sekmesini seçin.

• Silinecek kullanıcıları seçin.
• Sil (Delete) ögesini seçin.

Seri Filtresi (Series Filter)

Analiz modu tipine göre, analiz için uygun serinin seçimini hızlandırmak maksadıyla bir seri filtresi uygulanabilir. Filtre 
tercihleri analiz sırasında ana panelde küçük resim görünümünün üzerinde bulunan filtre düğmesine tıklayarak da seçilebilir. 

ŞEKİL 3- Filtre Tercihleri

Filtre Tercihi Seçme

1. Görüntü Görüntüleyici (Image Viewer) menü çubuğunda Araçlar (Tools) > Tercihler (Preferences) > Tercihi Düzenle
(Edit Preference) ögelerine tıklayın.

2. Genel Ayarlar (Global Settings) sekmesini seçin.

3. Her analiz tipi için uygun açık/kapalı seçimlerinin üzerine tıklayın.

4. Girdiğiniz verileri saklamak ve Tercihleri Düzenlemeyi kapatmak için Kaydet ve Çık (Save and Exit) ögesine tıklayın.

• Değişiklikleri kabul etmeden pencereyi kapatmak için İptal (Cancel) ögesine tıklayın.
• Pencereden çıkmadan Genel Tercihler (Global Settings) sekmesindeki tüm değerleri sıfırlamak için Sıfırla (Reset) ögesine tıklayın.

NOT:  Bir seri filtresi uygulandıysa ve gerekli seri mevcut değilse, bir mesaj görünür: “Seçili analiz tipiyle eşleştirilmiş 
seri yok” (“There are no series associated with the selected analysis type”). Tamam (OK) düğmesine tıklanırsa, 
filtre etkisiz hale gelir ve çalışma içindeki tüm seriler gösterilir.
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Diğer (Miscellaneous)

ŞEKİL 4- Diğer Paneli

Diğer Parametrelerini Düzenleme Prosedürü 

1. Görüntü Görüntüleme (Image View) menü çubuğunda Araçlar (Tools) > Tercihler (Preferences) > Tercihleri Düzenle
(Edit Preferences) ögelerine tıklayın.

2. Genel Tercihler (Global Settings) sekmesini seçin ve imleci Diğer (Miscellaneous) paneline getirin.

3. Hasta adını ve kimliğini raporda gizlemek için Hastayı Anonim Hale Getir (Anonymize Patient) onay kutusunu
işaretleyin.

Tüm hastaların adları “anonim” olarak görünür ve kimlik boş olarak ayarlanır. Bu değişiklikler rapor ve Görüntü 
Görünümüne uygulanacaktır.

4. Uygulamayı tablette çalıştırmak için Tablet Modunu Etkinleştirin (Enable Tablet Mode).

5. 2B ve 4B aşama kontrastı için otomatik aşama hatası düzeltme yapmak istiyorsanız Otomatik Ana Hat Düzeltmeyi
Etkinleştir (Enable Auto Baseline Correction) onay kutusunu işaretleyin.

6. Notları kalın çizgiler halinde göstermek için Kalın Çizgili Notları Göster (Display Thick Line Annotation) onay kutusunu 
işaretleyin.

7. Tüm analiz oturumlarında düzenleme aracını açmak için Sürükleme Aracı ile Düzenle (Edit with Nudge Tool) onay
kutusunu işaretleyin.

8. İpuçlarını kapatmak için Düğme İpuçlarını Kapat (Disable Button Tooltips) ögesini işaretleyin.
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9. Eğrileri görüntülemek için LV Etkinleştir (Enable LV) ögesini,  RV Gölge Eğri (RV Shadow Curve) ögesini veya her ikisini 
birden işaretleyin.

10. Örtüşmeyi engellemek için Aktif ROI’yi Örtüşme Olmadan Düzenle (Edit Active ROI for no overlap) ögesini işaretleyin.

“Aktif ROI’yi Örtüşme Olmadan Düzenle” (“Edit Active ROI for No Overlap”) ögesi işaretli ise, mevcutta seçili olmayan ROI’ler 
baskındır, işaretli olmadığında düzenlenmekte olan ROI baskındır.

11. Ekseni çevirmek için Matris modunda x (kesit) ve y (aşama)’yi çevir [Flip x(slice) and y(phase) axis for matrix mode]
ögesini işaretleyin.

12. İşlev analizi için otomatik bazal hat yerleştirme için ya Otomatik MV (Automatic MV) ya da TV Anülus Hattı Ekleme
(TV Annulus Line Insertion) ögesini işaretleyin.

13. Otomatik Bölümleme kullanırken düzenleme yapmak için Otomatik İşlev için analiz araçlarını kullan (Persist analysis
tools for Function Auto) ögesini işaretleyin.

14. Vakayı doğrudan Virtual Fellow™ ile açmak için Çalışmayı Virtual Fellow ile Aç (Open study with Virtual Fellow)
ögesine tıklayın.

15. Dosya aşağı açılır menüsünden Siemens Otomatik Birleştirme Modunu (Siemens Auto Combine Mode) seçin.

NOT:  Seri adı “null” ise seri göz ardı edilir.

16. T1 Eşleştirme Sekans Tipi (T1 Mapping Sequence Type) aşağı açılır menüsünden Satürasyon Kazanımı (Saturation
Recovery) veya MOLLI ögesini seçin.

17. Girdiğiniz verileri saklamak ve Tercihleri Düzenlemeyi kapatmak için Kaydet ve Çık (Save and Exit) ögesine tıklayın.

• Değişiklikleri kabul etmeden pencereyi kapatmak için İptal (Cancel) ögesine tıklayın.
• Pencereden çıkmadan Genel Tercihler (Global Settings) sekmesindeki tüm değerleri sıfırlamak için Sıfırla (Reset) ögesine tıklayın.

Boşta Kalma Süresi Tercihleri (Idle Timer Preferences)

Boşta Kalma Süresi Tercihleri (Idle Timer Preferences) paneli, uygulamada belirli bir süre herhangi bir eylem yapılmadığında 
uygulamanın kapatılması için dakika cinsinden bir süre ayarlamak için kullanılır. 

ŞEKİL 5- Boşta Kalma Süresi Tercihleri Penceresi
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Boşta Kalma Süresi Tercihleri Düzenleme Prosedürü

1. Görüntü Görüntüleme (Image View) menü çubuğunda Araçlar (Tools) > Tercihler (Preferences) > Tercihleri Düzenle
(Edit Preferences) ögelerine tıklayın.

2. Genel Tercihler (Global Settings) sekmesini seçin ve imleci Boşta Kalma Süresi Tercihleri (Idle Timer Preferences)
paneline getirin.

3. Boşta kalma süresi özelliğini etkinleştirmek için Boşta Kalma Süresi (Idle Timer) onay kutusunu seçin.

4. İstenen süreyi dakika olarak belirlemek için boşta kalma süresi işaretçisini çekin.

5. Girdiğiniz verileri saklamak ve Tercihleri Düzenlemeyi kapatmak için Kaydet ve Çık (Save and Exit) ögesine tıklayın.

• Değişiklikleri kabul etmeden pencereyi kapatmak için İptal (Cancel) ögesine tıklayın.
• Pencereden çıkmadan Genel Tercihler (Global Settings) sekmesindeki tüm değerleri sıfırlamak için Sıfırla (Reset) ögesine

tıklayın.

Dışa Aktarma Tercihleri (Export Preferences)

Dışa Aktarma Tercihleri (Export Preferences) paneli görüntü ve video verilerini dışa aktarmak için görüntü biçimlerini 
seçmenizi sağlar. Dışa aktarma özelliği, görüntü verilerinden sıkıştırılmamış AVI filmleri, sıkıştırılmış QuickTime filmleri ve 
JPEG, TIFF ve PNG dosyaları oluşturmanızı sağlar.

ŞEKİL 6- Dışa Aktarma Tercihleri Penceresi

Dışa Aktarma Tercihleri Prosedürü 

1. Görüntü Görüntüleme (Image View) menü çubuğunda Araçlar (Tools) > Tercihler (Preferences) > Tercihleri Düzenle
(Edit Preferences) ögelerine tıklayın.

2. Genel Tercihler (Global Settings) sekmesini seçin ve imleci Dışa Aktarma Tercihleri (Export Preferences) paneline
getirin.

3. Uygun görüntü veri türlerini seçin.

4. Girdiğiniz verileri saklamak ve Tercihleri Düzenlemeyi kapatmak için Kaydet ve Çık (Save and Exit) ögesine tıklayın.

• Değişiklikleri kabul etmeden pencereyi kapatmak için İptal (Cancel) ögesine tıklayın.
• Pencereden çıkmadan Genel Tercihler (Global Settings) sekmesindeki tüm değerleri sıfırlamak için Sıfırla (Reset) ögesine

tıklayın.
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Şablon Tercihleri (Template Preferences)

Uygulama, belirli nicel parametreleri ölçen ve rapor eden yapılandırılmış bir iş akışı sağlayan; yaş, beden yüzey alanı ve 
ağırlık temelli, kullanıcı tanımlı şablonlar oluşturmak için bir araç sağlar.

ŞEKİL 7- Şablon Tercihleri Sekmesi

Önemli Noktalar

Analize başlamadan önce, ana arayüzden kullanıcı tanımlı şablon seçilmelidir. Sağ üstte bulunan Varsayılan (Default) 
düğmesine tıklayın ve kullanılacak şablonu seçin. Analiz yaptıktan sonra şablon değiştirilirse, tercih aralığı şablona 
uygulanır.

NOT:  Daha önceki suiteHEART analizlerini içeren içe aktarılmış çalışmalarda, çalışmada kullanılan şablonun adı 
görünebilir. Bu şablon mevcut yazılımda bulunmayabilir.

Analiz için iki sistem kullanılıyorsa, şablon tercih dosyasının birinci sistemde oluşturulup ikinci sisteme aktarılması tavsiye 
edilir. Farklı bir sistemden içe aktarılan şablon tercih dosyaları, aktarıldıkları sistemde oluşturulmuş olan şablon tercih 
dosyalarının üzerine yazılır.

ŞEKİL 8- Şablon Değiştirme

Şablon Oluşturma Prosedürü

Aşağıda kullanıcı tanımlı şablon oluşturma kılavuzu yer almaktadır. Kullanılan parametre aralığının geçerliliğini 
doğrulamak, klinik tedavi uzmanının kararına bağlıdır.

Bir Şablon Oluşturma

Tüm yeni şablonlar, önceden var olan bir şablon çoğaltılarak oluşturulur. Ürünle birlikte gönderildiğinden ve her zaman 
kullanılabilir olduğundan örnekte Varsayılan (Default) şablon kullanılacaktır. Varsayılan şablon düzenlenemez. Kullanıcı 
tanımlı bir şablon oluşturmak için şunları yapın: 
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1. Araçlar (Tools) > Tercihler (Preferences) > Tercihleri Düzenle (Edit Preferences) ögelerini seçin.

2. Şablon Tercihleri (Template Preferences) sekmesini seçin.

3. Yeni Oluştur (Create New) düğmesine tıklayın.

4. Yaş, beden yüzey alanı veya ağırlık tercih aralıklarından birini seçin.

ŞEKİL 9- Şablon Değiştirme Penceresi

5. Şablon için yeni bir ad girin.

Yeni bir ad girildiğinde, Geçerli Şablon (Current Template) aşağı açılır menüsü güncellenir.

6. İstenen parametreler için aralık tercihlerini girin.

7. Kaydet ve Çık (Save and Exit) ögesine tıklayın.

- Değişiklikleri kaydetmeden pencereyi kapatmak için İptal (Cancel) ögesini seçin.

Şablonu Çoğaltma

1. Araçlar (Tools) > Tercihler (Preferences) > Tercihleri Düzenle (Edit Preferences) ögelerini seçin.

2. Şablon Tercihleri (Template Preferences) sekmesini seçin.

3. Geçerli Şablon (Current Template) aşağı açılır menüsünden şablonu seçin.

4. Çoğalt (Duplicate) düğmesine tıklayın.

Şablon Silme

1. Araçlar (Tools) > Tercihler (Preferences) > Tercihleri Düzenle (Edit Preferences) ögelerini seçin.

2. Şablon Tercihleri (Template Preferences) sekmesini seçin.

3. Geçerli Şablon (Current Template) aşağı açılır menüsünden şablonu seçin.

4. Sil (Delete) düğmesine tıklayın.

Tercih Aralıklarını Düzenleme

1. Araçlar (Tools) > Tercihler (Preferences) > Tercihleri Düzenle (Edit Preferences) ögelerini seçin.

2. Şablon Tercihleri (Template Preferences) sekmesini seçin.

3. Varsayılan dışında bir şablon seçin.
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ŞEKİL 10- Şablon Tercihleri

1. Geçerli şablon, 2. Kategori seçimi, 3. Analiz başına parametre ölçümü, 4. Erkek alt ve üst sınırlar, 5. Kadın alt ve üst sınırlar, 6. Aralık çubuğu.

4. İstenen şablon kategorisini seçin. Seçimler Yaş, Beden Yüzey Alanı ve Ağırlık olabilir.

NOT:  Seçilen şablon, oturumda uygulanacak olan şablondur.

5. Aktif hale getirmek için Aralık çubuğuna sol tıklayın.

Çubuk aktif olduğunda rengi yeşil olur.

6. Aralık çubuğunun ortasında aralık bölücü çubuk oluşturmak için Aralık çubuğuna sağ tıklayın.

• Aralık bölücü çubuklar konumu ayarlamak için sürüklenebilir.
• Birden fazla aralık bölücü çubuk oluşturulabilir.
• Aralık bölücü çubuklar, imleç çubuğun yakınına yerleştirilerek ve sağ fare menüsünden Aralığı Sil (Delete Range) seçilerek

silinebilir.

7. Uygun analiz modu için aralık değerlerini girin. Hem alt hem de üst sınırları girin. Gerekirse erkek ve kadın değerlerini
farklı olarak girin. Cinsiyetler arasındaki değerleri kopyalamak için Tümünü Kopyala (Copy All) oklarını kullanın. Tüm
analiz türleri için ölçümlere gitmek maksadıyla kaydırma çubuğunu kullanın.

UYARI : Parametre aralıkları için girilen değerler tamamen kullanıcı sorumluluğundadır. Analizden önce tüm 
parametre aralıklarını onaylayın. Hatalı parametre değerleri yanlış teşhise sebep olabilir.

8. Girdiğiniz verileri saklamak ve Tercihleri kapatmak için Kaydet ve Çık (Save and Exit) ögesine tıklayın.

• Değişiklikleri kabul etmeden pencereyi kapatmak için İptal (Cancel) ögesine tıklayın.

1
2

3

4 5

6
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NOT:  Bir şablonun geçerli olması için, parametre değerlerinin hem alt hem de üst sınırlarının girilmiş olması ve girilen 
değerlerin de rakam olması gerekir. Değerlerde tutarsızlıklar varsa, şu mesaj görünür: “Geçersiz normal aralık 
seçildi. (Invalid normal range selected.) Lütfen düzeltin ve yeniden kaydedin. (Please correct and save again.)” 
Düzeltilmesi gereken parametre kırmızı olarak gösterilecektir. Boş bir şablonun kaydedilmesine izin verilmez ve 
bu yapılmak istenirse “Şablon(lar) kaydedilemiyor” [“Unable to Save Template(s)”] mesajı görünür.

NOT:  Akış için girilen değerler hem 2B hem de 4B akış analiz sonuçlarını etkiler.

NOT:  Daha fazla bilgi için Ek A'ya bakın.

Makro Tercihleri

Makrolar kardiyak MRI vakasını rapor etmek için harcanan zamanı önemli ölçüde azaltabilir. Tüm makrolar şablonlardan 
bağımsızdır. Makroların basitleştirilmiş kullanıcı arabirimi, aşağıdakiler de dahil olmak üzere, görevleri otomatik hale getirir:

• Önceden tanımlanmış ve  otomatik olarak eklenebilen klinik izlenimler ve teknikler oluşturma.
• Nicel sonuçları analiz rapor penceresinden otomatik olarak ekleme.

İzlenimler Makrosu Ekleme

NOT:  Geçmiş veya Teknik makrosu oluşturmak için İzlenim makrosu oluşturma iş akışı takip edilir.

1. Araçlar (Tools) > Tercihler (Preferences) > Tercihleri Düzenle (Edit Preferences) ögelerini seçin.

2. Makro Tercihleri (Macro Preferences) sekmesini seçin.

3. İzlenimler Makrosu Ekle (Add Impressions Macro) ögesine tıklayın. İzlenim Makroları (Impression Macros) panelinde 
yeni bir düğme görünür.

ŞEKİL 11- İzlenim Makroları Penceresi

4. İmleci yeni düğme alanının içine yerleştirin ve istediğiniz adı girin.

NOT:  Oluşturulan makro düğmeleri yeniden sıralanabilir. İstediğiniz düğmeye tıklayıp liste içinde çekin.

Makro Metnini Girme

1. İmleci Makro Bilgileri (Macro Information) metin kutusuna getirin ve ilgili metni girin.

2. Hesaplama girmek için aşağıdaki analiz sekmelerinden birini seçin ve istediğiniz parametre düğmesine tıklayın;
parametre otomatik olarak makro bilgilerine girilecektir. Bu örnekte, LV Ejeksiyon Fraksiyonu parametresi seçilmiş ve
metnin sonuna girilmiştir.
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ŞEKİL 12- Makro Bilgisi

ŞEKİL 13- Makro Bilgileri Penceresi 

3. Yaptığınız değişiklikleri yeni makroya kaydetmek ve Makro Düzenleyiciden çıkmak için Kaydet ve Çık (Save and Exit)
ögesini seçin.

• Değişiklikleri kaydetmeden Makro Düzenleyiciden çıkmak için İptal (Cancel) ögesini seçin.

Makro Çalıştırma

Makro çalıştırmanın ön koşulu olarak, sayısal hesaplamalar içeren makrolar çalıştırılmadan önce analiz sonuçları 
oluşturulmalıdır. Otomatik rapor üretme için Teknik ve İzlenim makroları oluşturulabilir.

Makro  Silme

1. Araçlar (Tools) > Tercihler (Preferences) > Tercihleri Düzenle (Edit Preferences) ögelerini seçin.

2. Makro Tercihleri (Macro Preferences) sekmesini seçin.

3. Listeden makroyu seçin.

Gösterilen örnekte, MACRO_3 adlı makro silinmek üzere seçilmiştir.

ŞEKİL 14- Makro Seçim Listesi

4. Seçilen Makroyu/Makroları Kaldır [Remove Selected Macro(s)] ögesini seçin.
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Yazdırma Tercihleri

Yazdırma Tercihleri (Print Preferences) sekmesinde, her bir analiz modunda hesaplanan sonuçların rapora girip 
girmeyeceği ayarlanabilir.

ŞEKİL 15- Yazdırma Tercihleri Penceresi

1. Görüntü Görüntüleyici (Image Viewer) menü çubuğunda Araçlar (Tools) > Tercihler (Preferences) > Yazdırma
Tercihleri (Print Preferences)  ögelerine tıklayın.

2. Uygun analiz sekmesini seçin ve rapora girmesini istediğiniz sonucu işaretleyin.

3. Tüm analiz modu sekmeleri için tekrarlayın.

4. “Kaydet ve Çık (Save and Exit)” ögesine tıklayın.

NOT:  Yazdırma seçimleri doğrudan uygulama arayüzü üzerinden yapıldıysa, şablona kaydedilmezler.
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Tercihleri İçe Aktarma

Tercihler dosya sisteminden içe aktarılabilir. 

Tercihleri İçe Aktarma Prosedürü

1. Araçlar (Tools) > Tercihler (Preferences) > Tercihleri İçe Aktar (Import Preferences) ögelerini seçin.

ŞEKİL 16- Tercihleri İçe Aktarma Penceresi

2. Tara (Browse) düğmesine tıklayın, tercih dosyasının konumunu bulun ve Aç (Open) düğmesine tıklayın.

3. Görüntüleme protokollerini içe aktarmak için Sadece Görüntüleme Protokolleri (Only Viewing Protocols) seçenek
düğmesini seçin.

4. İçe aktarma prosedürünü açıklandığı gibi gerçekleştirmek için Tamam (OK) ögesine tıklayın.

• Şablonu içe aktarmadan pencereden çıkmak için İptal (Cancel) ögesine tıklayın.

NOT:  suiteHEART® Yazılımının önceki sürümlerinden (4.0.4 veya altı) içe aktarma desteklenmemektedir. Önceki 
sürümlerden tercihleri içe aktarma konusunda yardım almak için lütfen service@neosoftmedical.com adresinden 
NeoSoft  Destek ile iletişim kurun.

Tercihleri Dışa Aktarma

Tercihler dosya sistemine dışa aktarılabilir.

Tercihleri Dışa Aktarma Prosedürü

1. Araçlar (Tools) > Tercihler (Preferences) > Tercihleri Dışa Aktar (Export Preferences) ögelerini seçin.

ŞEKİL 17- Tercihleri Dışa Aktarma Penceresi

2. Tara (Browse) düğmesine tıklayın, tercih dosyasını kaydedeceğiniz konumu bulun ve Kaydet (Save) düğmesine tıklayın.

3. Dışa aktarma prosedürünü açıklandığı gibi gerçekleştirmek için Tamam (OK) ögesine tıklayın.

• Şablonu dışa aktarmadan pencereden çıkmak için İptal (Cancel) ögesine tıklayın.
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Virtual Fellow™

Virtual Fellow™ kardiyak MR çalışmaları için standart hale getirilmiş bir görüntü izleme özelliğidir. Bu özellik görselleştirme 
iş akışını iyileştirir ve kardiyak MR çalışmalarının klinik uzmanlar tarafından gözden geçirilmesini kolaylaştırır. Bu özellik, 
pencere seviyeleme, yaklaşma, kaydırma ve döndürme gibi görüntü kullanım araçlarını otomatik olarak uygular. Mevcut ve 
önceki kardiyak MR çalışmaları Virtual Fellow™ özelliği ile kolayca gözden geçirilebilir.

NOT:  Ön işlemeli Virtual Fellow™ özelliğini etkinleştirmek için suiteDXT Kullanım Talimatları NS-03-040-0012 
dokümanına bakın.

NOT:  Virtual Fellow™ içinde görüntülenebilmesi için hem mevcut hem de önceki incelemelerdeki hasta kimlik bilgisi 
eşleşmelidir. 

NOT:  Virtual Fellow™ içinde analiz sonuçları düzenlenemez, düzenleme yapmak için uygun analiz modunu seçin. 

UYARI : Virtual Fellow™ tarafından oluşturulan görüntüleme protokolleri için doğru görüntü seçimini onaylamak 
kullanıcı sorumluluğundadır. Mevcut/önceki görüntüleme protokolleri için yanlış belirlenen görüntüler 
manüel olarak seçilebilir. Uygun görüntülerin gözden geçirildiğinden emin olmak için, kullanıcı kardiyak 
görüntüleme teknikleri konusunda uygun bir şekilde eğitilmiş olmalıdır. Çalışma için alınan tüm 
görüntüleri gözden geçirmek için Görüntü Yönetim Araçları, sayfa 21 bölümünde bulunan Görüntüleyici 
modunu kullanın.

UYARI : Çalışmaları gözden geçirmeden veya karşılaştırmadan önce, arayüzün üst kısmında bulunan hasta 
gösterge bilgilerinin tamamını görsel olarak doğrulayın. #1 mevcut çalışmayı, #2 önceki çalışmayı 
gösterir.

UYARI : Virtual Fellow™ tarafından gerçekleştirilen WW/WL, kaydırma, yaklaşma, döndürme ve çevirme gibi 
görüntü kullanım işlemleri farklı patolojlerin görünümünü ve diğer anatomik yapıların anlaşılmasını 
etkileyebilir. Her görüntüleme protokolünü gözden geçirin ve uygun ayarlamaları yapın.
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Virtual Fellow™ ile Ön İşleme

Seri Tanımı

Otomatik Bölümleme

(tanımlanan seri için)

Otomatik Kapakçık Anülusu 

Virtual Fellow™ - Görüntü 

Tamam

Tespit Etme (etkinse)

Optimizasyonu (etkinse)
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Virtual Fellow™ Arayüzü

Virtual Fellow™ Arayüz Araçları

Seçim Açıklama

Virtual Fellow™

İşlev sonuçlarını gösterme

Akış sonuçlarını gösterme

Miyokardiyal Değerlendirme sonuçlarını 
gösterme

Uzun Eksen Çapraz Başvuru

ve Sonuç Görünümü

Ana Görüntüleyici

Görüntü Görüntüleme Kontrolleri

Görüntüleme
Protokolleri



suiteHEART® Yazılımı Kullanım Talimatları NS-03-040-0006 Rev.�1      46

WW/WL, kaydırma, yaklaşma, döndürme ve 
çevirme işlemlerini hem mevcut hem de önceki 
seri üzerinde aynı anda yapmayı sağlayan 
Bağlama Anahtarı.

WW/WL, kaydırma, yaklaşma, döndürme ve 
çevirme işlemlerini tek seri üzerinde aynı anda 
yapmayı sağlayan Çözme Anahtarı.
Not: Yaklaşma her zaman hem mevcut seride 
hem de önceki seride gerçekleştirilir.

Aşama, aşama duyarlı geç gelişmeyi (LE) 
görüntülemek için kullanılır.

Büyüklük, büyüklük duyarlı geç gelişmeyi (LE) 
görüntülemek için kullanılır.

Hareket düzeltmeli Zamana Bağlı seri 
görüntüleme için MOCO kullanılır.

Hareket düzeltmesiz Zamana Bağlı seri 
görüntüleme için NO MOCO kullanılır.

#1 mevcut çalışma için görüntülenen seriyi 
gösterir. Seriyi değiştirmek için doğrudan #1 
ifadesine sol fare tuşuyla tıklayın. 

#2 önceki çalışma için görüntülenen seriyi 
gösterir. Seriyi değiştirmek için doğrudan #2 
ifadesine sol fare tuşuyla tıklayın.

Filmi oynatmak, duraklatmak, saniyede 
gösterilecek çerçeve sayısını belirlemek ve 
başlangıç ile bitiş çerçevelerini belirlemek için 
film kontrolleri kullanılır.

Aynı konumu içeren görüntüleri otomatik 
olarak belirlemeyi ve görüntülemeyi sağlayan 
çapraz başvuru aracı. Bu özelliğin kullanılması 
hakkında bilgi almak için bkz. Bulma Özelliği*, 
sayfa 24.

Ölçüm araçları.

Seçim Açıklama
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Görüntüleme Protokolleri

Jenerik düzenlemeleri geri alma.

Görüntüleme alanı yerleşim seçenekleri*: 
1x1, 1x2, 4x4 ve 5x4.
*Seçilen protokole bağlıdır.

Kapsam Görüntü Kullanım Araçları, sayfa 12 
bölümünde anlatılan işleve sahiptir.

Klavye Sol Ok Tuşu Mevcut/önceki görüntüleme protokolü 
içindeyken kesit konumunu ilerletmek için 
kullanılır.

Klavye Sağ Ok Tuşu Mevcut/önceki görüntüleme protokolünde 
kesit konumunu tersine çevirmek için 
kullanılır.

Seri Tipi

Kısa eksen film işlev serisi.

Önceki çalışma ile kısa eksen film işlevi serisi.

Miyokardiyal Değerlendirme.

Önceki ile Miyokardiyal Değerlendirme.

Miyokardiyal Değerlendirmeli kısa eksen film işlevi.

Zamana Bağlı seri-Stres

Seçim Açıklama
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Klavye Kısayolları

Önceki  ile Mevcut Zamana Bağlı Stres

Miyokardiyal Değerlendirme ile Mevcut Zamana Bağlı Stres

Zamana Bağlı Stres/Dinlenme serisi.

T1 aksiyal seri.

T1 aksiyal seri içeren SSFP.

İşlev Klavye 
Eylemi

Sarı köşe işareti mevcutsa uzun eksen görüntüleri boyunca ileri gitme. Z

Sarı köşe işareti mevcutsa uzun eksen görüntüleri boyunca geri gitme. A

Seri Tipi
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Görüntüleme Protokolleri için Kullanıcı Seri Seçimi

Görüntüleme protokolleri, mevcut ya da önceki çalışmadan alınan görüntüleri görüntülemek için yapılandırılmıştır. 
Gösterilen görüntüler gözden geçirilmesi beklenen görüntüler değilse, Virtual Fellow™ arayüzünde Şekil 1‘de gösterildiği 
gibi doğrudan sayı gösterimi (mevcut çalışma için #, önceki çalışma için #2) üzerine sol fare tuşuyla tıklayarak uygun seriyi 
yeniden seçin. Mevcut seri için (#1) gösterilen seri listesinden uygun seriyi seçin. 

ŞEKİL 1- Virtual Fellow Arayüzü
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Uzun Eksen Çapraz Başvuru Görüntüleme Alanları için Kullanıcı Seri 
Seçimi

Gösterilen görüntüler gözden geçirilmesi beklenen görüntüler değilse, aşağıdaki Şekilde gösterildiği gibi, doğrudan uzun 
eksen görüntüleme alanı üzerine tıklayıp dosya aşağı açılır menüsünden görüntü seçilerek uygun seri seçimi yapılabilir.

NOT:  Klavyeden Z veya A seçimleri yapılırsa, kullanıcı tarafından seçilen görüntü görüntüleme alanında artık durmaz.

Virtual Fellow™ için Uzun Eksen Tepe Yönü Tercihi

1. Görüntü Görüntüleme (Image View) menü çubuğunda Araçlar (Tools) > Tercihler (Preferences) > Tercihleri Düzenle
(Edit Preferences) ögelerine tıklayın.

2. Virtual Fellow™ sekmesini seçin.

3. Uzun eksen görüntüleme için istenen tepe yönünü aşağıda gösterildiği gibi seçin.

ŞEKİL 2- Uzun Eksen Tepe Yönü Tercihi
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Konturları Düzenleme

Bu bölümde açıklanan kontur düzenleme tüm analiz modlarında yapılabilir. Bu özellik hen Düzenleme Penceresinde hem 
de Gözden Geçirme Penceresinde mevcuttur.

Kontur Düzenleme Seçenekleri

Konvansiyonel Düzenleme

1. Düzenleme Penceresinde kontur üzerine sol fare tuşu ile tıklayın. Kontur seçildiğinde mora döner.

2. Şekil 1‘de gösterildiği gibi, konturu hareket ettirmek için konturun merkezi üzerinde sol fare tuşu ile tıklayıp çekin.

• Seçilen kontur nokta eğrisi yöntemiyle oluşturulmuşsa, noktalar düzenleme için görüntülenir. Kontur boyutunu ve şeklini
ayarlamak için, Şekil 1‘de gösterildiği gibi noktalardan herhangi birine sol fare tuşuyla tıklayın ve çekin.

• Seçilen kontur serbest çizim aracıyla oluşturulmuşsa, konturu güncellemek için sol fare tuşuyla tıklayın ve basılı tutun.

ŞEKİL 1- Konvansiyonel Kontur Düzenleme
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Sürükleme Aracı

1. Sürükleme aracını aktifleştirmek maksadıyla konturu seçmek için üzerine sol fare tuşuyla tıklayın. Ardından, Şekil 2‘de
gösterildiği gibi, açılan menüden sağ fare tuşuyla tıklayarak sürükleme aracını seçin.

• Sürükleme aracı uygulandığında, seçili nokta ROI otomatik olarak bir serbest çizim ROI haline gelir.

ŞEKİL 2- Sürükleme Aracını Aktifleştirme

2. İmleç kare şeklinde görünecektir. İmleci ROI’den uzaklaştırın ve sol fare tuşuna basılı tutun. Şekil 3‘te gösterildiği gibi
sürükleme aracı görünecektir.

NOT:  Sürükleme çemberinin çapı, varsayılan olarak farenin bulunduğu noktayla seçili ROI arasındaki mesafe kadardır. 
Ebatı değiştirmek için imleci başka bir konuma alın.

ŞEKİL 3- Sürükleme Aracı
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3. Sürükleme aracını kapatmak için kontur üzerine sol fare tuşuyla tıklayın, ardından sağ fare tuşuna tıklayıp açılır
menüden Şekil 4‘te gösterildiği gibi sürükleme aracını seçin.

ŞEKİL 4- Sürükleme Aracını Kapatma

NOT:  Sürükleme aracının varsayılan açık/kapalı olma hali Tercihlerde ayarlanabilir.

Bir Konturu Silme

1. Konturu seçmek için üzerine sol fare tuşuyla tıklayın ve klavyedeki sil (delete) düğmesine basın

veya

2. Konturu seçmek için üzerine sol fare tuşuyla tıklayın, ardından sağ fare tuşuna tıklayın ve açılan menüde Şekil 5‘te
gösterildiği gibi çöp kutusunu seçin.

ŞEKİL 5- Kontur Silme
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İşlev Analizi
Kullanıcı, otomatik bölümleme algoritmaları tarafından oluşturulan ya da değiştirilenler de dahil olmak üzere, tüm ilgi bölgelerinin 
(ROI’ler) tam ve isabetli olarak yerleştirilmesinden (ve doğru şekilde atanmasından) sorumludur. Yazılım tarafından üretilen nicel 
veriler bu ilgi bölgelerinin tam ve isabetli olarak yerleştirilmesine (ve doğru şekilde atanmasına) bağlıdır.

Çalışma Ön İşleme özelliği, işlev analizinin ön işleme tabi tutulmasına olanak sağlar. NS-03-040-0012 kodlu suiteDXT 
Kullanım Talimatlarına bakın.

Bu bölüm kardiyak işlev analizi için kullanılan tipik adımları açıklamaktadır. Örnek iş akışları, kardiyak işlev analizini 
tamamlamak için uygulamada kullanılan adımlara genel bir bakış sunar. Prosedürler nicel analizlerin nasıl yapılacağını 
açıklar.

ÖNEMLİ: Analiz sonuçları bir teşhise ulaşmak için kullanılacaksa, kardiyak analizi yapma konusunda uzman bir kişi 
olmanız tavsiye edilir.

UYARI : Uygulama yalnızca görüntülerin analizine yardım eder ve otomatik olarak ölçülebilir sonuçlar üretmez. 
Nicel ölçümlerin kullanımı ve yerleştirilmesi kullanıcının inisiyatifindedir. Ölçümler yanlış yapılırsa, hatalı 
teşhisler meydana gelebilir. Ölçümler yalnızca uygun bir şekilde eğitilmiş ve uzman bir kullanıcı 
tarafından oluşturulmalıdır.

UYARI : Yanlış tarama düzlemi hatalı analiz sonuçlarına neden olabilir. Bkz. Ek B.

NOT:  4B Akıştan oluşturulmuş geriye dönük 2B seriler manüel bölümleme gerektirebilir.

Analiz için üç kategori vardır:

- Sol ventrikül (LV) ve sağ ventrikül (RV) için hacim analizini içerir.

- Sol (LV) ve sağ atrium (RV) için hacim analizini içerir.

- Ön tanımlı doğrusal ölçümleri ve eklenebilecek kullanıcı tanımlı ölçümleri içerir.
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 Ventriküller
Analiz tipini seçin:

 Konturları silmek için  ögesine tıklayın.

NOT:  Konturları silmek için matris modu kullanılabilir.

Endeks Ölçümlerini Hesaplama

1. Geçmiş Sekmesini (History Tab) seçin.

2. Hastanın Boy (Height) ve Ağırlık (Weight) değerlerini girin.

Diyastol sonu hacim endeksi, sistol sonu hacim endeksi, kütle diyastol sonu hacim endeksi, kütle sistol sonu hacim 
endeksi, kütle endeks aşaması, kardiyak çıkış endeksi ve kalp atımı hacim endeksi ölçümleri Ölçümler tablosunda 
hesaplanır.

NOT:  Rapor Görünümü (Report View) üzerinde yer alan Geçmiş (History) sekmesi altında BSA hesaplama yöntemi seçilebilir.

Otomatik LV ve RV Bölümleme

Otomatik bölümleme özelliği, kardiyak işlevinin standart parametrelerini anatomik girdi olmadan hesaplar. Bölümleme 
sonuçlarının oluşturulmasının ardından görüntülenecek/görüntülenmeyecek ROI tipleri seçilebilir. Kullanıcı girdisi ile 
bölümleme düzenleme de yapılabilir. 

NOT:  İşlev Kısa Eksen (Function Short Axis) içindeki LV ve RV düğmelerinin ikisi birden seçim dışı bırakıldıysa ya da Uzun 
Eksen (Long Axis) içindeki bölme seçim düğmesi seçim dışı bırakıldıysa, Otomatik Yaymaya Başla (Start Auto 
Propagation) düğmesi etkin olmaz. 

LV ve RV bölümleme yapmak için aşağıdali adımları uygulayın: 

1. Kısa eksen serisini seçin ve pencereyi/düzeyi ayarlayın.

2. ögesine tıklayın.

3. Otomatik bölümleme için  ögesine tıklayın.

4. Şekil 1‘de gösterildiği gibi, bölümleme araç çubuğundan uygun seçimleri yapın.

5. Otomatik bölümlemeye başlamak için  ögesini seçin.

Kısa Eksen Uzun Eksen
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ŞEKİL 1- Bölümleme Araç Çubuğu

* Matris modu için x (kesit) ve y (aşama)’yi çevir tercihi yapıldığında yayma işlevi değişir.

Tablo 1:  Otomatik Bölümleme Kontur Tipleri

Pürüzsüz Mod 
(Smooth Mode) - 
ventriküler hacim 
içindeki papiller 
kasları içerir. 

Papiller Mod 
(Papillary Mode) - 
ventriküler hacim 
içindeki papiller 
kasları içermez. 

Endokardiyal ve 
epikardiyal konturları 
göster. 

Endokardiyal 
konturları göster.

Kordları göster.

Tablo 2:  Otomatik Bölümleme Yayma* Tipleri

Tüm kesitleri tüm 
aşamalara yay veya tüm 
kesitleri tüm aşamalarda 
göster

Tüm kesitleri yay, tek 
aşama

Tüm aşamaları yay, tek 
kesit

Gösteren konturları sadece 
ED/ES aşamalarına yay

Tablo 3:  Ventriküler Seçim

Sol Ventrikül - Bölümleme veya görüntü üret Sağ Ventrikül - Bölümleme veya görüntü üret
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Tüm Kesitler ve Tüm Aşamalar için Otomatik Bölümleme Yapma

Bölgesel analiz, uyumsuzluk analizi ve kapakçık düzlemi analizi sonuçlarının üretilmesi için bu seçenek gereklidir. 

1. Kısa eksen serisini seçin ve pencereyi/düzeyi ayarlayın.

2. ögesine tıklayın.

3. Otomatik bölümleme için  ögesine tıklayın.

4. Bölümleme çubuğundan pürüzsüz modu  veya papiller modu  seçin.

5. Miyokardiyal kütle sonuçlarını üretmek için  ögesini seçin.

6. Tüm aşamalar ve tüm kesitler için  ögesini seçin.

7. ögesini,  ögesini veya ikisini birden seçin.

NOT:  Optimal RV bölümlemesi için hem epikardiyal hem de endokardiyal izleri seçin.

8. Otomatik bölümlemeye başlamak için  ögesini seçin.

NOT:  Hem LV hem de RV seçimleri seçim dışı bırakılmışsa, Otomatik Yaymaya Başla (Start Auto Propagation) düğmesi
etkin olmaz. 

Bölümleme İsabetini Gözden Geçirme/Düzenleme

1. Kısa eksen serisini film modunda oynatın ve konturların doğruluğunu gözden geçirin.

2. Yanlış konturları düzenleyin.

ED ve ES için aşama atamaları kilitlenmiştir. ED ve ES’yi yeniden atamak için ya ED veya ES düğmelerinden birine tıklayın ve 
aşama numarasını doğrudan matris üzerinde seçin. Kilitli aşamalar açık renkli bir üçgenle gösterilir.

3. Her kesit üzerine RV giriş noktasının yerleşimini gözden geçirin. Bazal kesitler için RV giriş noktasını düzeltin.

4. Matris modunu gözden geçirin ve ED ile ES atamalarını onaylayın.

NOT:  Pürüzsüz modda kontur düzenleme desteklenir. Bir kontur düzenleme gerçekleştirin ve otomatik bölümlemeye
başlayın.
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Bir Aşamadaki Tüm Kesitler için Otomatik Bölümleme Yapma

1. Kısa eksen serisini seçin ve pencereyi/düzeyi ayarlayın.

2. ögesine tıklayın.

3. ögesine tıklayın.

4. Bölümleme çubuğundan pürüzsüz modu  veya papiller modu  seçin.

5. Miyokardiyal kütle sonuçlarını üretmek için  ögesini seçin.

6. Kısa eksen görüntülerini gözden geçirin ve diyastol sonu aşamayı seçin.

7. ögesini,  ögesini veya ikisini birden seçin.

8. Tek aşamadaki tüm kesitler için  ögesini seçin.

9. Otomatik bölümlemeye başlamak için  ögesini seçin.

10. Kısa eksen görüntülerini gözden geçirin ve sistol sonu aşamayı seçin.

11. Otomatik bölümlemeye başlamak için  ögesini seçin.

NOT:  Hem LV hem de RV seçimleri seçim dışı bırakılmışsa, Otomatik Yaymaya Başla (Start Auto Propagation) düğmesi
etkin olmaz.

Bölümleme İsabetini Gözden Geçirme/Düzenleme

1. Kısa eksen serisini film modunda oynatın ve konturların doğruluğunu gözden geçirin.

2. Yanlış konturları düzenleyin.

3. Matris modunu gözden geçirin ve ED ile ES atamalarını onaylayın.

4. Ölçüm tablosundaki tüm sonuçları gözden geçirin.
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Manüel LV ve RV İşlev Analizi Prosedürü

NOT:  Diyastol sonu ve sistol sonu aşamalarının kullanılması tavsiye edilir. İşlem diyastol sonu aşamasında başlamalıdır. 
Analiz iş akışı tipik olarak tabandan tepeye kadar gerçekleştirilir.

1. ögesini seçin.

2. Görüntü Göstericiden (Image View) uygun kısa eksen serisini seçin.

3. ögesine tıklayın.

4. Hacim ölçümleri için  düğmesine tıklayın.

5. Diyastol sonu aşamasını belirleyin.

Endokardiyumu Tanımlama

1. LV için  ögesini veya RV için  ögesini seçin. 

2. Endokardiyal konturu izleyin.

3. Sonraki kesite geçmek için  ögesini veya <-- ve --> ögelerini kullanın ya da küçük resmi seçin.

4. Sol ve/veya sağ ventrikülün tamamı bölümlere ayrılana kadar 2. ve 3. adımları tekrar edin.

Birden fazla kesitin bölümlere ayrılmasını hızlandırmak için Endokardiyal kontur aracı seçili kalacaktır.

5. Sistol sonu aşamasını belirleyin.

6. Sol ve/veya sağ ventrikülün tamamı bölümlere ayrılana kadar sistol sonu aşamasındaki 2. ve 3. adımları tekrar edin.

NOT:  Yazılım otomatik olarak diyastol sonu aşamasını en büyük hacimli aşama olarak, sistol sonu aşamasını ise en küçük
hacimli aşama olarak tanımlar. Diyastol sonu ve sistol sonu aşama atamaları bölümleme sırasında güncellenir.

Bölümleme İsabetini Gözden Geçirme/Düzenleme

1. Kısa eksen serisini film modunda oynatın ve konturların doğruluğunu gözden geçirin.

2. Yanlış konturları düzenleyin.

3. Matris modunu gözden geçirin ve ED ile ES atamalarını onaylayın.

4. Ölçüm tablosundaki tüm sonuçları gözden geçirin.
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Manüel LV ve RV Miyokardiyal Kütle Prosedürü

1. Uygun kardiyak aşamasını seçin.

2. LV epikardiyum için  ögesini veya RV epikardiyum için  ögesini seçin. 

3. Epikardiyal konturu izleyin.

4. Sonraki kesite geçmek için  ögesini veya <-- ve --> ögelerini kullanın ya da küçük resmi seçin.

5. Sol ve/veya sağ ventriküler epikardiyumun tamamı bölümlere ayrılana kadar 3. ve 4. adımları tekrar edin.

Epikardiyal konturlar tanımlandıkça kütle sonuçları otomatik olarak güncellenir.

Bölümleme İsabetini Gözden Geçirme/Düzenleme

1. Kısa eksen serisini film modunda oynatın ve konturların doğruluğunu gözden geçirin.

2. Yanlış konturları düzenleyin.

3. Matris modunu gözden geçirin ve ED ile ES atamalarını onaylayın.

4. Ölçüm tablosundaki tüm sonuçları gözden geçirin.

Bazal Aradeğerleme

Bazal kesitler için bölümleme aradeğerlemesi yapmak için ya mitral veya trikuspit kapakçık anülusu ya da uzun eksen 
görüntülemeyi seçin.

NOT:  LV ve RV için kapakçık anülusu otomatik ekleme işlevi tercihler içinde ayarlanabilir, bkz. Diğer Parametrelerini 
Düzenleme Prosedürü, sayfa 33. 

1. LV bazal aradeğerleme için çapraz başvuru modunda 2 Bölme görünümünü seçin.

2. ögesini seçin.

3. Şekil 2‘de gösterildiği gibi MV anülusu tanımlayın. Film kontrollerini kullanarak, hattın uygun sistol sonu ve diyastol
sonu aşamalara yerleştirilmesini gözden geçirin.

NOT:  Çok düzlemli bazal aradeğerleme desteklenir. Örneğin, MV anülus 2 bölmeli ve 4 bölmeli görüntülemede tespit 
edilebilir; uyum iki düzlem arasında yapılır.
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ŞEKİL 2- MV Anülus

4. Hat ile ilişkili çapraz başvuru kesitlerini inceleyerek güncellenmiş hesaplamayı gözden geçirin.

Şekil 3‘te gösterildiği gibi, aradeğerleme hacim hesaplaması hattın kesitle kesişiminin (pembe hat) ilişkisine göre yapılır ve 
bu hacim artık hacim sonuçlarına eklenmiştir. Esas ilgi bölgesi gösterilmez. Aradeğerleme yapılan kesitler, Şekil 3‘te 
gösterildiği gibi, görüntünün sol köşesinde hacim miktarını ve aradeğerleme yüzdesini gösterirler.

ŞEKİL 3- Hacim Hesaplama

5. RV bazal aradeğerleme için çapraz başvuru modunda 4 Bölme görünümünü seçin.

6. ögesini seçin.

7. Şekil 4‘te gösterildiği gibi TV anülusu tanımlayın. Film kontrolünü kullanarak, hattın uygun sistol sonu ve diyastol sonu
aşamalara yerleştirilmesini gözden geçirin.
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ŞEKİL 4- TV Anülus

8. Hatla ilişkili çapraz başvuru kesitlerini inceleyerek güncellenmiş hesaplamayı gözden geçirin ve matris modunda ED ve 
ES atamalarını gözden geçirin.

9. Sonucu orijinal değerine geri almak için sağ fare tuşuyla tıklayın, doğrudan hat üzerinde tutun ve sil ögesini seçin ya
da hat üzerine sol fare tuşuyla tıklayıp klavye üzerindeki sil tuğunu kullanın.

Doğruluğu İnceleme

1. Uzun eksen serisini film modunda oynatın ve hat yerleşimini gözden geçirin.

2. Gerekli oldukça hat yerleşimini ayarlayın.

3. Otomatik ekleme yapıldıysa, uygun serinin seçildiğini ve uygun hat yerleşiminin yapıldığını kontrol edin. Uygun şekilde
yerleştirilmediyse, hat üzerine sağ fare tuşuyla tıklayın ve silin.
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Aradeğerleme İşlevi 

LV veya RV için işlev analizi yaparken, aradeğerleme işlevi “kapatılır”. 

Aradeğerleme işlevi aşağıdaki koşullarda uygulanabilir:

• Aynı kardiyak aşaması sistol sonu veya diyastol sonu için kesitler boyunca izlenmiş ve bir kesit atlanmışsa, aradeğerleme
Şekil 5‘de gösterildiği gibi “Açık” hale getirilerek etkinleştirilebilir.

• Aynı kardiyak aşaması sistol sonu veya diyastol sonu için kesitler boyunca izlenmiş ve/veya bir kesit atlanmışsa, bazal
aradeğerleme otomatik olarak uygulanabilir.

ŞEKİL 5- Aradeğerleme

Diyastol Sonu (ED) ve Sistol Sonu (ES) Atamaları Gözden Geçirme

Bölümleme tamamlandıktan sonra, matris modunu gözden geçirin ve sistol sonu veya diyastol sonu atamaları onaylayın. 

NOT:  Diyastol Sonu (ED) ve Sistol Sonu (ES) izler farklı bir aşamada manüel olarak yapıldıysa, tüm ventriküler hacim 
analiz tiplerinde aşağıdaki mesaj görünür.

Aradeğerleme KAPALI Aradeğerleme AÇIK
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ŞEKİL 6- ROI Atama Mesajı

1. Matris modu  düğmesine tıklayın.

2. Kesit Kesit ED/ES (Slice-by-Slice ED/ES) modunu  seçin.

Görüntüleme alanı, tüm kesit konumlarını ve alınan aşamaları temsil eden bir matrisi gösterecek şekilde değişir. Şekil 7‘de 
kırmızı üçgenlerle gösterildiği gibi, tüm LV diyastol sonu aşamaları atanmıştır. Mavi üçgenler atanmış LV sistol sonu 
aşamalarını gösterir. Kırmızı noktalar henüz atanmamış aşamaları temsil eder.

3. Bu örnekte, LV sistol sonu aşamalarını atamak için  düğmesine tıklayın ve kırmızı noktalı aşamalardan uygun
olanının üzerine tıklayın. Matris kutusuna tıkladıktan sonra mavi bir üçgen görünür. Şekil 8‘de gösterildiği gibi, tüm
diyastol sonu ve/veya sistol sonu atamalar artık doğrudur.

4. Yukarıdaki adımları gerekli olduğunda RV için de uygulayın. RV için, RV Sekmesine tıklayın.

ŞEKİL 7- LV Diyastol Sonu Aşamalarını Atama ŞEKİL 8- LV Sistol Sonu Aşamalarını Atama
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Hacim Yöntemi Belirleme

ED ve ES için hacim belirleme yöntemi, global veya kesit-kesit seçimini yapan anahtar düğmenin konumuna göre seçilir.

Tablo 4:  Hacim Yöntemi Belirleme Geçiş Düğmesi

Global ED/ES Global seçildiğinde, birleşik hacim aynı aşamadaki ED ve ES 
atamalarına göre belirlenir.

Kesit-Kesit 
ED/ES

Kesit-kesit seçildiğinde, birleşik hacim her kesitteki aşamalarda 
bulunan en büyük ve en küçük hacimlere göre belirlenir. 
Etkinleştirmek için Tüm Kesitleri Yay, Tüm Aşamalar modu seçilmiş 
olmalıdır.
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Ventriküler İşlev Analizi Sonuçları

Hacim Eğrisi

LV veya RV için tüm aşamalar ve tüm kesitlerde otomatik bölümleme yapıldığında, Şekil 9‘da gösterildiği gibi bir zamana 
göre ventriküler hacim eğrisi üretilir. Bu eğri rapora dahil edilebilir. Çekme özelliği olan işaretleyiciler ayarlanabilir.

ŞEKİL 9- Ventriküler Otomatik Bölümleme Sonuçları

1. Hacimsel sonuçlar, 2. Hacim Eğrisi, 3. Matris modu

• Kırmızı imleç diyastol sonu hacmini gösterir.

• Mavi imleç sistol sonu hacmini gösterir.

• Yeşil imleç Tepe Ejeksiyon Hızını (PER) ml/s olarak gösterir. (Etkileşimli Dikey İmleç).

• Sarı imleç Tepe Doldurma Hızını (PFR) ml/s olarak gösterir. (Etkileşimli Dikey İmleç).

• Karşılık gelen görüntü aşaması seçimi, hacim eğrisi üzerindeki beyaz işaretle gösterilir.

1

2

3
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Hacimsel sonuçlar ölçüm tablosunda gösterilir. 

• Ventriküler kütle aşama sonuçlarını ya da kütle endeks aşamasını gözden geçirmek maksadıyla LV veya RV için ters sarı
üçgene sağ tıklayın.

• Yalnızca tablodan seçilen aşama raporda gösterilir.

ŞEKİL 10- Kütle Aşaması Aşağı Açılır Menüsü

ŞEKİL 11- Bölme Hacmi Tablosu

Tam LV ve RV Hacimsel sonuçları Bölme Hacimleri tablosunda gösterilir. 
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Sol Ventriküler Bölgesel Analiz

LV Bölgesel Analiz, duvar hareketinin, duvar kalınlığının, duvar kalınlaşmasının ve duvar kalınlığı sonuçlarının gözden 
geçirilmesine olanak sağlar.

NOT:  İşlev Kısa Eksen (Function Short Axis) içindeki LV ve RV düğmelerinin ikisi birden seçim dışı bırakıldıysa ya da Uzun 
Eksen (Long Axis) içindeki bölme seçim düğmesi seçim dışı bırakıldıysa, Otomatik Yaymaya Başla (Start Auto 
Propagation) düğmesi etkin olmaz. 

1. Tüm aşamalardaki tüm kesitler için Otomatik LV bölümleme gerçekleştirin (bkz. sayfa 57).

2. Her kesitteki RV ekleme noktasının yerleşimini gözden geçirin ve bazal kesitler için RV ekleme noktasını ayarlayın.

3. Bir kesit konumuna bir RV ekleme noktası eklemek için, RV ekleme noktasına  tıklayın, otomatik bölümlenmiş 
kesiti seçin ve RV ekleme noktasını yerleştirin.

4. Bazal, orta ve tepe sınıflandırmasını onaylayın.

5. Bölgesel Analize  tıklayın. Kalınlık, Kalınlaşma Yüzdesi ve Duvar Hareketi çizim, grafik ya da tablo biçimlerinde gösterilir.

ŞEKİL 12- Bölgesel Analiz
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Uyumsuzluk Analizi

Uyumsuzluk, Bölgesel Analiz sonuçlarının bir uzantısıdır ve Bölgesel Analizden elde edilen çevresel bilgiye göre Duvar 
Kalınlığının Geçici Değişmezliğini [Temporal Uniformity of Wall Thickness (TUWT)] hesaplanmasını sağlar. Literatür 
referansı Tablo 5‘te verilmiştir.

Uyumsuzluk Analiz Prosedürü

1. Otomatik LV bölümleme gerçekleştirin (bkz. Bkz. “Tüm Kesitler ve Tüm Aşamalar için Otomatik Bölümleme Yapma”,
sayfa 57.).

2. Bölgesel Analizi  seçin.

3. Uyumsuzluk (Dyssynchrony) sekmesini seçin.

4. Ölçüm tablosunda her kesit için sonuçlar ve ortalama global sonuç gösterilecektir.

5. Global sonuç hesaplaması ancak LV orta ventriküler kesitler dahil edilirse optimal olur. Global sonuç hesaplamasından bir
kesit sonucunu çıkarmak için doğrudan en sağdaki sütunda bulunan ve içinde bir onay işareti olan kutuya tıklayın (Şekil 13).

ŞEKİL 13- Global Sonuç Hesaplama

Tablo 5:  

Sonuç Referans

Duvar Kalınlığının Geçici 
Değişmezliği [Temporal 
Uniformity of Wall Thickness 
(TUWT)]

*Bilchick et al, "Cardiac Magnetic Resonance Assessment of Dyssynchrony and
Myocardial Scar Predicts Function Class Improvement Following Cardiac
Resynchronization Therapy", JACC, Vol.1:No 5: 2008 p.561-8
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Hızlı LV İşlev Analizi Prosedürü

1. ögesini seçin.

2. Uzun eksen serisi seçin.

3. ögesini seçin.

4. Tüm kesitleri ve tüm aşamaları yaymak için  ögesini seçin.

5. ögesine tıklayın.

NOT:  Uzun eksen görünümü seçim dışı bırakılmışsa, Otomatik Yaymaya Başla (Start Auto Propagation) düğmesi etkin
olmaz.

6. Tüm izleri gözden geçirin. Merkez hattı sol ventrikülün uzun eksenine tabandan tepeye kadar karşılık gelecek şekilde
ayarlayın.

7. Manüel izleme yapılabilir. Diyastol sonu ve sistol sonu için sol ventrikül endokardiyumunu izlemek için
ögesine tıklayın.

8. Sol ventriküler kütleyi hesaplamak için sol ventriküler epikardiyumu izleyin .

ŞEKİL 14- Merkez Hattı Yerleştirme

Sonuçlar Ölçüm tablosunda gösterilir.
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 Atria

Manüel LA ve RA İşlev Analizi Prosedürü

1. Görüntü Göstericiden (Image View) uygun seriyi seçin.

NOT:  Optimal sonuçlar için analizde 4 bölmeli yığın kullanılması tavsiye edilir. 4 bölmeli görünüm atriyal anatomiyi
daha iyi gösterir.

2. ögesine tıklayın.

3. düğmesine basın.

4. Diyastol sonu aşamasını belirleyin.

Endokardiyumu Tanımlama

1. LA epikardiyum için  ögesini veya RA epikardiyum için  ögesini seçin.

2. Endokardiyal konturu izleyin.

3. Sonraki kesite geçmek için  ögesini veya <-- ve --> ögelerini kullanın ya da küçük resme tıklayın.

4. Atriyumun tamamı bölümlere ayrılana kadar 2. ve 3. adımları tekrar edin.

5. Sistol sonu aşamasını belirleyin.

6. Atriyumun tamamı bölümlere ayrılana kadar sistol sonu aşamasında 2. ve 3. adımları tekrar edin.

NOT:  Yazılım otomatik olarak diyastol sonu aşamasını en büyük hacimli aşama olarak, sistol sonu aşamasını ise en küçük
hacimli aşama olarak tanımlar. Diyastol sonu ve sistol sonu aşama atamaları bölümleme sırasında güncellenir.

7. Kısa eksen görünümü kullanıldıysa, MV ve/veya TV anülusu belirleyin.
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Hızlı LA veya RA İşlev Analizi Prosedürü

Bu yöntem uzun eksen serisi üzerinde gerçekleştirilir. 

1. ögesine tıklayın.

2. Bir uzun eksen serisi seçin.

3. Diyastol sonu aşamasını seçin.

4. düğmesine basın.

5. LA epikardiyum için  ögesini veya RA epikardiyum için  ögesini seçin.

6. Atrium endokardiyumunu izleyin. Dönüş çizgisinin merkezi otomatik olarak çizilir.

7. Dönüş çizgisinin merkezini atriumun uzun eksenine karşılık gelecek şekilde ayarlayın.

8. Sistol sonu için 5-7. adımları tekrarlayın.

Atriyal Boyutlar ve Alan

1. ögesine tıklayın.

2. Uygun seriyi seçin.

3. Atriyal boyut ölçümü yapmak maksadıyla, LA veya RA için doğrudan sütundaki tabloya tıklayın ve ardından iki nokta
girin. Bkz. Şekil 15.

4. Atriyal alan ölçümü yapmak maksadıyla, LA veya RA için doğrudan sütundaki tabloya tıklayın ve ardından bir ROI çizin.
Bkz. Şekil 15.

ŞEKİL 15- Atriyal Ölçüm
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Doğrusal Ölçümler

Uygulama doğrusal ölçümlerin rapor edilmesini sağlar. İmleç tabloda listelenen ölçümler üzerine getirildiğinde, açılır 
ipuçları gösterilir.

ŞEKİL 16- Doğrusal Ölçümler

1. Yazdırma Seçeneği, 2. Perikardiyum için Yazma Alanı, 3. Özel Ölçüm Ekleme/Kaldırma, 4. Tüm Ölçümleri Sil

Doğrusal Ölçüm Ayarlama

1. ögesini seçin.

2. Seriyi seçin.

3. düğmesine tıklayın.

4. Ölçülecek anatomiyi içeren görüntüyü seçin.

5. Ölçüm tablosundan istenen ölçüyü seçin, bu eylem seçimin aktif olduğunu göstermek için ölçümü yeşil renkle
işaretler.

1

2

3 4
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DİKKAT: Hattın doğru yerleştirilmesi ölçüm sonuçları için çok kritiktir. Ölçümler yanlış yapılırsa, hatalı teşhisler 
meydana gelebilir. Ölçümler yalnızca uygun bir şekilde eğitilmiş ve uzman bir kullanıcı tarafından 
oluşturulmalıdır.

6. Düzenlemek için notun üzerine tıklayın, aktif olduğunda renk yeşilden mora döner. İmleci uç noktalarından birinin
üzerine getirin ve bitiş noktasını ayarlayın.

İmleci Görüntü Düzenleyici penceresinin dışına taşıdığınızda, ölçüm uzaklığı değeri Ölçüm tablosunda uygun bir 
şekilde güncellenir.

Ölçüm uzaklığı hattının tamamını başka bir konuma taşımak için imleci orta işaretleyicinin üzerine getirin.

NOT:  Ölçümü sıfırlamak için ölçüm uzaklığı hattını seçin, sağ fare tuşuna tıklayın ve Sil (Delete) ögesini seçin ya da 
klavyedeki Sil (Delete) tuşunu kullanın. 

Ölçümleri Silme

Tüm ölçümleri silmek için  ögesine tıklayın.

Özel Ölçüm Ekleme

1. ögesini seçin.

2. Özel Ölçüm Ekle (Add Custom Measure ) açılır penceresine benzersiz bir etiket girin.

3. Ölçüm türünü Doğrusal (Linear) veya Alan (Area) olarak seçin.

4. Tamam (OK) ögesini seçin.

Özel Ölçümü Kaldırma

1. ögesini seçin.

2. Listeden kaldırılacak özel ölçümü/ölçümleri seçin.

3. Seç (Select) ögesini seçin.

NOT:  Oluşturulan özel ölçümler listeden kaldırılana kadar gelecekte yapılacak tüm analizlerde yer alırlar.
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Kapakçık Düzlemi Analizi

Kapakçık düzlemi analizi özelliği, kapakçık tepe hızını ve kapakçık içi tepe basınç değişim miktarı ile ortalama basınç 

değişim miktarını hesaplamayı sağlar.1

Basınç değişim miktarı, sol ventriküler sistolik hacimdeki çerçeve çerçeve değişimlere bağlı olarak ve LV otomatik 
bölümlemeden alınan sonuçları kullanarak kardiyak çıkışından hesaplanır.

Kapakçık Düzlemi Analizi Prosedürü

1. Tüm aşamalardaki tüm kesitlerde Otomatik LV bölümleme gerçekleştirin (bkz. sayfa 57).

2. Kapakçık anatomisini gösteren bir seri seçin.

3. Ölçüm tablosundan Kapakçık Alanı (Valve Area) ögesini seçin (Şekil 17) ve Şekil 18‘de gösterildiği gibi alan ölçümünü
gerçekleştirin.

ŞEKİL 17- Kapakçık Alanı

4. ROI tamamlandıktan sonra, tablodaki sonuçlar güncellenir ve zamana göre basınç değişim miktarını gösteren bir grafik 
sunar.

Tüm ölçümleri silmek için  ögesine tıklayın.

1. Wolff, Steven D., M.D., Ph.D. Kapakçık ağzındaki hız verisini kullanmadan kalp kapağı boyunca basınç değişim miktarını  belirlemek için 
noninvaziv yöntemler. ABD Patenti 9.585.568, 7 Mart 2017.
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ŞEKİL 18- Kapakçık Düzlemi Analizi

ÖNEMLİ: Analiz sonuçları bir teşhise ulaşmak için kullanılacaksa, kardiyak analizi yapma konusunda uzman bir kişi 
olmanız tavsiye edilir.

Uygulama yalnızca görüntülerin analizine yardım eder ve otomatik olarak ölçülebilir sonuçlar üretmez. Nicel 
ölçümlerin kullanımı ve yerleştirilmesi kullanıcının inisiyatifindedir. Ölçümler yanlış yapılırsa, hatalı teşhisler 
meydana gelebilir. Ölçümler yalnızca uygun bir şekilde eğitilmiş ve uzman bir kullanıcı tarafından 
oluşturulmalıdır.    

NOT:  Tepe Hız, Tepe Basınç Değişim Miktarı ve Ortalama Basınç Değişim Miktarı değerleri mitral regurjitan ya da şant 
sorunu olan hastalarda geçerli değildir.
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Akış Analizi
Kullanıcı, otomatik bölümleme algoritmaları tarafından oluşturulan ya da değiştirilenler de dahil olmak üzere, tüm ilgi bölgelerinin 
(ROI’ler) tam ve isabetli olarak yerleştirilmesinden (ve doğru şekilde atanmasından) sorumludur. Yazılım tarafından üretilen nicel 
veriler bu ilgi bölgelerinin tam ve isabetli olarak yerleştirilmesine (ve doğru şekilde atanmasına) bağlıdır.

Çalışma Ön İşleme özelliği, akış analizinin ön işleme tabi tutulmasına olanak sağlar. NS-03-040-0012 kodlu suiteDXT 
Kullanım Talimatlarına bakın.

Akış Analizi aracı, kardiyak döngüsündeki çeşitli noktalardaki düzlem akış kodlamalı 2D Aşama Kontrastı (PC) 
görüntülerinden akış ve hız bilgilerini hesaplar.

Akış sonuçlarını üretmek için iki yöntem vardır: Gelişmiş ve Konvansiyonel. Gelişmiş otomatik bölümlemede ilgilenilen 
damar üzerine ilk ROI’nin yerleştirilmesine gerek yokken konvansiyonel otomatik bölümlemede buna gerek duyulur.

NOT:  4B Akıştan oluşturulmuş geriye dönük 2B aşama kontrast serileri konvansiyonel otomatik bölümleme gerektirebilir.

UYARI : Uygulama yalnızca görüntülerin analizine yardım eder ve otomatik olarak ölçülebilir sonuçlar üretmez. 
Nicel ölçümlerin kullanımı ve yerleştirilmesi kullanıcının inisiyatifindedir. Ölçümler yanlış yapılırsa, hatalı 
teşhisler meydana gelebilir. Ölçümler yalnızca uygun bir şekilde eğitilmiş ve uzman bir kullanıcı 
tarafından oluşturulmalıdır.

UYARI : Gelişmiş otomatik bölümleme kullanmak için tüm sonuçların dikkatli bir şekilde gözden geçirilmesi 
gereklidir. Damar tanımlama optimal değilse, damar için konvansiyonel otomatik bölümleme yapın.
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Akış Penceresi Bileşenleri

ŞEKİL 1- Akış Penceresi  

1. Akış Analizi ROI’leri, 2. Akış sekmeleri, 3. Aktif ROI/Gelişmiş Otomatik seçim, 4. Yayma düğmeleri, 5. ROI silme düğmesi, 6. Ana hat düzeltme aşağı
açılır menüsü, 7. Gürültü Piksellerini Çıkarma, 8. Akış ofset değeri, 9. Genişleme etkeni, 10. Venc kaydırma çubuğu, 11. Akış eğrisi sonuçları,
12. Gösterim modu, 13. Aşama ofset değeri, 14. Grafik görünüme geçme, 15, Özet tablosuna geçme

NOT:  Akış Analizi, büyüklük ve aşama görüntülerini yan yana görüntüler halinde gösterir. Aynı konumdan alınan diğer
görüntü tipleri gösterilmez, bunlar ayrı bir DICOM görüntüleyicide izlenmelidir.

NOT:  Akış analizi olan önceki çalışmalar gözden geçirilirken, grafik ile 2 numaralı (mavi) akış simge ROI’si arasında bir 
renk uyuşmazlığı olacaktır.
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Akış Analizi

Akış Sonuçlarını Oluşturma

Gelişmiş Otomatik Bölümleme Kullanarak

Gelişmiş otomatik bölümlemede ilgilenilen damar üzerine ilk ROI’nin yerleştirilmesine gerek yoktur. Alınan damar 
anatomisine karşılık gelen uygun akış sekmesini seçmek önemlidir. Sadece aort ve pulmoner anatomi desteklenmektedir. 

NOT:  Aşamada sekme başına alınan damar sayısı altıdan fazlaysa, Ön İşleme özelliği sadece en son altı sonucu saklar.

Bir Aort Akış Eğrisi Oluşturma

1. Aort damarını gösteren uygun seriyi Şekil 2‘de gösterildiği gibi seçin.

ŞEKİL 2- Aort Damarı

2. Şekil 3‘te gösterildiği gibi Aort sekmesini seçin ve Aktif ROI rengini seçin.

ŞEKİL 3- Aort Sekmesi

3. Bir akış eğrisi oluşturmak için  ögesini seçin.
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4. Damar üzerindeki bölümlemeyi gözden geçirin. Yanlış damar bölümlemesi yapılmışsa, konvansiyonel otomatik
bölümleme yapın. Bkz. Konvansiyonel Otomatik Bölümleme Kullanarak, sayfa 81.

5. Düzenlemek için bir kontur üzerine tıklayın, düzenlemeyi yapın ve  ögesine tıklayın.

Bir Pulmoner Akış Eğrisi Oluşturma

1. Pulmoner damarı gösteren uygun seriyi Şekil 4‘te gösterildiği gibi seçin.

ŞEKİL 4- Pulmoner Damar

2. Şekil 5‘te gösterildiği gibi PA sekmesini seçin ve Aktif ROI rengini seçin.

ŞEKİL 5- PA Sekmesi

3. Bir akış eğrisi oluşturmak için  ögesini seçin.

4. Damar üzerindeki bölümlemeyi gözden geçirin. Yanlış damar bölümlemesi yapılmışsa, konvansiyonel otomatik
bölümleme yapın. Bkz. Konvansiyonel Otomatik Bölümleme Kullanarak, sayfa 81.
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5. Düzenlemek için bir kontur üzerine tıklayın, düzenlemeyi yapın ve  ögesine tıklayın.

UYARI : Gelişmiş otomatik bölümleme kullanmak için tüm sonuçların dikkatli bir şekilde gözden geçirilmesi 
gereklidir. Damar tanımlama optimal değilse, damar için konvansiyonel otomatik bölümleme yapın.

Konvansiyonel Otomatik Bölümleme Kullanma

1. Akış Analiz Modunu  seçin. 

2. Aşama kontrast serisi seçin.

Büyüklük görüntüsü solda, aşama görüntüsü sağda görüntülenir.

ŞEKİL 6- Büyüklük ve Aşama Görüntüleri

3. Bir Akış Sekmesi seçin.

Kullanılabilir beş sekme vardır; birinin etiketi aort (aorta), birinin adı pulmoner arter (pulmonary artery) (PA), ikisi 
ise kullanıcı tanımlı sekmeler olup etiketleri Akış 3 (Flow 3) ve Akış 4 (Flow 4)’tür. Qp/Qs sekmesi Qp/Qs oranının 
raporlanmasını sağlar.

4. Eğri 1’i  seçin. 

Kullanılabilir altı ROI vardır ve 1 - 6 olarak numaralandırılmıştır. Renk kodları analiz görünümünde, görüntüleme 
alanlarında ve grafiklerde tutarlıdır.

5. İlgilenilen damar çevresine 4 nokta koyarak ve son noktada ROI’yi kapatmak için çift tıklayarak damar çevresinde bir
kontur oluşturun. Alternatif olarak imleci düzenleme penceresinin dışına hareket ettirerek ROI’yi kapatabilirsiniz.

Damarın manüel izlenmesi de gerçekleştirilebilir.

Kontur hem büyüklük hem de aşama görüntüleri üzerinde Şekil 7‘de gösterildiği gibi oluşturulur.
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ŞEKİL 7- Akış ROI’leri

6. Kesit içindeki tüm aşamalar üzerinde otomatik bölümleme yapmak için aşağıdaki yayma yöntemlerinden birini seçin:

• Kesit içindeki tüm aşamalar üzerinde otomatik bölümleme yapmak için  ögesini seçin.

veya

• Kesit içindeki tüm aşamalar üzerinde aynı konturu yaymak için  ögesini seçin. Bu, küçük ve sabit damarları 
incelerken kullanışlıdır.

7. Akış sonuçları grafikte ve özet tablolarında görüntülenir.

• Grafikten ilişkili eğriyi kaldırmak için ml/atım hızının yanındaki onay kutusuna tıklayın. Bu hesaplamaları değiştirmez.
Yalnızca eğriyi grafikten çıkarır.

8. Dosya aşağı açılır menüsünden bir Ana Hat Düzeltme seçeneği seçin.

• Ana Hat Düzeltme uygulanan eğrilerin Şekil 8‘de gösterildiği gibi dolu aşama veri noktaları olur. Bkz. Ana Hat Düzeltme
Seçenekleri, sayfa 84.

ŞEKİL 8- Akış Grafiği - Düzeltme Yok (sol grafik); Düzeltme Uygulanmış (sağ grafik) 
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9. Eğriyi ters çevirmek için  ögesini seçin.

NOT:  Üretilen tüm akış eğrileri pozitif yönde gösterilir. Ters çevrilmiş eğriler aktif ters çevirme düğmesi ile gösterilir.

10. Akış eğrisinin ordinatını değiştirmek için bir Aşama Ofset Değeri seçin.

11. Karşılık gelen aşama görüntüsünü belirlemek için grafikteki herhangi bir noktayı seçin.

12. Gerekli oldukça başlangıç ve bitiş noktaları için dikey imleci ayarlayın.

13. Konturların doğruluğunu gözden geçirin.

Kontur Düzenleme

Konturlar bir kerede bir aşama veya aşama aralıkları şeklinde düzenlenebilir.

Tek bir aşamayı düzenleme

1. Düzenlemek istediğiniz aşamayı seçin.

2. Düzenlemek için etkinleştirmek istediğiniz kontura tıklayın.

Kontur mora dönüşerek düzenlenebileceğini gösterir.

3. Nokta eğrisi konturları için noktaları hareket ettirerek; serbest çizim veya bilgisayar tarafından oluşturulan konturlar
için sol fare tuşu basılı halde görüntü üzerinde çizim yaparak konturu düzenleyin.

4. Sürükleme aracını aktifleştirmek maksadıyla konturu seçmek için üzerine sol fare tuşuyla tıklayın. Ardından, Şekil 9‘da
gösterildiği gibi, açılan menüden sağ fare tuşuyla tıklayarak sürükleme aracını seçin. Daha fazla bilgi için bkz. Konturları
Düzenleme, sayfa 51

ŞEKİL 9- Sürükleme Aracı
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Bir aşama aralığını düzenleme

1. İstenen kesiti seçin.

2. Verilen kesitin tüm aşamalarına ait küçük resimleri görüntülemek için  ögesini seçin.

3. Düzenlenecek aşama aralıklarının ilk aşamasını seçin.

4. Üst karakter tuşuna basılı tutun ve düzenlenecek aralıktaki son aşamayı seçin.

5. Konturu görüntü düzenleyici penceresinde düzenleyin.

6. Görüntü üzerinde seçili konturdan uzak bir yere tıklayarak veya imleci düzenleyici penceresinin dışına taşıyarak
konturun seçimini kaldırın.

Ana Hat Düzeltme Seçenekleri

2B aşama kontrastı için üç akış ana hat düzeltme yöntemi vardır. Üzerine bir düzeltme yöntemi uygulanan akış eğrilerinin 
dolu aşama veri noktaları olur.

NOT:  Analiz için kullanılan aşama kontrast görüntülerinde görüntü aşaması paketleme olmamalıdır. Görüntü içinde 
aşama paketleme varsa, bu hatalı akış sonuçlarına neden olur.

Otomatik Ana Hat Düzeltme

Otomatik ana hat düzeltme işlevi, uzak sabit organlardaki (ör. Göğüs kafesi duvarı, karaciğer, vb.) aşama hatalarını araştırarak 
ve verileri doğrusal ya da yüksek dereceli aradeğerleme yöntemiyle doldurarak, resim alma esnasında meydana gelen aşama 
hatalarını düzeltir. 

NOT:  Bir 2B büyüklük ve aşama serisi 3B/4B görüntüleyici kullanarak oluşturulmuşsa, uygulama düzeltilmemiş bir seri 
ve aşama hata düzeltme uygulanmış ikinci bir seri oluşturacaktır. “Düzeltilmiş” (“Corrected”) etiketli serilere ana 
hat düzeltme aşağı açılır menüsündeki Otomatik (Auto) seçeneğini uygulamayın.

1. Uygun aşama kontrast serisini kullanarak bir akış eğrisi oluşturun.

2. Ana Hat Düzeltme aşağı açılır menüsünden Otomatik (Auto) ögesini seçin.

NOT:  Tercihlerde Otomatik Ana Hat Düzeltme Etkinse, otomatik ana hat düzeltme otomatik olarak uygulanır.

3. Düzeltme, güncellenmiş sonuçlarla uygulanır ve akış grafiği üzerinde doğrudan gösterilir.

4. Uyum analizinde başarısız olan seriler, Şekil 10‘daki gibi bir uyarı sembolü ile gösterilir.
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ŞEKİL 10- Ana Hat Düzeltme Hatası 

NOT:  Görüntü içinde aşama paketleme varsa, bu Şekil 11‘de gösterildiği gibi hatalı akış sonuçlarına neden olur. Akış 
analizi için kullanılan 2B Film Aşama Kontrast görüntülerinde Şekil 12‘de gösterildiği gibi görüntü aşama kaydırma 
olmamalıdır.

ŞEKİL 11- Aşama Paketlemeyi Gösteren Örnek Görüntüler (Beyaz Oklar)

Hata Tipleri:
1 - Görüntüde çok fazla gürültü.
2 - Uyum hatası çok büyük.
3 - Girdi verisi geçersiz.
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ŞEKİL 12- Aşama Paketleme Olmayan Örnek Görüntüler 

Hayalet Düzeltme

Aşama kontrast sonuçlarının doğruluğunu iyileştirmek ve ana hat aşaması kayma hatalarını düzeltmek için hatayı 
hesaplamak maksadıyla bir hayalet veri alma gerçekleştirilebilir.

NOT:  Hayalet düzeltme serisi, orijinal akış serisiyle aynı tarama talimatıyla ve aynı parametrelerle alınmış olmalıdır. 
Hayalet seride konturun tamamını dolduran sabit bir nesneden alınan sinyal olmalıdır.

1. Uygun aşama kontrast serisini kullanarak bir akış eğrisi oluşturun.

2. Ana Hat Düzeltme aşağı açılır menüsünden karşılık gelen hayalet seriyi seçin.

3. Düzeltme, güncellenmiş sonuçlarla uygulanır ve akış grafiği üzerinde doğrudan gösterilir.

Arka Plan Kontur Düzeltme 

Bu düzeltme yöntemi, statik dokularla çevrili damarlar için değerlendirilmelidir.

NOT:  En iyi düzeltme için, arka plan konturu akış bölgesine doğrudan komşu olan ve onu çevreleyen statik dokuya 
yerleştirilmelidir.

1. Uygun aşama kontrast serisini kullanarak bir akış eğrisi oluşturun.

2. Ana Hat Düzeltme aşağı açılır menüsünden Arka Plan ROI (Background ROI) ögesini seçin.

3. Bir kontur çizmek için  ögesine tıklayın.

4. Düzeltme, güncellenmiş sonuçlarla uygulanır ve akış grafiği üzerinde doğrudan gösterilir.
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Akış Eğrisi Seçenekleri

Gürültü Piksellerini Çıkar

Bu seçenek, Şekil 14‘te gösterildiği gibi pembe katmanla tanımlanan ROI içinde mevcut düşük yoğunluklu pikselleri (hızlara 
yüksek değişim) belirler ve akış hesaplamasından çıkarır. Bu seçeneği uygulamak için onay kutusuna tıklayın. Gürültü 
piksellerinin yüzdesi kaydırma çubuğu kullanılarak ayarlanabilir.

ŞEKİL 13- Gürültü Pikselleri

ŞEKİL 14- Pembe Katmanla Gösterilen Gürültü Pikselleri

Akış Ofset Değeri

Akış ofset değeri, akış sonucunun ana hat değerini değiştirme akış eğrisinin apsis değerini değiştirir.
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Genişleme Etkeni

Genişleme etkeni, geçerli akış piksellerini içine almak maksadıyla, bölümlenmiş damarın yarıçapını belirtilen piksel miktarı 
kadar eşit şekilde değiştirir.

Hız Örtüşme Düzeltmesi

Hız örtüşmesini düzeltmek maksadıyla aşama paketlemeyi kaldırmak için kaydırma çubuğu kontrol düğmesini çekin. 
Değişikliğin etkisi doğrudan aşama görüntüsü üzerinde güncellenir ve sonuçlar doğrudan akış grafiği üzerinde gösterilir.

Kullanıcı Tanımlı Tepe Hız

1. Kardiyak döngüsünün uygun aşamasını seçin.

2. İmleci aşama görüntüsü üzerine yerleştirmek için  ögesini kullanın.

İmleç hem büyüklük hem de aşama görüntüleri üzerinde eş zamanlı olarak hareket eder. Hız, mm/s cinsinden 
imlecin yanındaki aşama görüntüsü üzerinde görünür.

ŞEKİL 15- Piksel Akış Hızı
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Gösterim Modları

Aşağı açılır menüden istenen Görüntü Modunu (Display Mode) seçin (Şekil 16).

ŞEKİL 16- Görüntü Modu Menüsü

Akış Görüntü Modu Tanımları:

"Akış (Flow): Bu grafik tüm kardiyak döngüsündeki her aşamanın akış hacmini temsil eden bir çizim gösterir (varsayılan). 
Eğri üzerindeki her nokta o aşama için akışı temsil eder.

Pozitif (Positive): Bu grafik kardiyak döngüsü boyunca pozitif akış alanının toplamını gösterir.

Negatif (Negative): Bu grafik kardiyak döngüsü boyunca negatif akış alanının toplamını gösterir.

Tepe Zarf (Peak Envelope): Bu grafik kardiyak döngüsündeki her aşama için tepe pozitif ve tepe negatif hızları temsil eden 
bir çizim gösterir.

Tepe Mutlak (Peak Absolute): Bu grafik her aşama için mutlak tepe akışı temsil eden bir çizim gösterir.

Histogram: Bu grafik, kardiyak döngüsünün tüm aşamaları için her bir ilgi bölgesindeki tüm piksellerin hızını gösteren bir 
grafik görüntüler.

Regurjitan (Regurgitant): Regurjitan Fraksiyonu (%) negatif akışın toplam pozitif akışa bölümüdür.

Basınç Yarı Zamanı (PHT): Tepe transmitral basınç değişiminin yarıya indiği süredir. 

Histogram Modu

Piksel başına hızları göstermek ve tepe ve ortalama basınç değişimini hesaplamak için bu histogram modunu kullanın.

1. Uygun aşama kontrast serisini kullanarak bir akış eğrisi oluşturun.

2. Görüntü Modu aşağı açılır menüsünden Histogram ögesini seçin.

3. Aşama görüntüsü üzerinde, pikselin karşılık gelen konumunu gösteren ince artı imleci etkinleştirmek için doğrudan
grafiğe tıklayın.

4. En yüksek ve en düşük hız değerlerini bulmak için grafiğin altında yer alan çift ok kontrollerini kullanın (Şekil 17).

5. Hız değerleri içinde kesikli olarak artırma yapmak için, Şekil 17‘de gösterildiği gibi tek ok kontrollerini kullanın.

NOT:  Histogram modunda doğrudan akış eğrisi üzerinde tıklandığında, seri bulma işlevi kapatılır. Bulma işlevini
yeniden açmak için akış moduna geçin.

NOT:  Karşılık gelen büyüklük ve aşama görüntülerinin gösterildiğinden emin olmak için, bir defada tek akış eğrisi ile 
çalışın, grafik gösterimindeki diğer histogram eğrileri üzerindeki seçimleri kaldırın.

NOT:  suiteHEART® Yazılımının daha eski bir sürümünde histogram modu kullanılarak analiz edilmiş çalışmaların 
yeniden analiz edilmesi gerekir. 
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ŞEKİL 17- Histogram Modu

Regurjitan Modu

Negatif akışı ve regurjitan fraksiyonunu hesaplamak için Regurjitan modunu seçin.

1. Uygun aşama kontrast serisini kullanarak bir akış eğrisi oluşturun.

2. Görüntü Modu aşağı açılır menüsünden Regurjitan (Regurgitant) ögesini seçin.

3. Siyah dikey imleçlerin yerleşimini gözden geçirin. İmleçler, Şekil 18‘de gösterildiği gibi gerileyen akışın başlangıç ve
bitişine yerleştirilmelidir.

Sonuçlar akış grafiği ekranının sağ üstünde ve özet tablosunda yer alır. 

ŞEKİL 18- Regurjitan Sonuçları
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Basınç Yarı Zamanı

Basınç Yarı Zamanı (PHT), mitral kapakçıktan alınan aşama kontrast resimlerindeki E dalgasının yavaşlama eğimi 
hesaplanarak elde edilebilir. Bu mod, PHT ve mitral kapakçık alanını (MVA) hesaplamak için grafiğin eğimini belirlemeye 
olanak verir.

1. Uygun mitral kapakçık aşama kontrast serisini kullanarak bir akış eğrisi oluşturun.

2. ROI’yi yaymak için kopyala-yapıştır seçeneğini kullanın.

3. Görüntü Modu aşağı açılır menüsünden Basınç Yarı Zamanı (Pressure Half-Time) ögesini seçin.

4. Eğrinin yavaşlama kısmındaki en yüksek hızı tespit etmek için doğrudan çizim üzerine tıklayın.

5. Eğrinin eğimini hesaplamak için Şekil 19‘da gösterildiği gibi bir bitiş noktasına tıklayın.

6. Hesaplamayı sıfırlamak için imleci bir bitiş noktasının üzerine getirin, sağ fare tuşuyla tıklayın ve çöp kutusunu seçin.

ŞEKİL 19- Basınç Yarı Zamanı Sonuçları

NOT:  Mitral Kapakçık bölgesi (MVA), Basınç Yarı Zamanı (PHT) sonuçları aort yetmezliği, kardiyak şantı ya da düşük 
ventriküler uyumdan mustarip hastalarda geçerli değildir.

NOT:  PHT modunda doğrudan akış eğrisi üzerinde tıklandığında, seri bulma işlevi kapatılır. Bulma işlevini yeniden 
açmak için akış moduna geçin.

Referans:

http://www.csecho.ca/mdmath/?tag=mvapht
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Akış Sonuçlarını Gözden Geçirme

ŞEKİL 20- Akış Sonuçları

1. Aşağı açılır ROI menüsü, 2. Akış Sonuçları, 3. Grafik simgesi, 4. Akış Sonuçları/Akış Tablosu simgesi.

1. Tablodaki tüm eğrilerin değerlerini gözden geçirmek için aşağı açılır menüden Tüm ROI’ler (All ROIs) ögesini seçin.

2. Akış sonuçlarını ya da akış tablosunu görüntülemek için  ögesini seçin. 

3. Sonucu rapora dahil etmek veya raporun dışında tutmak onay kutusuna tıklayın.

4. Akış sonuçları ve akış tablosu arasında geçiş yapmak için  ögesini seçin.

5. Akış eğrilerini görüntülemek için  ögesini seçin.

1

2

43
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Qp/Qs Sekmesi

Qp/Qs rapor penceresi, damar akışı sekmeleri rapor pencerelerinin yerleşiminden farklıdır.

ŞEKİL 21- Qp/Qs Rapor Penceresi

1. Aort eğrisi, 2. Pulmoner arter eğrisi, 3. Qp/Qs ölçümü, 4. Akış eğrileri

1

2

3

4
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Qp/Qs Hesaplama

NOT:  Qp/Qs hesaplamalarından önce aort ve pulmoner arter için uygun seriler üzerinde akış eğrileri oluşturulmalıdır.

1. En az bir aort eğrisi seçin.

2. En az bir pulmoner arter eğrisi seçin.

Qp/Qs ölçümleri, hem aort hem de pulmoner arter konturları seçildiğinde otomatik olarak hesaplanır. Tüm 
kontur seçimleri hesaplamaları etkiler. Tüm akış eğrileri grafikte görüntülenir. Eğriler her zaman seçilebilir veya 
seçimleri iptal edilebilir.

Grafikte herhangi bir eğri seçiminin iptal edilmesi hesaplamaları etkilemez.

Birden fazla Aort veya PA seçildiyse, sistem değerlerin ortalamasını alacaktır.

3. Bu sekmedeki grafiği ve tüm hesaplamaları sıfırlamak istiyorsanız, Qp/Qs Sil (Reset Qp/Qs) ögesini seçin.
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Sekme Etiketlerini Değiştirme

ŞEKİL 22- Akış Analizi Sekmeleri 

Sekme Etiketini Değiştirme:

1. Sekme üzerine sağ fare tuşuyla tıklayın (Şekil 22).

2. Yeni etiket adını girin (Şekil 23).

ŞEKİL 23- Sekme Etiketi Düzenleme Açılır Penceresi

NOT:  Akış sekmesi etiketini değiştirmek sadece rapordaki akış başlık etiketini değiştirir.

Akış Eğrisi Lejant Etiketlerini Değiştirme

1. Akış grafiğinin altında bulunan Eğri 1 (Curve 1) üzerine sağ fare tuşuyla tıklayın (Şekil 24).

ŞEKİL 24- Akış Lejantları

2. Yeni etiket adını girin.

ŞEKİL 25- Akış Eğrisi Lejant Etiketi Değiştirme Penceresi

NOT:  Yeni akış eğrisi lejantları mevcut şablona kaydedilir.
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Miyokardiyal Değerlendirme 
Kullanıcı, otomatik bölümleme algoritmaları tarafından oluşturulan ya da değiştirilenler de dahil olmak üzere, tüm ilgi bölgelerinin 
(ROI’ler) tam ve isabetli olarak yerleştirilmesinden sorumludur. Yazılım tarafından üretilen nicel veriler bu ilgi bölgelerinin ve 
uygulanan eşik değerlerin tam ve isabetli olarak yerleştirilmesine bağlıdır.

Çalışma Ön İşleme özelliği, LE’nin (Late Enhancement) ön işleme tabi tutulmasına olanak sağlar. NS-03-040-0012 kodlu 
suiteDXT Kullanım Talimatlarına bakın.

Miyokardiyal Değerlendirme (ME) analiz aracı, miyokardiyum içindeki sinyal yoğunluğu farklı alanların nicel olarak 
belirlenmesine yardımcı olur. 

Üç analiz sekmesi mevcuttur:

• LE - Yüksek ve düşük sinyal yoğunluğuna sahip miyokardiyal kesitleri belirler.
• T2 - Kirli kan görüntüleme teknikleriyle yüksek sinyal yoğunluğuna sahip miyokardiyal kesitleri belirler.
• Sinyal Farklı - LE, T2 analizi  ve T2 sinyal yoğunluk (SI) oranı ile Kazanım Kütlesi sonuçlarını gösterir.

ŞEKİL 1- Analiz Sekmeleri

UYARI : Uygulama yalnızca görüntülerin analizine yardım eder ve otomatik olarak ölçülebilir sonuçlar üretmez. 
Nicel ölçümlerin kullanımı ve yerleştirilmesi kullanıcının inisiyatifindedir. Ölçümler yanlış yapılırsa, hatalı 
teşhisler meydana gelebilir. Ölçümler yalnızca uygun bir şekilde eğitilmiş ve uzman bir kullanıcı 
tarafından oluşturulmalıdır.
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ME Nicel Analiz Prosedürü

LE (Late Enhancement) 

1. ögesini seçin.

2. LE (Late Enhancement) sekmesini seçin.

3. Uygun kısa eksen serisini seçin.

4. Otomatik bölümleme yapmak için  ögesini seçin.

5. Tüm endokardiyal ve epikardiyal izleri, RV ekleme noktasını ve her kesitteki eşiği gözden geçirin Eşiği gerekli oldukça
düzenleyin.

ŞEKİL 2- ME Nicel Analiz Raporu Penceresi

1. Sonuç tablosu, 2. Kutupsal Çizim tipi, 3. Kutupsal Çizim kesiti, 4. Tablo kesiti, 5. Sil, 6. Nicel Kutupsal Çizim

1

2 

3

5 

6

4
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6. Manüel bölümleme yapmak için,  ögesini seçerek en bazal kesitte LV endokardiyumu izleyin.

7. ögesini seçerek LV epikardiyumu izleyin.

8. ögesini seçerek alt RV ekleme noktasını yerleştirin.

9. ROI’yi tamamlamak için imleci düzenleyici penceresinin dışına taşıyın.

10. Tüm ventrikül bölümlere ayrılana kadar 6 - 9 arasındaki adımları tekrar edin.

11. Baz, orta ve tepe sınıflandırmasını onaylayın.

Eşik Seçimi

1. Dosya aşağı açılır menüsünden uygun eşik algoritmasını seçin (Şekil 3).

ŞEKİL 3- Eşik Algoritması Menüsü

2. Gerekli olursa, bir kesit için eşik değerini en üst seviyeye çıkarmak için  ögesine tıklayın. Bu değeri tüm kesitlere 

uygulamak için  ögesine tıklayın. Gerekli olursa, eşik algoritmasını her bir kesite uygulamak için 
kaydırma çubuğunu kullanın.

3. Ortalama +2 ila +7 sonuçlar için, normal miyokardiyum bölümüne normal bir ROI  yerleştirin. Normal ROI’yi 
Yay (Propagate Normal ROI) onaylı ise ROI tüm kesitlere kopyalanır.

Eşik Düzenleme

1. Yüksek sinyal yoğunluklu bölgeler eklemek için  ögesini seçin. 

2. Düşük sinyal yoğunluklu bölgeler eklemek için  ögesini seçin.

3. Her iki tür sinyal yoğunluklu bölgeyi silmek için  küçük silgi aracını ya da  büyük silgi aracını seçin.
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Kutupsal Çizim Gösterim Biçimleri

ME analiz aracı 2 kutupsal çizim biçimi sunar: 16 Bölüm ve Eşmerkezli

Seçenek 1: 16 bölüm prosedürü

1. 16 Bölüm (16 Segment) sekmesini  seçin.

2. 2 Renk (2 Color), 4 Renk (4 Color) veya Sürekli (Continuous) seçimini yapın.

Renk ölçeği çubuğuna tıklayarak renk atamalarını tanımlayabilirsiniz.

Yüzde değerlerini değiştirmek için doğrudan renk ayracına tıklayın ve çekin.

ŞEKİL 4- Kutupsal Çizim

3. Kutupsal Çizim Özet Tablosunu görüntülemek için  ögesini seçin.

Seçenek 2: Kesit-Kesit prosedürü

1. Eşmerkezli (Concentric) sekmesini seçin.

ŞEKİL 5- Eşmerkezli Sekmesi

2 Renkli Kutupsal Çizim 4 Renkli Kutupsal Çizim Sürekli Renkli Kutupsal Çizim
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Eşmerkezli sekmesi, Kutupsal Çizimin biçimini her halkanın bir kesiti temsil ettiği kesit-kesit biçimine dönüştürür. Halka 
sayısı analiz edilen kesit sayısıyla belirlenir.

2. Bölge sayısını seçin.

3. Bölgedeki ROI kütle yüzde değişikliklerini göstermek için alt bölgeleri kontrol edin.

Alt bölgeler seçildiğinde düzeltme işlevi uygulanır.

4. Kutupsal Çizimi yüzde sinyal yoğunluğuna değiştirmek ve değerlere %0-100 arasında sürekli bir aralıkta renk
kodlaması uygulamak için Sürekli (Continuous) onay kutusunu tıklayın.

Konturları silmek için  ögesine tıklayın.

NOT:  LE analizi için yarı otomatik eşik değer, aşağıda gösterildiği gibi yüksek kaliteli miyokardiyal değerlendirme 
görüntüleri üzerinde optimal olarak çalışır (Görüntü A). Kan havuzundan sinyal olmadan alınan (Görüntü B) ya da 
yanlış Döndürme zamanına sahip görüntülerde eşik değerin kullanıcı tarafından öznel olarak ayarlanması gerekir. 

ŞEKİL 6- Miyokardiyal Değerlendirme Görüntüleri

T2 Analizi

1. T2 sekmesini seçin.

2. LE serisi daha önce analiz edilmişse, kopyala düğmesine basılarak ROI’ler T2 serisine kopyalanabilir (bkz. Şekil 7).

NOT:  ROI’leri kopyalamak için, isabetli sonuçlar alabilmek maksadıyla her serideki kesit sayısının eşit olması gereklidir;
kesit sayısı eşleşmiyorsa, kopyala düğmesi kullanılamaz. Aynı sayıda kesit içeren uygun serileri oluşturmak için 
DICOM içe aktarma süreci kullanılabilir.  
En iyi sonuçlar için, Matris ve FOV gibi alma parametreleri her seride aynı olmalıdır. Bir kopyalama yaptıktan 
sonra, ROI’leri tüm kesit konumlarında dikkatle inceleyin ve uygun düzenlemeleri yapın. 
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ŞEKİL 7- Kopyala (Copy) Düğmesinin Yeri

3. Daha önce yapılmış bir LE analizi yoksa, ROI’ler manüel olarak oluşturulabilir.

4. ögesini seçerek en bazal kesitte LV endokardiyumu izleyin.

5. ögesini seçerek LV epikardiyumu izleyin.

6. ögesini seçerek alt RV ekleme noktasını işaretleyin.

7. ROI’yi tamamlamak için imleci düzenleyici penceresinin dışına taşıyın.

8. Tüm ventrikül bölümlere ayrılana kadar 4-7. adımları tekrar edin.

9. 2 Standart sapmalı eşikleme yapmak için, Normal ROI Ekle (Add Normal ROI)  ögesini seçin ve bir normal
miyokardiyum bölümü üzerine bir ROI yerleştirin. Normal ROI’yi Yay (Propagate Normal ROI) onaylı ise ROI tüm
kesitlere kopyalanır. Her bir kesitin konumunu gözden geçirin ve gerektikçe ROI’yi ayarlayın.

NOT:  İskelet kas ROI’si ve Normal ROI verildiğinde, yazılım aşağıdaki hesaplamayı yapar:

Normalize miyokardiyal T2 SI = SI miyokardiyum / SI iskelet kas; 

Eşik hesaplama: Eşik = 2 * STD NORMAL + ORT NORMAL

10. Baz, orta ve tepe sınıflandırmasını onaylayın. Gerekli ise, her kesit için eşik algoritmasını ayarlamak için kaydırma
çubuğunu kullanın.

11. T2 Sinyal Yoğunluk (T2 Signal Intensity) analizi yapmak için İskelet Kas ROI’sini seçin  ve iskelet kas içine bir ROI 
yerleştirin. ROI tüm görüntülere kopyalanır. Her bir kesitin konumunu gözden geçirin ve gerektikçe ROI’yi ayarlayın. 

NOT:  Kirli kan görüntülerinde yetersiz akış baskılama olabileceğinden bunlar hatalı sinyal yoğunluk analizlerine ve 
eşiklemeye neden olabilir.
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Düzenleme

Yüksek T2 sinyal yoğunluk bölgeleri eklemek için  ögesini seçin.

Yüksek T2 sinyal yoğunluk bölgeleri çıkarmak için  küçük silgi aracını ya da   büyük silgi aracını seçin.

Konturları silmek için  ögesine tıklayın.
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Birleşik Analiz

LE ve T2

Birleşik analiz modu, LE ve T2 (Ödem) görüntülerinin yan yana analiz edilmesini sağlar ve düzenleme araçları da sunar.

NOT:  Birleşik analiz modunu etkinleştirmek için, önce LE kullanılarak bir kısa eksen LE serisi için analiz tamamlanmalıdır. 
T2 (Ödem) görüntüleri de aynı çalışma içinde mevcut olmalıdır. 

1. ögesini seçin.

2. Hem LE hem de T2 (ödem) görüntüleri içeren uygun bir çalışma seçin. LE analiz prosedürünü tamamlayın.

NOT:  Birleşik analiz modunu seçmeden önce LE sekmesinde her kısa eksen kesiti için eşiklemeyi gözden geçirin.

3. T2 sekmesini seçin ve T2 serisi için analiz prosedürünü tamamlayın.
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4. Birleşik analizi başlatmak için Şekil 8‘de gösterildiği gibi  ögesini seçin.

ŞEKİL 8- Birleşik Analiz Modu

5. Seçimin ardından, daha önce analiz edilen LE serisi mod görüntüleme penceresinde görünür. Bu pencere daha sonra
LE görüntüleri için bir düzenleme penceresi olur.

6. LE görüntülerini düzenlemek için Şekil 9‘da gösterildiği gibi görüntüleme alanının altında yer alan düzenleme araçlarını
kullanın.

NOT:  Tüm güncellemeleri ve sonuçları doğrudan LE (Late Enhancement) sekmesi üzerinde onaylayın.

NOT:  LV endokardiyum veya LV epikardiyum ROI’leri silinmişse, yeniden izlemek  LE (Late Enhancement) sekmesine 
geri dönün.

T2 (Ödem) Late
Enhancement
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ŞEKİL 9- LE Düzenleme Araçları

7. Soldaki T2 (Ödem) serisini düzenlemek için Şekil 10‘da gösterildiği gibi görüntüleme alanının altında yer alan
düzenleme araçlarını kullanın.

ŞEKİL 10- T2 (Ödem) Analiz Araçları
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8. LE serisinde başka bir kesit seviyesine gitmek için Şekil 11‘de gösterildiği gibi artı ve eksi düğmelerini kullanın.

• Kesit konum bilgisi her görüntüleme alanının sağ alt köşesinde yer alır.

NOT:  LE için gösterilen kesit konumu, T2 (Ödem) düzenleme penceresindeki kesit konumu tarafından belirlenir. Bu 
seçimi geçersiz kılmak için eksi/artı düğmelerini kullanın. 

ŞEKİL 11- Kesitler Arasında Gezinme LE’yi Kontrol Eder 

9. Hem LE hem de T2 (Ödem) serilerinde başka bir kesit seviyesine gitmek için Şekil 12‘de gösterildiği gibi T2 (Ödem)
düzenleme görüntüleme alanının altında yer alan artı ve eksi düğmelerini kullanır.

NOT:  Birleşik analiz modunda sol taraftaki artı ve eksi düğmeleri her iki görüntüleme alanı için kesitler arası gezinmeyi 
ilişkilendirir.

ŞEKİL 12- Birleşik Kesit Gezinme Kontrolleri

Kesit Konumu Kesit 
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Sinyal Diferansiyeli Sonuçları

Sinyal Diferansiyeli (Signal Differential) Sekmesini seçin.

NOT:  Kazanım Kütlesi (Salvage Mass) sonuçlarını elde etmek için LE ve T2 analizlerinin tamamlanmış olması gereklidir. 
T2 Sinyal Yoğunluğu [Signal Intensity (SI)] analizi için İskelet kas ROI’sinin yerleştirilmesiyle T2 analizinin 
tamamlanmış olması gereklidir.

NOT:  T2 (Ödem) sonucu LE sonucundan (Enfarktüs + MVO) daha azsa Kazanım Kütlesi sonucu boş olur.

ŞEKİL 13- Sinyal Diferansiyeli (Signal Differential) Sekmesi
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T1 Eşleştirme Analizi
Bu özellik, eksenel spin-latis gevşeme süresi (T1) sinyalinin sayısallaştırılmasını sağlar. Uygulama, hem Doğal 
(güçlendirilmemiş) hem de Güçlendirme sonrası görüntülerin T1 analizinin yapılmasını hem de hücre dışı hacim kesrinin 
(ECV) hesaplanmasını destekler.

Gerekli Görüntüler: Farklı çevirme sürelerine sahip geri kazanım görüntülerinin çevrilmesi veya satürasyonu (TI). Analiz için 
hareket düzeltme uygulanmış serilerin kullanılması tavsiye edilir. Sol ventriküler taban, orta ve tepeyi temsil eden kesit 
konumlarının kullanılması tavsiye edilir.

UYARI : Uygulama yalnızca görüntülerin analizine yardım eder ve otomatik olarak ölçülebilir sonuçlar üretmez. 
Nicel ölçümlerin kullanımı ve yerleştirilmesi kullanıcının inisiyatifindedir. Ölçümler yanlış yapılırsa, hatalı 
teşhisler meydana gelebilir. Ölçümler yalnızca uygun bir şekilde eğitilmiş ve uzman bir kullanıcı 
tarafından oluşturulmalıdır.

T1 Eşleştirme Analizi Başlatma

1. ögesini seçin.

2. Uygun T1 Eşleştirme serisini seçin.

3. Uygun sekmeyi seçin: Taban, Orta veya Tepe.

4. Seri listesinden veya küçük resim panelinden kısa eksen kesitini seçin.

5. Geri kazanım görüntülerinin ya da Satürasyon Geri Kazanımının analizi için MOLLI analizini seçin.

ŞEKİL 1- T1 Eşleştirme Analizi



suiteHEART® Yazılımı Kullanım Talimatları NS-03-040-0006 Rev.�1    109

Doğal T1 Analiz Prosedürü

1. Bölgesel T1 analizi yapmak için Doğal Yerel ROI aracını  seçin ve miyokardiyum içinde bir ilgi bölgesi 
oluşturun.

2. Bölge için Doğal Yerel T1 sonucu, T1 eğrisinin yanındaki sonuç tablosunda milisaniye (ms) cinsinden gösterilir. Görüntü 
üzerinde birden fazla Doğal Yerel ROI yerleştirilmişse, T1 Yerel Ortalama sonucu güncellenir.

3. Bir görüntü üzerinde sekme başına 5 taneye kadar Doğal Yerel ROI ölçümü yerleştirilebilir.

4. Bir Global T1 analizi yapmak için, LV Doğal endokardiyumu  seçin ve endokardiyal sınırı izleyin.

5. LV Doğal epikardiyumu  seçin ve epikardiyal sınırı izleyin. Global T1 sonucu sonuç tablosunda gösterilecektir. 

Güçlendirme Sonrası T1 Analiz Prosedürü

1. Bölgesel T1 analizi yapmak için Yerel Sonrası ROI aracını  kullanın ve miyokardiyum içinde bir ilgi bölgesi 
oluşturun.

2. Bölge için Yerel Sonrası T1 sonucu ve T1 eğrisi sonuç tablosunda milisaniye (ms) cinsinden gösterilir. Görüntü üzerinde 
birden fazla Yerel Sonrası ROI yerleştirilmişse, T1 Yerel Sonrası Ortalama sonucu güncellenir.

3. Bir görüntü üzerinde sekme başına 5 taneye kadar Yerel Sonrası ROI ölçümü yerleştirilebilir.

4. Bir Global T1 analizi yapmak için, LV Sonrası endokardiyumu  seçin ve endokardiyal sınırı izleyin.

5. LV Sonrası epikardiyumu  seçin ve endokardiyal sınırı izleyin. Global T1 sonucu sonuç tablosunda 
gösterilecektir.
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Renkli Parametrik Harita Görüntüleme

NOT:  Renkli parametrik harita görüntüleme seçeneği için bir Yerel veya Global ROI gereklidir.

1. Şekil 2’de gösterildiği gibi, dosya aşağı açılır menüsünden uygun ögeyi seçin.

2. Parametrik harita seçeneklerini gri tonlamalı görmek için Gri Tonlamalı (Grayscale) ögesine tıklayın.

ŞEKİL 2- Renkli Harita Sonuçları

ECV sayısallaştırma 

1. Hem Doğal hem de Güçlendirme Sonrası görüntüler için ya Yerel analizi ya Global T1 analizi ya da ikisini birden tamamlayın.

2. Doğal görüntüler için  ögesini seçin ve sol ventriküler boşluk içine bir ROI yerleştirin.

3. Güçlendirme Sonrası görüntüler için  ögesini seçin ve sol ventriküler boşluk içine bir ROI yerleştirin.

4. Hematokrit (HCT) değerini girin.

5. ECV sonucu (%) sonuç tablosunda gösterilecektir.

Referans: Wong ve diğerleri, “Association Between Extracellular Matrix Expansion Quantified by Cardiovascular Magnetic 
Resonance and Short-Term Mortality.” Circulation (2012):126:1206-1216.

16 Bölümlü Kutupsal Harita Oluşturma

NOT:  ECV Kutupsal Çizimi için ECV analizinin tamamlanmış olması gerekir.

1. Taban, Orta ve Tepe sekmeleri için Global T1 analizini tamamlayın.

2. Doğal görüntüler için  ögesini seçin ve RV ekleme noktasını yerleştirin. 

3. Güçlendirme Sonrası görüntüler için  ögesini seçin ve RV ekleme noktasını yerleştirin.

4. 16 Bölümlü Kutupsal Harita  ögesini seçin.

5. T1 eğrilerine döndürülecek Grafikleri  seçin.
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Konturları Silme

Konturları silmek için  ögesine tıklayın.

T1 Eğrilerini Gözden Geçirme 

1. Eğri uyum sonuçları görüntü verilerinin sinyal davranış uyum sonuçlarını gösterir. Yanlış kayıt nedeniyle görüntü
kalıntıları, solunum kalıntıları veya ritim bozuklukları varsa eğri uyumu optimal olmayabilir.

2. Sinyal yoğunluk noktaları üzerine doğrudan grafikte tıklayarak ve görüntü üzerindeki kontura tıklayıp mor renge
döndürerek noktaların hesaplamaya dahil edilmemesi sağlanabilir.

3. Sağ fare tuşuyla tıklayıp (tıklayıp bekleyin) sil ögesini seçin ya da klavyedeki sil tuşunu kullanın.

UYARI : T1 eğri yerleştirmenin sonuçlarını gözden geçirin. Analizi uygun bir şekilde eğitilmiş ve uzman bir kullanıcı yapmalıdır. 

Referans: *Messroghli D. R. ve diğerleri, “Modified Look-Locker Inversion Recovery (MOLLI) for High Resolution T1 
Mapping of the Heart.” Magnetic Resonance in Medicine (2004) 52: 141-146. 

Sonuç Denklem Referansı Uyum Tipi

T1 Look-Locker 
(MOLLI) 

y=A-B exp(-t/T1*) Levenberg-Marquardt algoritması 
kullanılarak doğrusal olmayan eğri 
uyumu *
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T2 Eşleştirme Analizi
Bu özellik, T2 gevşeme süresi sinyalinin sayısallaştırılmasını sağlar. T2 eşleştirme bir doku özelliği belirleme tekniğidir.

Gerekli Görüntüler: Değişken eko süreli (TE) durağan durumlu serbest yalpalı okuma değerlerinde sahip T2 hazırlama 
sekansı. Sol ventriküler taban, orta ve tepeyi temsil eden kesit konumlarının kullanılması tavsiye edilir.

T2* azalma eğrisi şöyle hesaplanır: y = a exp(-TE/T2*) + c

2 parametre uyumu için 2 uyum düzeltme yöntemi vardır ve arka plan gürültüsü olarak adlandırılan c, histogram tabanlı 
bir algoritma ile hesaplanıp, üzerinde doğrusal olmayan uyum gerçekleştirilen sinyal yoğunluğundan çıkarılır.  3 parametre 
uyumu doğrusal olmayan bir yaklaşım kullanır.

UYARI : Uygulama yalnızca görüntülerin analizine yardım eder ve otomatik olarak ölçülebilir sonuçlar üretmez. 
Nicel ölçümlerin kullanımı ve yerleştirilmesi kullanıcının inisiyatifindedir. Ölçümler yanlış yapılırsa, hatalı 
teşhisler meydana gelebilir. Ölçümler yalnızca uygun bir şekilde eğitilmiş ve uzman bir kullanıcı 
tarafından oluşturulmalıdır.

T2 Eşleştirme Analizi Başlatma

1. ögesini seçin.

2. Uygun T2 Eşleştirme serisini seçin.

3. Taban, Orta veya Tepe sekmelerinden uygun olanı seçin.

4. Seri listesinden veya küçük resim panelinden kısa eksen kesitini seçin.

5. Uyum düzeltme için ya 2 Parametre ya da 3 Parametre Uyumunu seçin.

ŞEKİL 1- T2 Eşleştirme Analizi
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T2 Analiz Prosedürü

1. Bölgesel T2 analizi yapmak için Yerel ROI aracını  seçin ve miyokardiyum içinde bir ilgi bölgesi oluşturun. 

2. Bölge için Yerel T2 sonucu, T2 eğrisinin yanındaki sonuç tablosunda milisaniye (ms) cinsinden gösterilir. Görüntü
üzerinde birden fazla Yerel ROI yerleştirilmişse, T2 Yerel Ortalama sonucu güncellenir.

3. Bir görüntü üzerinde sekme başına 5 taneye kadar yerel ROI ölçümü yerleştirilebilir.

4. Bir global T2 analizi yapmak için, LV endokardiyumu  seçin ve endokardiyal sınırı izleyin.

5. LV epikardiyumu  seçin ve epikardiyal sınırı izleyin. Global T2 sonucu sonuç tablosunda gösterilecektir. 

Renkli Parametrik Harita Görüntüleme

Şekil 2’de gösterildiği gibi, dosya aşağı açılır menüsünden uygun ögeyi seçin.

ŞEKİL 2- Renkli Harita Sonuçları

16 Bölümlü Kutupsal Harita Oluşturma

1. Taban, Orta ve Tepe sekmeleri için Global T2 analizini tamamlayın.

2. RV ekleme noktası için  ögesini seçin. 

3. 16 Bölümlü Kutupsal Harita  ögesini seçin.

4. T2 eğrilerine döndürülecek Grafikleri  seçin.
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Konturları Silme

Konturları silmek için  ögesine tıklayın.

T2 Eğrilerini Gözden Geçirme 

1. Eğri uyum sonuçları görüntü verilerinin sinyal davranış uyum sonuçlarını gösterir. Yanlış kayıt nedeniyle görüntü
kalıntıları, solunum kalıntıları veya ritim bozuklukları varsa eğri uyumu optimal olmayabilir.

2. Sinyal yoğunluk noktaları üzerine doğrudan grafikte tıklayarak ve görüntü üzerindeki kontura tıklayıp mor renge
döndürerek noktaların hesaplamaya dahil edilmemesi sağlanabilir.

3. Sağ fare tuşuyla tıklayıp (tıklayıp bekleyin) sil ögesini seçin ya da klavyedeki sil tuşunu kullanın.



suiteHEART® Yazılımı Kullanım Talimatları NS-03-040-0006 Rev.�1    115

Zamana Bağlı Analiz 

Zaman Bağlı analiz modu, kullanıcının miyokardiyal zaman kesiti görüntülerini incelemesini ve analiz etmesini sağlar.

NOT:  Yarı nicel analiz desteklenmektedir. Kullanılabilir bir çift sekans serisi varsa, gölge düzeltme özelliği de uygulanabilir. 

DİKKAT: Zamana Bağlı yukarı eğim ve göreli yukarı eğim parametreleri, üzerinde gölge düzeltme uygulanmamış 
görüntülerde isabetli olmayabilir. 

UYARI: Uygulama yalnızca görüntülerin analizine yardım eder ve otomatik olarak ölçülebilir sonuçlar üretmez. 
Nicel ölçümlerin kullanımı ve yerleştirilmesi kullanıcının inisiyatifindedir. Ölçümler yanlış yapılırsa, hatalı 
teşhisler meydana gelebilir. Ölçümler yalnızca uygun bir şekilde eğitilmiş ve uzman bir kullanıcı 
tarafından oluşturulmalıdır.

ŞEKİL 1- Zamana Bağlı Analiz Arayüzü
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Tablo 1:  Analiz Araçları

Tüm kesitleri yay, tüm aşamalar.

Tüm aşamaları yay, tek kesit.

Otomatik bölümleme gerçekleştir.

Düzenleme sonrasında analizi yeniden hesapla. (Sadece otomatik bölümleme yapılmışsa.)

Tüm aşamalarda konturları kopyala / yapıştır. 

Düzenleme sonrasında analizi yeniden hesapla. (Sadece kopyala / yapıştır yapılmışsa.)

Gölge düzeltme uygulandı, sadece bir çift sekans serisi için gerçekleştirilebilir.

Renkli Bölüm katmanını göster.

Katman gösterme.

Hesaplanan parametre için piksel hassasiyetli renkli katmanı göster.

Grafik göster.

Parametre sonuç tablosunu göster.

16 Bölümlü ya da Eşmerkezli Kutupsal Çizim seçimi

2 Renkli, 4 Renkli veya Sürekli Kutupsal Çizim renk seçimi.

Eşmerkezli Kutupsal Çizim Seçimleri.
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Zamana Bağlı Analiz Yapma

1. ögesini seçin.

2. Stres ya da Dinlenme için uygun sekmeyi seçin.

3. Miyokardiyal zamana bağlı seriyi seçin.

4. Otomatik bölümleme ve analiz hesaplaması gerçekleştirmek için  ögesini seçin.

5. Tüm endokardiyal ve epikardiyal izler ile RV ekleme noktasını gözden geçirin ve gerekli oldukça düzenleyin.

6. Taban, orta ve tepe sınıflandırmasını onaylayın.

7. Manüel bölümleme yapmak için tek kesit ya da tüm kesitler üzerinde endokardiyal konturu çizmek için
ögesini seçin.

8. Tek kesit ya da tüm kesitler üzerinde epikardiyal konturu çizmek için  ögesini seçin.

9. Konturları tüm aşamalara kopyalamak / yapıştırmak için  ögesini seçin.

10. ögesini seçerek alt RV ekleme noktasını yerleştirin.

11. Tüm endokardiyal ve epikardiyal izler ile RV ekleme noktasını gözden geçirin ve gerekli oldukça düzenleyin.

12. Taban, orta ve tepe sınıflandırmasını onaylayın.

13. Başlama ve bitiş aşamalarını belirlemek için  ögesini seçin.

14. Başlama aşamasını atamak için  ögesine tıklayın ve ardından doğrudan matris hücresine tıklayın. 

15. Bitiş aşamasını atamak için  ögesine tıklayın ve ardından doğrudan matris hücresine tıklayın.
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Kontur Düzenleme

Bir düzenleme yapıldığında analizin yeniden hesaplanması gerekir. Düzenleme uyarı sembolü görünecektir. Yeniden 

hesaplama yapmak için  ögesine tıklayın.

Sonuçları Gözden Geçirme: 16 Bölümlü Kutupsal Çizim

1. Hesaplanan parametreleri gözden geçirmek için dosya aşağı açılır menüsünden seçin. Bkz. Şekil 2.

Kutupsal çizim üzerindeki bir bölüm üzerine imleci yerleştirirseniz, bu bölüme karşılık gelen grafiğin rengi değişir.

ŞEKİL 2- Hesaplanan Parametreler Aşağı Açılır Menüsü

Grafik/Tablo Sonuçlarını Gözden Geçirme

1. Grafik sonuçlarını gözden geçirmek için grafik görünümünün sol altında yer alan dosya aşağı açılır menüsünden Şekil 3 seçin.

2. Grafikleri görüntülemek için  ögesine tıklayın.

Görüntü üzerinde renkli bölüm katmanını görüntülerken, imleci doğrudan renkli bir bölüm üzerine 
yerleştirirseniz, bu bölüme karşılık gelen grafiğin rengi değişir.

3. Parametre sonuçlarını görüntülemek için  ögesine tıklayın.

ŞEKİL 3- Grafik Sonuçları
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Bağıl Yukarı Eğimi (RU) ve Rezerv Endeksini (RI) Hesaplama

1. ögesini seçin ve kan havuzunun içine bazal kesit seviyesinde bir ROI yerleştirin.

2. Kan havuzu ROI’sini silmek için sağ fare tuşuyla tıklayın ve  ögesini seçin.

NOT:  Rezerv endeksini hesaplamak için hem Stres hem de Dinlenme analizlerinin olması gerekir.

DİKKAT: Zamana Bağlı yukarı eğim ve göreli yukarı eğim sonuç parametreleri, üzerinde gölge düzeltme 
uygulanmamış görüntülerde isabetli olmayabilir. 
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Zaman Bağlı Eğriden Hesaplanan Parametre Tanımları 

Varış Süresi ana hat ile yukarı eğimin kesişim süresi (saniye cinsinden)

Tepe Süresi sinyal yoğunluğunun maksimuma ulaşma süresi (saniye cinsinden) 

SI Oranı SI (tepe süre - ana hat)/ana hat

Yukarı Eğim Yukarı eğim, varış süresi ile tepe süresi arasındaki noktalara uygulanan 
ağırlıklandırılmış doğrusal uyum ile hesaplanır.

Göreli Yukarı Eğim RU = miyokardiyal yukarı eğim / kan havuzu yukarı eğimi

Rezerv Endeksi Miyokardiyal rezerv endeksi (RI) şu şekilde tanımlanır:
 RI = RU STRES / RU DİNLENME

Sinyal Yoğunluğu

Yukarı Eğim

Güçlendirme

İlk ölçü

Varış Süresi Tepe Süresi
Süre
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Patent Foramen Ovale (PFO) 
Analizi 

PFO analiz aracı, PFO belirleme işleminde erken tepe noktayı göstermek için zaman eğrisine göre sinyal oluşturulmasını 
sağlar. 

UYARI : Uygulama yalnızca görüntülerin analizine yardım eder ve otomatik olarak ölçülebilir sonuçlar üretmez. 
Nicel ölçümlerin kullanımı ve yerleştirilmesi kullanıcının inisiyatifindedir. Ölçümler yanlış yapılırsa, hatalı 
teşhisler meydana gelebilir. Ölçümler yalnızca uygun bir şekilde eğitilmiş ve uzman bir kullanıcı 
tarafından oluşturulmalıdır.

PFO'yu başlatma

1. Dosya (File) > Analiz Seç (Select Analysis) > PFO menü ögesini seçin.

2. Bir gerçek zaman serisi seçin.
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ŞEKİL 1- PFO Analiz Penceresi

1. PFO düzenlenebilir sekmeler, 2. Aktif ROI’ler, 3. Sil, 4. Başlangıç ve Bitiş aşaması, 5. Sinyal Yoğunluğu-Aşama eğrisi, 6. PFO Analiz simgeleri

Atriyal Anatomiyi Seçme

1. Sol atrium (LA) ve sağ atrium (RA) anatomilerinin kabul edilebileceği PFO kesitini seçin.

Sol Atriyal (LA) Yoğunluk Eğrisini Oluşturma

1. ögesini seçerek eğriyi çizin.

2. Görüntü Düzenleyici penceresinde LA üzerindeki bir konturu izleyin.

3. İmleci Görüntü Düzenleyici penceresinin dışına taşıyın.

4. LA yoğunluk eğrisini oluşturun.

LA için sinyal yoğunluk eğrisi otomatik olarak oluşturulur.

Sağ Atriyal (RA) Yoğunluk Eğrisini Oluşturma

1. RA yoğunluk eğrisini oluşturmak için  ögesini kullanarak daha önce LA yoğunluk eğrisini oluşturmak için 

uygulanan adımları izleyin.

1

3

5

6

2

4
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Eğriler katman haline getirilir ve eğri sonuçları görüntüleme penceresinde gösterilir.

NOT:  Örneğin, ROI aşama 1 üzerine yerleştirildiyse ve başlangıç aşaması değişmişse, kullanıcı tarafından çizilen ROI, 
ROI’lerin yerleştirildiği orijinal görüntünün üzerinde hala görünür.

ŞEKİL 2- PFO Eğrisi Sonuçları

 Eğri Verisini Gözden Geçirme ve Aşama Aralığı Seçme

1. Rapor penceresinde eğrileri gözden geçirin ve Başlangıç Aşaması (Start Phase) ile Bitiş Aşamasını (End Phase)
ayarlayın.

2. Eğri gösterimi yapılacak aşama aralığını belirlemek maksadıyla Başlangıç Aşaması (Start Phase) ile Bitiş Aşamasını
(End Phase) seçmek için yukarı ve aşağı okları kullanın.

Başlangıç ve bitiş aşamalarını ayarlamak PFO eğrilerinin görüntüsünü etkiler.

Grafik bir noktaya tıklamak Görüntü Düzenleyici penceresinde görüntülenen aşamayı günceller.

ŞEKİL 3- Başlangıç ve Bitiş Aşaması Seçim Ekranı

NOT:  Aynı seride iki alım işlemi varsa, ilk alım için Başlangıç ve Bitiş Aşamalarını seçebilir, LA ve RA ROI’lerini (eğrilerin 
otomatik olarak oluşturulmasından kaynaklanan) çizebilir ve ikinci görüntü kümesi için işlemi başka bir PFO 
sekmesinde tekrarlayabilirsiniz. Tüm PFO sekme etiketleri düzenlenebilir.
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Konturları Düzenleme

Birden fazla aşamayı tek bir kesit konumunda düzenleme:

1. Kesit konumunu seçin

2. ögesini seçin

3. Düzenlenecek aşama aralıklarının ilk aşamasını seçin.

4. Üst karakter tuşunu basılı tutun ve düzenlenecek aralıktaki son aşamayı seçin.

Seçilen küçük resimler kırmızı bir kenarlıkla vurgulanmış halde görüntülenir.

5. Konturu görüntü düzenleyici penceresinde düzenleyin.

6. Seçilen konturun ilerisinde görüntü üzerine tıklayarak veya imleci düzenleyici penceresinin dışına taşıyarak konturun
seçimini kaldırın.

ROI düzenleme gösterme aralığı ayarlanarak kontrol edilebilir.

Görüntü Görünümünden (Image View) uygun gösterme aralığını seçin.

 Aralık-Hepsi (Scope All) – ROI düzenlemelerini tüm aşamalara uygular.

 Aralık-Mevcuttan Bitişe Kadar (Scope Current to End) – ROI düzenlemelerini mevcut aşamadan bitişe 
kadar uygular.

 Aralık-Sadece Mevcut (Scope Current to End) – ROI düzenlemelerini sadece mevcut aşamaya uygular.

Konturları Silme

1. Konturları silmek için  ögesine tıklayın.

Nihai Eğri Sonuçlarını Gözden Geçirme

Konturlardan zamana karşılık piksel yoğunluğunu gösteren bir grafik oluşturulur. Rapora göndermek için grafiğin üzerine 

sağ fare tuşuyla tıklayın .
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T2Star

T2Star analiz aracı, çoklu-eko hızlı değişim eko sekansından faydalanarak dokunun T2* değerlerini hesaplar.

T2* eğrisi, üssel azalma eğrisi formülü kullanan bir eko süresi-sinyal yoğunluğu grafiğidir. T2* uyum algoritması, 
Levenberg-Marquardt doğrusal olmayan en küçük kareler algoritmasını temel alır.

T2* azalma eğrisi şöyle hesaplanır:   y = a *exp(-TE/T2*) + c

 Burada simgeler şu anlama gelir:

UYARI: Uygulama yalnızca görüntülerin analizine yardım eder ve otomatik olarak ölçülebilir sonuçlar üretmez. 
Nicel ölçümlerin kullanımı ve yerleştirilmesi kullanıcının inisiyatifindedir. Ölçümler yanlış yapılırsa, hatalı 
teşhisler meydana gelebilir. Ölçümler yalnızca uygun bir şekilde eğitilmiş ve uzman bir kullanıcı 
tarafından oluşturulmalıdır.

y TE zamanındaki sinyal yoğunluğudur

a 0 (sıfır) zamanındaki ters manyetizasyondur

TE eko süresidir

T2* azalma sabitidir ve

c arka plan gürültüsüdür
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Kalp Analiz Prosedürü
ŞEKİL 1- T2Star Analiz Prosedürü

1. ögesini seçin.

2. Uygun seriyi seçin.

3. Küçük resim panelinden kısa eksen kesitini seçin.

4. Ögesini kullanarak interventriküler bölmeyi çevreleyen bir kontur çizin.

T2* ve R2* değerleri hesaplanır ve sonuç tablosunda gösterilir.

R2 değeri hesaplanır ve grafik üzerinde gösterilir.
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Miyokardiyal Renk Haritası Oluşturma

1. ögesini kullanarak endokardiyal sınır konturunu çizin.

2. ögesini kullanarak epikardiyal sınır konturunu çizin.

T2*/R2* renk haritası görüntünün üzerine katman olarak yerleştirilir.

3. R2* renk haritası değeri değiştirilebilir.

NOT:  1.5T görüntüler için varsayılan aralık 5ms - 500ms arasıdır. 3.0T görüntüler için varsayılan aralık 2,5ms - 1000ms
arasıdır. 

4. Renk haritası dinamik renk aralığını ayarlamak için yukarı ve aşağı ok tuşlarına tıklayıp çekin.

Görüntü Düzenleyici içindeki renk katmanı dinamik olarak değişir.

Hz ve ms değerleri de dinamik olarak değişir.

5. T2* ve R2*  değerleri seçilerek ve görüntüdeki renk haritası katmanının üzerine yerleştirilerek belirlenebilir.
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Uyum Parametreleri

T2* azalma eğrisi için 2 Parametre (2 Parameter) veya 3 Parametre Uyumunu (3 Parameter Fit) seçin. 

ŞEKİL 2- Parametre Uyumu

2 parametre yerleştirme, emsal değerlendirme literatüründe genel bir kabul görmüştür [1]. Bu modelde, arka plan 
gürültüsü olarak adlandırılan c, histogram tabanlı bir algoritma ile hesaplanıp, üzerinde doğrusal olmayan uyum 
gerçekleştirilen sinyal yoğunluğundan çıkarılır.

3 parametre yerleştirmeye de emsal değerlendirme literatüründe referans edilmiştir [2]. Bu model doğrudan giriş sinyali 
üzerinde çalışan doğrusal olmayan bir yaklaşımdır.

Her iki model içinde ilk T2Star değeri deneme için yapılan bir doğrusal uyum kullanılarak tahmin edilir.

1. D.J Pennell ve diğerleri “Cardiovascular T2-star (T2Star) magnetic resonance for the early diagnosis of myocardial iron overload,” Eur Heart J
2001; 22: 2171-2179.

2. Ghugre NR ve diğerleri “Improved R2* Measurements in Myocardial Iron Overload,” Journal of Magnetic Resonance Imaging 2006; 23: 9-16.

T2Star Sonuçlarını Gözden Geçirme

1. Görüntülerin tümünde kontur konumunu gözden geçirin.

2. Tablo T2*/R2* ölçümlerini ayrı ayrı listeler ve ortalama değer hesaplar.

Konturları silmek için  ögesine tıklayın.

3. Her konturun sonuçlarını yazdırma seçimi, ölçüm tablosundaki her değer için Yazıcı ayarı seçilerek yapılabilir.

T2Star Eğrisini Gözden Geçirme ve Güncelleme

T2* eğrisi, üssel azalma eğrisi formülü kullanan bir eko süresi-sinyal yoğunluğu grafiğidir. Tüm görüntülerde yeterli sinyal-
gürültü oranı yoksa (yani sinyal eğrisi sıfıra yakınsa), T2*/R2* değerleri yanlış olabilir. 

Görüntüden tek bir kontur silmek için
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1. Konturu seçin, seçilen kontur mora döner.

2. Sağ fare tuşu menüsünden Sil (Delete) ögesini seçin veya klavye üzerindeki Sil tuşunu kullanın.

• Kontur silinir ve ilişkili nokta grafikten kaldırılır.

ŞEKİL 3- T2Star Eğrisi

UYARI: T2Star eğri uyumunun sonuçlarını gözden geçirin. Analizi ve teşhisi uygun bir şekilde eğitilmiş ve uzman 
bir kullanıcı yapmalıdır.

R2*/T2* Dönüştürmeleri

T2 ve T2* milisaniye olarak, R2 ve R2* ise Hertz (veya s-1) olarak bildirildiği için 1000 çarpanı kullanılır.

Tablo 1:  

Sonuç Birim Dönüşüm

R2* Hz R2*=1000/T2*

T2* ms T2*=1000/R2*
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3B/4B Görüntüleyici
3B/4B Görüntüleyici, 3B ve 4B Akış MRI görüntülerini göstermeyi sağlar. 4B Akış MRI görüntülerinden,  suiteHEART® 
Yazılımı kullanılarak konvansiyonel olarak analiz edilebilen 2B aşama kontrast ve 2B işlev görüntülerini yeniden 
biçimlendirmeyi ve oluşturmayı destekleyen araçlar sunar.

NOT:  İzometrik voksellerden ve örtüşen kesitlerden oluşan 3B seri, yeniden biçimlendirilmiş görüntülerin kalitesini 
iyileştirir.

NOT:  3B/4B analiz aracı 4B lisansı varsa 4B seriyi gösterebilir.

DİKKAT: 3B ya da yeniden biçimlendirilmiş görüntüler bir tanının oluşturulması için sadece ek destekleyici bilgi 
sağlar ve her zaman konvansiyonel görüntüleme teknikleriyle birlikte kullanılmalıdır.

UYARI : 3B yeniden biçimlendirilmiş görüntüleri her zaman orijinal alınmış verilerle ilişkilendirin.

UYARI : Pencere genişliği ve seviyesi (WW/WL) ayarları faklı patolojilerin görünümünü ve diğer anatomik yapıları 
fark etme becerisini etkileyebilir. Yanlış WW/WL ayarları görüntü verilerinin gösterilememesine neden 
olabilir. Tüm görüntü verilerini gözden geçirmek için farklı WW/WL ayarları gerekebilir.
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3B/4B Görüntüleyici Bileşenleri

ŞEKİL 1- Görüntüleme Kontrol Araçları ve Görüntüleme Alanları

Görüntüleme 

3B Görüntüleme Aksiyal 

Eğik Görüntüleme Eğik Görüntüleme 

Alanı Görüntüleme Alanı

Kontrol Araçları

Alanı 1 Alanı 2
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Tablo 1:  Görüntüleme Kontrol Araçları

Araç Açıklama

İnce Artı İmleci (Crosshair Cursor) - tüm görüntüleme alanları 
arasında gezinmeyi senkronize eder. 

Yönlendirme Düğmeleri (Orientation Buttons) - 3B ve eğik 
görüntüleme alanlarında görüntü düzlemini değiştirir.

S = Üst (Superior)
I = Alt (Inferior)
A = Ön (Anterior) 
P = Arka (Posterior) 
L = Sol
R = Sağ 

Eğik Mod (Oblique Mode) - istenen anatomiyi göstermek içim eğik 
yeniden biçimlendirilmiş görüntüyü ve düşey kesişimi gösterir. 

Çifte Eğik Mod (Double Oblique Mode) - üç ayarlanabilir renkle 
(mavi, sarı ve yeşil) tanımlanan üç eğik düzlem gösterir. Diğer iki eğik 
düzlemi güncellemek için herhangi bir ekseni ayarlayın. 

3B Görüntüleme Modu (3D View Mode) - 3B görüntüleme alanında 
görüntü resimleme modları sunar

Yüzey 
MIP = Maksimum yoğunluk projeksiyonu (Varsayılan)
MINIP = Minimum yoğunluk projeksiyonu 

Akış Çizgileri (Streamlines) - 3B hız alanlarını belirli bir zaman 
aşamasında görsel olarak sunar.

Renk Katmanı (Color Overlay) - renk katmanını açar/kapatır. 
Sadece 4B akış görüntüleri içindir.

Aşama (Phase) - büyüklük ve aşama görüntüsü göstermeyi açar/
kapatır.
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Kan Hızı (Blood Speed) - akış yönünün renk atamasını ayarlar. 
Sadece 4B akış görüntüleri içindir.
Kan Hızı renk barı lejantı her görüntüleme alanının sağ tarafında 
gösterilir. Değer tahminidir.

Renk Opaklığı (Color Opacity) - anatomiyi vurgulayan 
görüntülemeyi iyileştirmek için görüntünün renk opaklığını kontrol 
eder. Sadece 4B akış görüntüleri içindir. 

Film (Cine) - saniye başına çerçeve sayısını kontrol eder ve filmin 
başlangıç ve bitiş çerçevelerini belirler. Sadece 3B zaman 
çözünürlüklü büyüklük ve 4B akış görüntüleri içindir. Filmi oynatmak 
ya da duraklatmak için klavyedeki boşluk tuşunu kullanın.

Seri Tanımı (Series Definition) - analiz için 2B konvansiyonel işlevsel 
ya da akış görüntü serisi ya da sonradan işlenmiş MIP görüntüleri 
oluşturur. Kesit sayısını, kesit kalınlığını, boşluğu ve görüş alanını 
girmek için kullanın. Bu parametreler her bir görüntüleme alanının 
sol üstünde bulunur. Açmak/kapatmak için Ctrl + T tuş 
kombinasyonunu kullanın.

Sadece Büyüklük (Magnitude Only) - işlev analizinde kullanmak 
üzere orijinal görüntülerden tek kesitli veya çok kesitli çok aşamalı 
bir büyüklük serisi oluşturur.

Büyüklük ve Aşama (Magnitude and Phase) - akış analizinde 
kullanmak üzere orijinal görüntülerden tek kesitli veya çok kesitli 
çok aşamalı bir aşamalı büyüklük serisi oluşturur. Bu seçenek sadece 
4B Akış serisi seçildiğinde kullanılabilir. (Otomatik aşama düzeltmeli 
bir kopya seri de oluşturulur.)

Sonradan İşlenmiş (Post-processed) - 3B görüntülerden maksimum 
yoğunluk projeksiyon görüntüleri oluşturur. 4B akış verisi 
olduğunda, görüntüler üzerinde gözden geçirme maksadıyla renk 
katmanlı tek kesitli veya çok kesitli çok aşamalı bir seri oluşturulur. 

Kaydet (Save) - seri tanımı tarafından oluşturulan tüm görüntü 
serisi tiplerini yerel veritabanına kaydeder. 

Rx Planlama (Rx Planning) - seri tanımı tarafından oluşturulan 
istenen tarama eksenini tanımlar. 

Tablo 1:  Görüntüleme Kontrol Araçları

Araç Açıklama
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Sayfalama ve Kalınlaştırma (Paging and Thickening) - MIP 
görüntüsün kalınlığını değiştirir ve görüntü seti boyunca sayfalama 
yapar. 

1= MIP görüntüsünün kalınlığını değiştirmek için tıklayın ve iki 
taraftaki düğmelere doğru çekin
2= görüntü seti boyunca sayfalama yapmak için kaydırıcıya tıklayın 
ve çekin. 

Kontroller seçili görüntüleme alanının sağ tarafında yer alır.

Doğrusal (Linear) - Düz hat mesafelerini ölçmek için sunulmuştur. 
Silme, Bulma veya Etiketleme yapmak için doğrudan ölçüme tıklayın 
ve sağ fare tuşuna basın.

3B Döndürme (3D Rotate) - 3B görüntüleme alanında ve/veya eğik 
görüntüleme alanı 1 ve 2’de görüntüleri eğer veya döndürür. Eğmek 
ya da döndürmek için görüntüleme alanında doğrudan sol fare 
tuşuna tıklayıp çekin. 

Akış Yönü (Flow Direction) - eğik görüntüleme alanı 1 ve 2’de düşey 
düzlemi gösterir. Bu özelliği kullanmak içi ilgilenilen anatomi 
üzerinde doğrudan sol fare tuşuna tıklayın. Sadece 4B akış 
görüntüleri içindir.

Pencere/Seviye (Window/Level) - tüm görüntüleme alanlarında 
mevcuttur.

Kaydırma (Pan) - tüm görüntüleme alanlarında mevcuttur.

Yaklaşma (Zoom) - tüm görüntüleme alanlarında mevcuttur.

Döndürme (Rotate) - 3B görüntüleme alanı, görüntüleme alanı 1 ve 
görüntüleme alanı 2’de kullanılabilir.

Tablo 1:  Görüntüleme Kontrol Araçları

Araç Açıklama
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Sıfırlama (Reset) - tüm görüntüleme alanlarında mevcuttur.

Tarama Parametreleri (Scan Parameters) - tüm görüntüleme 
alanlarında mevcuttur.

Tablo 2:  Hızlı Tuş

İşlev Eylem

Hedef İmleç Üst Karakter tuşuna basın ve ince artı imleci istenen 
anatominin üzerine getirin.

Tablo 1:  Görüntüleme Kontrol Araçları

Araç Açıklama
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3B/4B Görüntüleyici Yerleşimi ve Seri Oluşturma 
Çıktıları

Yeniden biçimlendirme için seçilen görüntü serisinin tipine bağlı olarak, görüntü oluşturma tipi aşağıdaki tabloda özetlenmiştir. 

Örnek İş Akışı: 3B Görüntü Serisinden MIP Görüntüler Oluşturma

1. Uygun çalışmayı seçin ve suiteHEART® Yazılımını çalıştırın.

2. ögesini seçin.

3. Aşağı açılır seri listesinden uygun 3B seriyi seçin. Şekil 2‘de görüldüğü gibi, seçili görüntü tipi düğme üzerinde
gösterilecektir.

ŞEKİL 2- Seri Seçme

Tablo 3:  3B/4B Yerleşimleri ve Çıktıları

3B/4B Görüntüleyici Yerleşimi 3B Görüntü Serisi Çıktıları 4B Akış Görüntüsü Serisi Çıktıları

3B görüntüleme  
(sol üst görüntüleme alanı)

Sonradan İşlenmiş Sonradan İşlenmiş

Aksiyal  
(sağ üst görüntüleme alanı)

Sadece Büyüklük

Sonradan İşlenmiş (MIP)

Sadece Büyüklük*, Büyüklük ve 
Aşama* ve Sonradan İşlenmiş (renk 
katmanı)*

Eğik 1  
(sol alt görüntüleme alanı)

Sadece Büyüklük

Sonradan İşlenmiş (MIP)

Sadece Büyüklük*, Büyüklük ve 
Aşama* ve Sonradan İşlenmiş (renk 
katmanı)*

Eğik 2  
(sağ alt görüntüleme alanı)

Sadece Büyüklük

Sonradan İşlenmiş (MIP)

Sadece Büyüklük*, Büyüklük ve 
Aşama* ve Sonradan İşlenmiş (renk 
katmanı)*

* Bu seri tipi suiteHEART® Yazılımında konvansiyonel analiz için kullanılabilir.

Büyüklük ve aşama serilerinin her biri için otomatik aşama düzeltmeli bir kopya oluşturulacaktır.
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4. ögesini seçin ve istenen görüntüleme alanına tıklayın. Aktif görüntüleme alanı kırmızı olarak gösterilecektir.
Şekil 3‘te gösterildiği gibi sarı yeniden biçimlendirme çizgileri görünecektir.

ŞEKİL 3- Eğik Mod

5. Düz sarı çizgiye tıklayın, sol fare tuşuna tıklayıp çekerek çizgiyi istenen anatomiyi gösterecek şekilde eğin.

a.) Kaydetmek için istenen görüntüleme alanına tıklayın. 

b.) Görüntüleme alanının sağ tarafında yer alan kontrolleri kullanarak MIP kalınlığını ayarlayın. 

c.) Şekil 4’te gösterildiği gibi seri tanım girişlerini tamamlayın. 

d.) MIP görüntüsünü yerel veritabanına kaydetmek için kaydet düğmesine basın.

ŞEKİL 4- Seri Tanımı

1. Sonradan İşlenmişi Seçin

2. Kaydet Düğmesine Tıklayın
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6. ögesini seçerek bir MIP görüntü yığını oluşturun.

NOT:  Oluşturulabilecek maksimum sonradan işlenmiş MIP görüntüsü sayısı 512’dir.

7. Şekil 5‘te gösterildiği gibi, referans görüntü olarak kullanılacak görüntüleme alanına tıklayın ve bir toplu görüntü
kümesi tanımlayın.

a.) Kesit kapsama aralığını genişletin.

b.) Kesit yönünü göstermek için açıyı ve okları ayarlayın.

c.) Rx’i hareket ettirin.

ŞEKİL 5- Rx Planlama

8. Seri tanımını girin ve görüntüleri yerel veritabanına kaydetmek için  ögesine tıklayın. 

9. Oluşturulan seriyi görüntülemek için analiz moduna geçin, gözden geçirme modunu seçin ve yenileye tıklayın.

Örnek İş Akışı: Konvansiyonel Analiz için 2B Seri Oluşturma

Konvansiyonel 2B aşama kontrast ve 2B işlevsel görüntüler oluşturmak için hem zaman çözünürlüklü büyüklük hem de R/
L, A/P ve S/I akış düzenine sahip bir 4B Akış serisi gereklidir. 

4B akış görüntülerinden oluşturulmuş sadece büyüklük ya da büyüklük ve aşama serileri, işlev ya da akış analizinde 
kullanılabilecek geçerli 2B konvansiyonel serilerdir. 

4B Akış serisinden sonradan işleme ile oluşturulan serilerin bir renk akış katmanı olur. Uygun tarama düzlemi 
oluşturulduysa, seri işlev analizi için kullanılabilir.

1. Uygun çalışmayı seçin ve suiteHEART® Yazılımını çalıştırın.

2. ögesini seçin.

a a

b

c
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3. Şekil 6‘da gösterildiği gibi, aşağı açılır seri listesinden uygun 4B seriyi seçin. Şekil 6‘da görüldüğü gibi, seçili görüntü tipi 
düğme üzerinde gösterilecektir.

ŞEKİL 6- Seri Seçme

4. ögesini seçin ve istenen görüntüleme alanına tıklayın. Aktif görüntüleme alanı kırmızı olarak gösterilecektir.
Şekil 7‘de gösterildiği gibi sarı yeniden biçimlendirme çizgileri görünecektir.

ŞEKİL 7- Eğik Mod 4B Yeniden Biçimlendirme

5. Düz sarı çizgiye tıklayın, sol fare tuşuna tıklayıp çekerek çizgiyi istenen anatomiyi gösterecek şekilde eğin.

a.) Kaydetmek için istenen görüntüleme alanının üzerine tıklayın ve 2B aşama kontrast serisi oluşturmak için 
Büyüklük ve Aşamayı, işlevsel bir seri oluşturmak için Büyüklüğü seçin. 

b.) Görüntüleme alanının sağ tarafında yer alan kontrolleri kullanarak kesit kalınlığını ayarlayın. 

c.) Şekil 8’de gösterildiği gibi seri tanım girişlerini tamamlayın ve seriyi yerel veritabanına kaydetmek için kaydet 
düğmesine basın.
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ŞEKİL 8- Seri Tanımlama ve Kaydetme

6. Çok kesitli çok aşamalı görüntülerden bir yığın oluşturmak için  ögesini seçin.

NOT:  Oluşturulabilecek çok aşamalı görüntülerin maksimum sayısı 32’dir.

NOT:  3B/4B görüntüleyici kullanılarak bir 2B büyüklük ve aşama serisi oluşturulduysa, uygulama kopya bir otomatik
aşama düzeltmeli seri oluşturur. Seri, Şekil 9‘da gösterildiği gibi “düzeltilmiş” olarak etiketlenecektir.

ŞEKİL 9- Otomatik Aşama Düzeltmeli Kopya Seri Örneği

1. Büyüklük ve Aşamayı Seçin

2. Kaydet Düğmesine Tıklayın
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7. Şekil 10‘da gösterildiği gibi, referans görüntü olarak kullanılacak görüntüleme alanına tıklayın ve bir toplu görüntü
kümesi tanımlayın.

ŞEKİL 10- Rx Planlama

8. Seri Tanımı seçeneklerini seçin ve görüntüleri yerel veritabanına kaydetmek için  ögesine tıklayın. 

9. Oluşturulan seriyi analiz etmek için uygun analiz moduna geçin ve yenileye tıklayın.

Örnek İş Akışı: Bir Akış Ölçümü Oluşturma 

Akış analizi arayüzü araçları hakkında ayrıntılı bilgi için bkz. Akış Analizi, sayfa 77.

1. Analiz (Analysis) Sekmesini seçin.
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2. Üzerinde çalışılacak damarı saptayın. Gelişmiş otomatik bölümleme için, gösterildiği gibi, sadece aort ya da pulmoner

anatomi desteklenir. Bir akış eğrisi oluşturmak için  ögesine tıklayın.

ŞEKİL 11- Aort ve Pulmoner Damar Örneği

UYARI :  Gelişmiş otomatik bölümleme kullanmak için tüm sonuçların dikkatlice gözden geçirilmesi gereklidir. 
Eğer damar tanıma optimal değilse, damar için konvansiyonel otomatik bölümleme yapın.

3. Konvansiyonel otomatik bölümleme için üzerinde çalışılacak damarı saptayın ve Şekil 12‘de gösterildiği gibi
ögesine tıklayın.

1 - 6 arası numaralandırılmış altı ROI mevcuttur. Renk kodlaması analiz görünümünde, görüntüleme alanlarında ve 
grafiklerde aynıdır.

4. Üzerinde çalışılacak damarın çevresine 4 nokta koyarak ve ROI’yi kapatmak için son noktaya çift tıklayarak damar
etrafında bir kontur oluşturun.

5. Kesitteki tüm aşamalar üzerinde otomatik bölümleme yapmak için  ögesine tıklayın.
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ŞEKİL 12- Manüel ROI Yerleştirme

Hız Örtüşme Düzeltmesi Uygulama

Hız örtüşmesini düzeltmek için aşama açma işlemi yapmak maksadıyla kaydırma çubuğu kontrol düğmesini çekin. Değişikliğin 
etkisi doğrudan aşama görüntüsüne uygulanır ve sonuçlar doğrudan akış grafiği üzerinde görüntülenir. Hız kodlu üç 
görüntünün her birini üç dik yön (x, y, z) boyunca kontrol etmek için aşağı açılır menüden Şekil 13‘te gösterildiği gibi seçim 
yapın.

ŞEKİL 13- 
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Yapılandırılmış Rapor

Rapor İçeriğini Tanımlama

Raporlarda yer alan ölçümler ve grafikler, analiz modlarının sonuçlarından alınır. Her farklı analiz sonucu raporda yer almak 
üzere seçilebilir.

Önceden tanımlanmış klinik izlenimler ve teknikler özel raporları basitleştirir. Klinik izlenimler ve teknikler oluşturma 
prosedürlerinin ayrıntıları için İzlenim Sekmesi bölümüne bakın. Rapor Tercihleri, hasta raporunda başlık ve üst bilgi olarak 
görünecek site bilgilerinin girilmesini sağlar.

Yapılandırılmış Rapor Görünümü

Yapılandırılmış Rapor Görünümü, klinik raporların oluşturulmasına yardım etmek için tasarlanmıştır. Dört sekme içerir:

• Geçmiş (History)
• İzlenim (Impression)
• Görüntüler (Images)
• Kutupsal Çizim (Polar Plots)

Yazdırılabilir her alan yanında onay kutusu seçim düğmesi  bulunur. Alanı rapora dahil etmek veya raporun dışında 
tutmak onay kutusuna tıklayın. 

NOT:  Yazdırma tercihleri,  Araçlar (Tools) > Tercihler (Preferences) > Tercihleri düzenle (Edit Preferences) menüsü 
altındaki Yazdırma Tercihleri sekmesinde düzenlenebilir.

Geçmiş Sekmesi

Geçmiş Sekmesi (History Tab) DICOM başlığındaki hasta bilgisini içerir. Bilgi güncellenirse alan sarı işaretli olarak gösterilir.

NOT:  Düzenlenen hasta bilgileri yalnızca raporu etkiler. DICOM üst bilgisi aynı kalır.
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ŞEKİL 1- Geçmiş Sekmesi

1. DICOM Başlık Bilgisi, 2. Beden Yüzey Alanı seçimi, 3. Hasta Geçmişi, 4. Notlar

Beden Yüzey Alanı hesaplama tipi, ters sarı üçgen üzerinde sağ fare tuşuyla tıklanarak seçilebilir.

Referans: http://halls.md/formula-body-surface-area-bsa/

Beden Yüzey Alanı 
Hesaplama Yöntemi

Formül

DuBois ve DuBois BYA (m2) = 0,20247 x Boy(m)0,725 x Ağırlık(kg)0,425

Mosteller BYA (m2) = KAREKÖK ([Boy(cm) x Ağırlık(kg) ]/3600)
BYA (m2) = KAREKÖK ([Boy(inç) x Ağırlık(libre) ]/3131)

Gehan ve George BYA (m2) = 0,0235 x Boy(m)0,42246 x Ağırlık(kg)0,51456

Haycock BYA (m2) = 0,024265 x Boy(m)0,3964 x Ağırlık(kg)0,5378

Boyd BYA (m2) = 0,0003207 x Boy(cm)0,3 x Ağırlık(gram)(0,7285 - (0,0188 x LOG(gram))

1

2

3

4
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Geçmiş ve Not Metin Kutuları

Geçmiş alanına hasta geçmişiyle ilgili tüm bilgileri girin veya uygun makroyu seçin. Notlar paneli, kullanıcı tarafından analiz 
esnasında girilen notları gösterir ama rapora eklenemez.

İzlenim Sekmesi

ŞEKİL 2- İzlenimler Sekmesi

1. İzlenim, 2. Teknik

İzlenim 

Metin kutusuna yazarak ve/veya izlenim makro düğmesine tıklayarak izlenim bilgilerini girin.

Önceden tanımlanmış izlenim makroları İzlenim panelinin altındaki düğmelerde yer alır. 

NOT:  Makrolarla sonuç hesaplamaları yapılmadan önce uygun tüm analizlerin  gerçekleştirilmesi gerekir.

Teknik 

Metin kutusuna yazarak ve/veya izlenim makro düğmesine tıklayarak teknik bilgilerini girin.

Önceden tanımlanmış teknik makroları Teknik panelinin altındaki düğmelerde yer alır. 

NOT:  Makrolarla sonuç hesaplamaları yapılmadan önce uygun tüm analizlerin  gerçekleştirilmesi gerekir.

1

2
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Görüntüler Sekmesi

ŞEKİL 3- Görüntüler Sekmesi 

1. Grafikler/Tablolar, 2. Rapor için görüntüler

2

1
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Rapor Grafiklerini ve Özet Tablolarını İnceleme

Grafikler Görünümü paneli analiz sırasında rapora eklenen tüm grafikleri ve özet tablosu sonuçlarını içerir.

1. simgelerini kullanarak grafik ve özet tabloları arasında ilerleyin.

2. Yazdırılan rapora bir grafik veya özet tablosu başlığı eklemek için beyaz kutuya tıklayın.

3. etkin olduğunda, grafik veya tablo rapora eklenir.

4. Bir grafiği ya da tabloyu silmek için  ögesine tıklayın.

Görüntüleri Gözden Geçirme

Görüntü paneli analiz sırasında Rapora gönderilen tüm görüntüleri içerir.

1. simgelerini kullanarak görüntüler arasında ilerleyin.

2. Yazdırılan rapora bir görüntü başlığı eklemek için beyaz kutuya tıklayın.

3. küçük biçim veya  büyük biçim düğmelerini seçerek görüntü boyutunu seçin.

4. Görüntü panelindeki görüntüler, üzerine tıklanarak ve farklı bir görüntüleme alanına çekilerek yeniden sıralanabilir.

5. Görüntü kullanma araçlarına erişmek için doğrudan görüntü üzerine sağ fare tuşuyla tıklayın.

6. Görüntünün geldiği seriye gitmek için doğrudan görüntü üzerine sağ fare tuşuyla tıklayın ve  git düğmesine 
tıklayın.

7. etkin olduğunda, görüntü Rapora eklenir.

8. ögesini seçerek görüntüyü silin.

NOT:  Eski bir yazılım sürümüyle (2.1.0 veya daha eski) analiz edilmiş bir çalışma açılırsa, daha önceden Rapor
Görünümüne eklenmiş görüntüler görüntü kullanma araçlarıyla kullanılamaz. Eklenen yeni görüntüler beklendiği 
gibi kullanılabilir.

Kutupsal Çizimler Sekmesi

Bu tablo, işlevsel, miyokardiyal değerlendirme ve zamana göre görülen anormallikleri nitel olarak kutupsal çizim biçiminde 
tespit etmeye yarar. Bölümlerin renk kodlarını değiştirmek maksadıyla renk paletini açmak için bölüm renk lejantına sağ 
fare tuşuyla tıklayın.
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ŞEKİL 4- Kutupsal Çizimler Sekmesi

Kutupsal Çizimleri Rapora Ekleme

Rapora ek kutupsal çizimler eklemek için  ögesine tıklayın ve dosya aşağı açılır menüsünden kutupsal çizim biçimini 

 seçin.

Bölümler için Renk Seçme

Anormalliği tanımlamak için istenen terminolojinin yanındaki renk kutusuna tıklayın. İmleç boya fırçası haline gelir. 
Ardından rengi belirlemek için doğrudan kutupsal çizim üzerine tıklayın. 

Tüm Bölümler için Renk Seçme

Kutupsal çizim çerçevesinin dışına sağ fare tuşuyla tıklayın ve listeden istenen seçimi yapın. 



suiteHEART® Yazılımı Kullanım Talimatları NS-03-040-0006 Rev.�1    150

ŞEKİL 5- İşlev Seçimi

16 veya 17 Bölüm Çizimini Seçme

Kutupsal çizimin solunda yer alan uygun seçim düğmesine basın.

Kutupsal Çizimin Başlığını Düzenleme

Her kutupsal çizimin tip başlığı yazma alanına tıklanarak düzenlenebilir.

ŞEKİL 6- Kutupsal Çizim Başlığı Yazma Alanı

Kutupsal Çizimi Kaldırma

Her çizim  düğmesine tıklanarak kaldırılabilir. Kutupsal çizimi rapordan çıkarmak için onay kutusundaki seçimi kaldırın. 

ŞEKİL 7- Kutupsal Çizimli Rapordan Çıkarma

Kutupsal çizimi varsayılan şekle geri getirmek için  ögesini seçin.
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Rapor Önizleme  

1. Dosya (File) > Rapor Önizleme (Preview Report) ögelerini veya sağ alttan  ögesini seçin.

2. İstenen tüm analiz sonuçlarının ve yapılandırılmış bilgilerin dahil edildiğinden emin olmak için raporu gözden geçirin.

3. Raporu yerel sabit sürücüye kaydetmek için  ögesini seçin. 

Kaydet açılır penceresi raporun hedef, ad ve rapor biçimi seçeneklerini tanımlayan araçlar sağlar.

NOT:  Raporun dosya adı Tercihler içinde yapılandırılabilir. Bkz. Rapor Tercihleri Prosedürü, sayfa 30.

ÖNEMLİ: Kırmızı renkle gösterilen değerler aralık dışındaki değerlerdir ve rapor siyah beyaz bir yazıcıda yazdırılacaksa 
belirgin görünmezler. 

ŞEKİL 8- Kaydet Penceresi

4. Raporu yazdırmak için Yazdır (Print) ögesini seçin.

UYARI : Rapor, içeriğin analizle eşleştiğinden emin olmak için onay ve dağıtımdan önce denetlenmelidir. Rapor 
içeriğinin hatalı olması, gecikmiş veya yanlış teşhise neden olabilir. Analiz ve yorum uygun bir şekilde 
eğitilmiş ve uzman kullanıcılar tarafından yapılmalıdır.

İncelemeyi Onaylama 

Uygulama raporları onaylama ve kilitleme özelliğine sahiptir. Onaylanan rapor kaydedilir ve görüntülenebilir ancak 
değiştirilemez.

NOT:  Ön Gereksinimler: Kullanıcı raporu imzalamak için yetkili olmalıdır. Bkz. Rapor Onay Yetkili Kişiler, sayfa 31.

NOT:  Bir görüntü üzerinde bir eylem gerçekleştirilinceye kadar “Onaylı İnceleme” (“Approved Exam”) düğmesi ve 
menüsü etkin olmaz. 
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1. İncelemeyi Onayla (Approve Exam) ögesini veya Dosya (File) > İncelemeyi Onayla (Approve Exam) ögesini seçin.

ŞEKİL 9-        İncelemeyi Onayla Penceresi

2. İstenirse, imza açıklaması girin.

3. İsim aşağı açılır menüsünden kullanıcı adınızı seçin.

4. Parolanızı girin.

5. Onaylamak ve pencereyi kapatmak için Onayla (Approve) ögesine tıklayın. Onaylama prosedürünü tamamlamadan
pencereyi kapatmak için İptal (Cancel) ögesine tıklayın.

Verilen açıklama kullanılarak bir seri oluşturulur.

NOT:  Onaylı bir inceleme yapıldığında, raporun bir tarihi ve zaman damgası olur.



suiteHEART® Yazılımı Kullanım Talimatları NS-03-040-0006 Rev.�1    153

Dışa Aktarma Seçenekleri

Dışa aktarma özelliği ileride kullanılmak üzere incelemelerin ve analiz sonuçlarının yedeklerini oluşturmak için 
tasarlanmıştır. Dışa aktarma özelliği, görüntülerden sıkıştırılmamış AVI filmleri, sıkıştırılmış QuickTime filmleri ve JPEG, TIFF 
ve PNG dosyaları oluşturmanızı sağlar. Bu dosyalar dosya sistemine yazılabilir. 

Araçlar (Tools) > Dışa Aktar (Export) > Raporu Dışa Aktar (Export Report) ögelerini seçin.

İkincil yakalama (SCPT) oluşturulur ve seri listesine eklenir.

Araçlar (Tools) > Dışa Aktar (Export) > Raporu Excel Olarak Dışa Aktar (Export Report to Excel) ögelerini seçin.

Raporu bir Excel dosyası olarak dışarı aktarır.

Araçlar (Tools) > Dışa Aktar (Export) > DICOM Filmi Olarak Dışa Aktar (Export Cine DICOM) ögelerini seçin.

İkincil yakalama (SCPT) oluşturulur ve seri listesine eklenir.

Araçlar (Tools) > Dışa Aktar (Export) > Filmi Dosyalarını Dışa Aktar (Export Cine Files) ögelerini seçin.

Filmi Kaydet açılır penceresi görüntülenir.

Araçlar (Tools) > Dışa Aktar (Export) > Raporu XML Olarak Dışa Aktar (Export Report to XML) ögelerini seçin.

Raporu bir XML dosyası olarak dışarı aktarır.

Araçlar (Tools) > Dışa Aktar (Export) > Matlab’a Dışa Aktar (Export to Matlab) (sadece lisansla) ögelerini seçin.

İkili biçimde bir Mat-file dosyasını dışa aktarır.

ŞEKİL 10- Filmi Kaydet Penceresi

1. Dışa aktarılacak dosya türlerini seçin.

2. Dosyanın/dosyaların kaydedileceği konuma gidin.

3. Dışa aktarma işlemine başlamak ve pencereyi kapatmak için Kaydet (Save) ögesine tıklayın. Görüntülenmekte olan
seri dışa aktarılan tek dosyadır.

NOT:  Veriyi AVI veya MOV dosyası olarak dışa aktarırken, suiteHEART® Yazılımı maksimum saniyedeki çerçeve sayısını, 
uygulama içinde görüntüleme için ayardan bağımsız olarak, 20 olarak ayarlar.

NOT:  İçinde hem çok aşamalı hem de tek aşamalı görüntüler olan özel bir seri .avi veya .mov dosyası olarak dışa aktarılıyorsa, 
dışa aktarma işleminden önce çok aşamalı görüntü içeren bir görüntüleme alanının seçildiğinden emin olun.
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Onaylı Raporu Gözden Geçirme 

1. Dosya (File) > Onaylı Rapor Yükle (Load Approved Exam) ögelerini seçin.

Bu, Onaylı İncelemeyi Seç penceresini görüntüler. İncelemeyle ilgili tüm onaylı incelemeler listede görüntülenir.

ŞEKİL 11-       Onaylı İnceleme Seçimi Penceresi

2. Listeden seriyi seçin.

3. Onaylı raporu ve ilgili analizi yüklemek ve görüntülemek için Yükle (Load) ögesine tıklayın.

• Yalnızca onaylı bir rapor görüntülenebilir.
• Onaylı rapor düzenlenerek ve bu değişiklikler yeni bir incelemeye kaydedilerek onaylanan bir incelemeden yeni bir

inceleme oluşturulabilir. Yeni inceleme ikincil yakalama serisi olarak kaydedilir.

NOT:  Onaylı bir inceleme ve analizin yüklenmesi, geçerli analiz oturumundaki bilgilerin üzerine yazacaktır.

NOT:  suiteHEART® Yazılımının önceki sürümleriyle analiz edilen incelemeler yüklenmek isteniyorsa ve bir “Onaylı 
İnceleme Yükle” (“Load Approved Exam”) işlemi yapıldıysa, rapor üzerinde onaylayan kişi adı ile tarih veya zaman 
damgası bilgisi bulunmaz. Raporu yeniden yayımlamadan önce tüm analizlerin gözden geçirilmesi ve tüm 
sonuçların onaylanması tavsiye edilir.
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Rapor Veritabanı

Rapor Veritabanı Aracı (Report Database Tool) daha önce onaylanan raporların içeriğinde arama yapmanızı sağlar. Bir 
rapor, yalnızca onaylandıktan sonra rapor veritabanına girilir.

ŞEKİL 1- Rapor Veritabanı Penceresi

1. Aşağı açılır şablon arama menüsü, 2. Geçmiş çubuğu, 3. Sorgu alanları oluştur, 4. Sorgu sonuçları, 5. Yeni düğmesi

3
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Rapor Veritabanı Aracı Prosedürü

Veritabanı Araçları Penceresini Açma

1. Araçlar (Tools) > Rapor Veritabanı (Report DB) ögelerini seçin.

Arama Kriterleri Seçme

1. Şablon arama aşağı açılır menüsünden arama yapmak için doğru şablonu seçin.

2. Geçmiş aşağı açılır menüsünden arama sorgusunu seçin. Geçerli sorgu çubuğu seçilen değerlerinizi görüntüler.

ŞEKİL 2- Şablon Arama Menüsü

NOT:  İstenen sorgu yoksa, yeni bir sorgu oluşturun.

Sorgu Oluşturma

1. Geçmiş çubuğunun sağındaki Yeni (New) ögesini seçin.

Rapor Veritabanı penceresinde sorgu oluşturma panelleri görüntülenir.
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ŞEKİL 3- Sorgu Oluşturma Paneli

1. Sorgu İşleyicileri, 2. Sorgu İşlenenleri, 3. Sorgu kategorisi sekmeleri, 4. Sorgu grubu , 5. Sorgu alanları, 6. Sorgu kuralları, 
7. Sorgu seçenekleri, 8. Çalıştır düğmesi, 9. Ekle düğmesi, 10. Yeni düğmesi

2. Çalışma, İşlev, ME ve T2 Star arasından sorgu kategorisi sekmesini seçin. Sorgu grupları ve alanları uygun bir şekilde
güncellenir.

3. Sorgu grubunu seçin.

4. Sorgu alanını seçin.

NOT:  Rapor Veritabanı özel ölçümlerde arama yapamaz.

5. Sorgu arama parametrelerini belirlemek için işleyici seçin.

6. Arama parametrelerine değer sağlamak için işlenenleri girin.

7. Sorgu değerlerini Kurallar (Rules) panelinde görüntülemek için Ekle (Add) ögesini seçin. Tek bir arama işlemi sırasında
birden fazla sorgu yürütülebilir. Her ek kural için 1 ile 7 arasındaki adımları tekrarlayın.

Değil (Not) düğmesi sorgu değerini olumsuz yapar.

Veya (Or) düğmesi aramayı sorgulardan yalnızca biriyle karşılarken birden fazla sorguyu birbirine bağlar. Veya (Or) 
işlevi seçimin üzerindeki sorgu kuralına uygulanır.

Sil (Delete) düğmesi sorgu kuralının seçilmesini ve silinmesini sağlar.
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Aramayı Etkinleştirme

1. Veritabanında arama yapmak için Çalıştır (Run) ögesini seçin.

Arama sonuçları Sorgu sonucu alanında görüntülenir. Aramayı karşılayan sorgu değerleri sonuç penceresinin en 
sağdaki sütununda görüntülenir.

ŞEKİL 4- Sorgu Sonucu Penceresi

1. Geçmiş çubuğu, 2. Sorgu sonuçları, 3. Listeyi yazdır düğmesi, 4. Raporları yazdır düğmesi, 5. Listeyi dışa aktar düğmesi, 6. Sil düğmesi

NOT:  Yeni sorgu sonuçları yalnızca inceleme kimliği, inceleme tarihi, imza yetkisi ve rapor şablonunun benzersiz bir
birleşimine göre oluşturulur. Bu alanların bir kopyası algılanırsa, eski rapor yeni raporla değiştirilir.

Sonuçları Görüntüleme

1. Raporu görüntülemek için Sorgu sonucu alanındaki bir girişe çift tıklayın.

Seçilen raporu görüntüleyen yeni bir pencere açılır. Birden fazla rapor varsa, raporlar arasında gezinmek için 
Sonraki Rapor (Next Report) ve Önceki Rapor (Previous Report) ögelerini kullanın. Rapor Gözden Geçirme 

penceresini kapatmak için pencereyi kapatma işaretine  tıklayın.

1
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ŞEKİL 5- Rapor Penceresi

2. Sonuç seçimlerini değiştirmek için menü seçimini Düzenleme seçeneklerini uygulayın:

Düzenle (Edit) > Tümünü Seç (Select All) tüm arama sonuçlarını seçer.

Düzenle (Edit) > Seçimi Temizle (Clear Selection) tüm arama sonuçlarının seçimini iptal eder.

Düzenle (Edit) > Seçimi Ters Çevir (Invert Selection) her sonucun seçim durumunu değiştirir.

Düzenle (Edit) > Geçmişi Temizle (Clear History) önceki sorguların kaydını siler.

3. Sorgu listesini yazıcıya göndermek için Listeyi Yazdır (Print List) ögesini seçin.

4. Seçilen raporları yazıcıya göndermek için Raporları Yazdır (Print Reports) ögesini  seçin.

5. Listeyi bir html dosyası olarak kaydetmek için Raporu Dışa Aktar (Export List) ögesini seçin.

6. Seçilen raporları rapor veritabanından kaldırmak için Sil (Delete) ögesini seçin.
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Sorguyu Kaydetme

1. Favoriler (Favorites) > Favorilere Ekle (Add to Favorites) ögelerini seçin.

2. Favorilere Ekle metin kutusunda, sorgu için bir etiket girin ve Tamam (OK) ögesine tıklayın.

ŞEKİL 6- Favoriler Menüsü

ŞEKİL 7- Favoriler Açılır Menüsü
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Favoriyi Silme

1. Rapor Veritabanı penceresinden Favoriler (Favorites) > Favorilere Yönet (Manage Favorites) ögelerini seçin.

ŞEKİL 8- Favorileri Yönet Penceresi

2. Favori ögesini seçin.

Sonuç penceresinde tüm sorgu formülü görüntülenir.

3. Sil (Delete) ögesine tıklayın.

Onay açılır penceresi silme seçiminizi doğrulayacaktır. Evet (Yes) ögesini seçin.

4. Kapat (Close) ögesini seçin.
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Arama Sonuçlarını HTML Dosyası Olarak Dışa 
Aktarma

1. Rapor Veritabanı penceresinin sağ tarafındaki  Listeyi Dışa Aktar (Export List) ögesini seçin.

ŞEKİL 9- Dışa Aktarma Penceresi

2. Listenin dışa aktarılacağı dizini seçin.

3. Tamam (OK) ögesini seçin.

• Açılır bir pencere raporların dahil edilip edilmeyeceğini sorar.
• Liste ve raporlar HTML dosyası olarak dışa aktarılır.

Veritabanını Dışa Aktarma

Veritabanı büyüdükçe verinin arşivlenmesi tavsiye edilir.

1. Rapor Veritabanı menü çubuğundan Dosya (File) > Dışa Aktar (Export) ögesini seçin.

2. Listenin dışa aktarılacağı dizini seçin.

3. Tamam (OK) ögesini seçin. Veritabanı harici depolama cihazına dışa aktarılır.
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Veritabanını İçe Aktarma

Veritabanı, dışa aktarıldığı başka bir bilgisayardan tekrar içe aktarılabilir. 

1. Dosya (File) > İçe Aktar (Import) ögesini seçin.

ŞEKİL 10- İçe Aktarma Penceresi

2. Listenin içe aktarılacağı dizini seçin.

3. İçe aktarılan veritabanı mevcut veritabanıyla birleştirilir.
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Tablet Modu
64 bir işlemcili ve üzerinde Windows 10 Professional veya Windows 10 Enterprise işletim sistemi çalışan tabletlerde 
suiteHEART® Yazılımı desteği vardır. suiteHEART® Yazılımını bir tablet cihazda kullanmak için aşağıdaki bölümü inceleyin.

Tablet Modunu Etkinleştirme

1. Görüntü Görüntüleme (Image View) menü çubuğunda Araçlar (Tools) > Tercihler (Preferences) > Tercihleri Düzenle
(Edit Preferences) ögelerine tıklayın.

2. Genel Tercihler (Global Settings) sekmesini seçin ve imleci Diğer (Miscellaneous) paneline getirin.

3. Tablet Modunu Etkinleştir (Enable Tablet Mode) onay kutusunu işaretleyin.

4. Rapor Görünümünde Şekil 1‘de gösterildiği gibi bir klavye simgesi aktif hale gelir.



suiteHEART® Yazılımı Kullanım Talimatları NS-03-040-0006 Rev.�1    165

ŞEKİL 1- Klavye Anahtarı

5. Bir metin alanı kullanıldığında sanal klavye açılır.

Sanal klavye arayüz üzerinde hareket ettirilebilir.

6. Metin olmayan bir alan üzerinde seçim yapıldığında klavye kapanır.

7. Sanal klavyeyi manüel olarak etkinleştirmek için  ögesine tıklayın. Kapatmak için  ögesine tıklayın.

Görüntü Kullanım Araçları

Tablet üzerinde görüntü kullanım araçlarını kullanmak isterseniz, işaret kalemiyle veya bağlıysa sol fare tuşuyla tıklayarak 
aracın üzerine gelin. 

Görüntüler sekmesindeki görüntüleri yeniden düzenlemek için sağ fare tuşuyla tıklayın ve bırakma eli simgesini 
seçin.



suiteHEART® Yazılımı Kullanım Talimatları NS-03-040-0006 Rev.�1    166

Ek

Teknik Referans

Ek A - Referans Makaleler
Bu el kitabında sayfa 37'de açıklanan başvuru değerleri, aşağıdaki emsal değerlendirme literatür başvuru kaynaklarından oluşturulmuş 
olabilir:

1. Kawel-Boehm  et al, “Normal Values for Cardiovascular Magnetic Resonance in Adults and Children.” Journal of
Cardiovascular Magnetic Resonance (2015) 17:29

2. Maceira A.M. et al, "Normalized Left Ventricular Systolic and Diastolic Function by Steady State Free Precession
Cardiovascular Magnetic Resonance." Journal of Cardiovascular Magnetic Resonance (2006) 8, 417-426.

3. Lorenz C. et al. “Normal Human Right and Left Ventricular Mass, Systolic Function, and Gender differences by Cine
Magnetic Resonance Imaging.” Journal of Cardiovascular Magnetic Resonance 1(1), 7-21, 1999.

4. Sechtem, U. et al. “Regional left ventricular wall thickening by magnetic resonance imaging: evaluation in normal
persons and patients with global and regional dysfunction.” Am. J. Cardiol. 1987 Jan 1;59(1):145-51.

5. Storey P, et al. “R2* Imaging of Transfusional Iron Burden at 3T and Comparison with 1.5T,” Journal of Magnetic
Resonance Imaging 25:540–547 (2007)

6. D.J Pennell, et al. “Cardiovascular T2-star (T2Star) magnetic resonance for the early diagnosis of myocardial iron
overload”, Eur Heart J 2001; 22: 2171-2179.
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Ek B - İşlevsel Analiz Tarama Düzlemi Örneği
İsabetli işlev sonuçları için, analiz aşağıdaki ilk resimde gösterildiği gibi kısa eksen görüntüsü üzerinde yapılmalıdır.
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Kısa eksen görüntüsünün alınması için doğru tarama yüzeyi belirleme. Kesitler, ventrikülün uzun eksenine dik olarak belirlenmeli ve 
tabanın üstünde en az 2 kesit, seride bulunan apeksten sonra da en az 1 kesit olmalıdır.
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Ek C - Desteklenen Üreticiler
suiteHEART® Yazılımı, aşağıdaki tabloda bulunan üreticilerden alınan MRI görüntüleri ile değerlendirilmiştir.

Üretici Tarayıcı Tipi Analiz Modu

GE Healthcare Discovery MR750
Discovery MR750w
Optima MR360
Optima MR450w
Optima MR450
Signa HD
Signa HDx
Signa HDxt

Tüm Analiz Modları

Philips Healthcare Achieva
Ingenia
Intera
Intera Achieva

İşlev, Miyokardiyal Değerlendirme, 
Zamana Bağlı, Akış, T2 Eşleştirme,  
T1 Eşleştirme, T2Star

SIEMENS Aera
Avanto
Espree
Skyra
Sonata
Symphony
Verio

İşlev, Miyokardiyal Değerlendirme, 
Zamana Bağlı, Akış, T2 Eşleştirme,  
T1 Eşleştirme, T2Star
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İndeks

Sayılar

3B/4B

Görüntüleyici Bileşenleri 131

Görüntüleyici Yerleşimi 136

Seri Oluşturma Çıktıları 136

3B/4B Görüntüleyici 130

A

Analiz Görünümü 15

Analiz Görünümü İşlevleri 16

Akış Analizi 77

Ana Hat Düzeltme Seçenekleri 84

Akış Sonuçları 92

Gösterim Modları 89

Pencere Bileşenleri 78

Tepe Hız 88

Araçlar Menüsü 8

Arama, Rapor Veritabanı 158

Aramayı HTML Olarak Dışa Aktarma

Rapor Veritabanı 162

Atria 71

B

Bir Konturu Silme 53

Boşta Kalma Süresi Tercihleri (Idle Timer Preferences) 34

Bölgesel Analiz 68

Bölme Hacmi Tablosu 67

Ç

Çapraz Başvuru Modu 11
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D

Diğer Paneli 33

Dışa Aktarma

Tercihler 42

Doğrusal Ölçüm

Ayarlama 73

Dosya Menüsü Seçenekleri 8

Düzenleme

Sekme Etiketleri 95

Tercih Aralıkları 37

E

Ekipman Tehlikeleri 3

F

Favori Silme, Rapor Veritabanı 161

Film Modu 10

G

Geçmiş Sekmesi 144

Görüntü Görüntüleme Kontrolleri 9

Görüntü Kullanım Araçları 12

Görüntü Yönetim Araçları 21

Karşılaştırma Modu 25

Görüntüler Sekmesi 147

Görüntüleyici 21

Güvenlik Bildirimleri 3

H

Hızlı Tuşlar 14

İ

İnceleme Onaylama, Yapılandırılmış Rapor 151
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İçe Aktarma

Tercihler 42

Veritabanı 163

İşlev Analizi 54

Doğrusal Ölçüm Ayarlama 73

Manüel LV İşlev Analizi Prosedürü 70

Ölçümleri Silme 74

Özel Ölçüm, Ekleme 74

Özel Ölçüm, Kaldırma 74

Ventriküler İşlev Analizi Sonuçları 66

İzlenim Sekmesi 146

İzlenimler

Makro, Ekle 39

K

Kapakçık Düzlemi Analizi 75

Karşılaştırma Modu 25

Kontur Düzenleme

Bir Konturu Silme 53

Konvansiyonel Düzenleme 51

Seçenekler 51

Sürükleme Aracı 52

Kontur Silme 53

Konturları Düzenleme 51

Kullanıcı Arayüzü

Analiz Görünümü 15

Analiz Modları 7

Araçlar Menüsü 8

Çapraz Başvuru Modu 11

Dosya Menüsü 8

Düzenleme Penceresi 8

Film 10

Genel Bakış 6

Görüntü Görüntüleme Kontrolleri 9

Görüntü Kullanma 12

Matris Modu 10

Mod Görüntüleme 8

Raporlama Sekmesi 18

Seride Dolaşma 7

Yardım Menüsü 9

Kullanım Amacı 2
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Kullanım Endikasyonları 1

Kutupsal Çizimler Sekmesi 148

L

LA

İşlev Analizi, Hızlı 72

İşlev Analizi, Manüel 71

LV

İşlev Analizi, Hızlı 70

İşlev Analizi, Manüel 59

İşlev Analizi, Sonuçlar 66

M

Makro

Çalıştırma 40

İzlenimler, Ekle 39

Metin Girme 39

Silme 40

Tercihler 39

Matris Modu 10

Miyokardiyal Değerlendirme 96

Kutupsal Çizim Biçimleri 99

Nicel Analiz Prosedürü 97

Miyokardiyal Renk Haritası Oluşturma 127

Ö

Ölçümler

Doğrusal 73

Özel, Ekleme 74

Özel, Kaldırma 74

Ölçümleri

Silme 74

Ölçümleri Silme 74

Özel Ölçüm

Ekleme 74

Kaldırma 74
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P

Patent Foramen Ovale (PFO) Analizi 121

PFO

Analiz Penceresi 122

Aşama Aralığı Seçme 123

Atriyal Anatomi 122

Eğri Sonuçları 124

Eğri Verisi 123

Konturlar 124

LA Yoğunluk Eğrisini Oluşturma 122

RA Yoğunluk Eğrisini Oluşturma 122

Q

Qp/Qs

Hesaplama 94

Sekme 93

R

RA

Hızlı İşlev Analizi 72

İşlev Analizi, Manüel 71

Rapor

Onay Yetkili Kişiler 31

Onay Yetkili Kişiler, Yönetme 31

Tercih Prosedürü 30

Rapor Önizleme, Yapılandırılmış Rapor 151

Rapor Veritabanı 155

Araç Prosedürü 156

Arama Kriterleri 156

Aramayı Etkinleştirme 158

Aramayı HTML Olarak Dışa Aktarma 162

Favori Silme 161

Pencere 155

Sorgu 156

Sorgu Kaydetme 160

Veritabanını İçe Aktarma 163

Raporlama Sekmesi 18
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S

Sekme

Etiketleri Düzenleme 95

Geçmiş 144

Görüntüler 147

İzlenim 146

Kutupsal Çizimler 148

Qp/Qs 93

Raporlama 18

Yapılandırılmış Rapor, Görüntüler 147

Yapılandırılmış Rapor, İzlenim 146

Seride Dolaşma 7

Sorgu Kaydetme, Rapor Veritabanı 160

Sürükleme Aracı 52

Ş

Şablon

Çoğaltma 37

Oluşturma 36

Silme 37

Tercihler 36

T

T1 Eşleştirme 108

T2 Eşleştirme 112

T2Star 125

Analiz Prosedürü 126

Eğriyi Gözden Geçirme ve Güncelleme 128

Miyokardiyal Renk Haritası, Oluşturma 127

Parametre Uyumu 128

Sonuçlar 128

Teknik, Yapılandırılmış Rapor 146

Tepe Hız, Akış Analizi 88

Tercihler

Boşta Kalma Süresi 34

Dışa Aktarma 35, 42

Düzenleme 29

İçe Aktarma 42

Makro 39
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Rapor 29

Şablon 36

Tanımlama 29

U

Uygulamadan Çıkma 4

Uygulamayı Başlatma 4

V

Ventriküller 55

Veritabanı, Tarama 19

Virtual Fellow™ 43

Arayüz 45

Arayüz Araçları 45

Görüntüleme Protokolleri 47

VT Tarama 19

Y

Yapılandırılmış Rapor 144

Dışa Aktarma 153

Geçmiş Sekmesi 144

Görüntüler Sekmesi 147

Grafikler 148

İnceleme Onaylama 151

İzlenimler 146

Kutupsal Çizimler Sekmesi 148

Onaylı Rapor 154

Özet Tablosu 148

Rapor Önizleme 151

Sekmeler 144

Teknikler 146

Yardım Menüsü Seçenekleri 9

Z

Zamana Bağlı

Analiz 115


